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Chapter 1
|nstallation

Welcome to the wonderful world of SuperScope 1. We are extremely excited about this product and
hope you can share in our enthusiasm. SuperScope Il is more than just 1 product, it is a core technology
on which the following products are based:

SuperScope | Base Package, usb key #GWI-SS2-usb
SuperScope | Base Package, adb key #GWI-SS2-adb

SuperScope Il supports all instruNet hardware for a variety of data acquisition, analysis, control and
presentation tasks. GWI is committed to the SuperScope |1 platform and will continue to develop it
throughout this decade and into the 21st Century.

TO GET STARTED WITH SUPERSCOPE |l QUICKLY:

1) Firstinstall your instruNet hardware system per Chapter 1 of the instruNet User’s Manual. Do the
steps listed in the Hardwar e Installation, Software Installation, and Verify That Your Systemis
Working Properly sections of this chapter. UseinstruNet World software to verify that your hardware
is operating properly before using SuperScope I

2) Do Chapter 2, instruNet Tutorial, of the instruNet User’s Manual. SuperScope Il accesses the
windows and dialogs reviewed in this chapter; and therefore all information in instruNet World is
relevant to SuperScope 1.

3) Install SuperScope Il PPC 3.x software onto your computer viathe following steps:

*  Copy the "SS2-SOS 3.x CD" folder from the CD onto your hard disk drive viathe Finder.

* Copy the following files from the "Extensions - Important” folder in the "SS2-SOS 3.x CD" folder
to the "Extensions" folder within your "System" folder: "E3ITF", "RainbowUSBShim", " SSProtect
INIT", and "USBSentinel".

*  Attach the SuperScope Il hardware security key (small plastic box) to your USB or ADB
keyboard/mouse connector.

Please Note:

*  SuperScope Il 3.x is not compatible with 68K computers and requires System >=7.5. Itis
compatible with the newer Macintosh computers including the iBook, iMac, G3 and G4 models.
SuperScope Il 3.x isbased on a CD and is not available on floppy. SuperScope Il 3.x is compatible
with instruNet data acquisition hardware; and will work with in most cases with the older
MacADIOS hardware, yet thisis not guaranteed.

*  Freetechnical support is available only viaemail at support@gwinst.com.

* CD Rom software upgrades are available, part #gwi-SS2-upg-xxx. No upgrades/updates are
available viathe internet.

4) Please do Chapter 2 Tutorial of the SuperScope Il User’s Manual.

5) Optionally, do Chapter 3 Building Instruments & 4 Advanced Techniques of the SuperScope Il User’s
Manual.
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6) Review Chapter 9 of the SoundScope & SuperScope Il Reference Manual (formally the 16pg
"SuperScope |1 Design Guide") -- it summarizes instrument design, and is EXTREMELY HELPFUL.

7) Tolearn how to design your own instruments or modify existing instruments, read Chapter 5
Instrument Design of the SuperScope Il User’s Manual. For detailed information on task instructions
and mathematical functions, refer to the SoundScope & SuperScope Il Reference Manual.
Descriptions are listed in alphabetical order in Chapters6 & 7.

CONVERTING OLD MACADIOS INSTRUMENTS TO INSTRUNET

To convert an old MacADIOS instrument to instruNet, make sure the instruNet driver isinstalled in the
Extensions folder, load the old MacADIOS instrument into SuperScope |1, choose Edit Menubar Full
under Edit, select the instruNet Menu, and then choose Show. Thiswill cause the MacADIOS
"Hardware" menu to disappear, and for the MacADIOS channels to be converted to SuperScope |1 waves.
To re-attach these "now" waves to instruNet channels, please refer to the below instructions. To convert
an instrument from instruNet to MacADIOS, select the "Hardware" menu in the Menubar Editor dialog.
Things are much simpler with instruNet -- all options in the MacADIOS hardware menu are gone. There
are no such things as "digitizing" modes. Instead, instruNet digitizes in what was "segment seamless" and
has an optionsin it's Digitize Segment task instruction that selects between Oscilloscope and Strip Chart
(i.e. continuous or non-continuous "scans’). Oh, by the way, a"trace" isnow a"scan".

ASSOCIATING INSTRUNET CHANNELS WITH SUPERSCOPE Il WAVES

To associate an instruNet channel with a SuperScope Il wave (which enablesit for digitizing when a
Digitizer Task isrun), enter the Wave Options dialog, select "Link to instruNet Channel”, and then select
the desired instruNet channel. All linked waves are automatically filled with digitized data when a
Digitizer Task runs. The sample rate, number of scans per task, and whether or not the scans are
continuous (i.e. Oscilloscope or Strip Chart) are al selected within a Digitizer Task's Digitize Segment
instruction. Itiswithin thisinstruction that little ssgments of waveform are digitized, in aloop, between
the Segment Loop Begin and Segment Loop End instructions.

THE INSTRUNET MENU

The instruNet menu is used to view and set the instruNet channel options, and to record waveforms
directly into the instruNet World Record window for purposes of verifying that the channels are set up
properly. For information on how to use the instruNet World Record, Network and Test pages (all
accessible from the SuperScope Il instruNet menu), please refer to the instruNet User's Manual. All
settings in the Network page are used when digitizing (e.g. analog and digital filter settings, integration
times for each channel, sensor type, etc) and are saved with SuperScope |1 instruments. The Digitizer
Task automatically digitizes into SuperScope Il waves that have been linked to instruNet channels via the
"Link to instruNet Channel™ option within the Wave Options dialog box. These links can be turned on/off
at run time viathe Set Wave Internas instruction.

INCLUDED INSTRUNET INSTRUMENTS

It is recommended that one begin with the included instruments inside the "instruNet Instruments:Best
Instruments” folder, relying on their HEL P windows (opened with a Help button) for information on how
they work. These instruments are both powerful and fairly simple, with only a handful of tasks each,
where each task typically includeslessthan 5 instructions. To learn good SuperScope Il programming
techniques, it is recommended that one study these tasks. Recommended instruments are:

» Oscilloscope with Database.iNet * Transient Database.iNet
* Strip Chart To Disk.iNet * XY Recorder.iNet
* Strip Chart w Database.iNet * Spectrum Analyzer.iNet

1- 2 Installation
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COMPUTER REQUIREMENTS
SuperScope I must be run on a machine with the following minimum requirements:

Computer
SuperScope I is compatible with PowerPC computers (not 68K) including iBook, iMac, G3 and G4
models.

Operating System
Apple System 7.5 or newer is required.

Monitor
SuperScope Il supports all monitorsincluding: two page displays, 24bit color, and grayscale.

Hard Disk
SuperScope I requires a hard disk with at least 50 MB free.

Random Access Memory (RAM)

At least 5 MB of RAM should be allocated for SuperScope 11, although it will run with aslittle as 3.5 MB
or RAM. System 7.x itself can consume 4 MB or more of RAM. Adding extensions ("INITS") to your
System Folder requires additional RAM aswell. In summary, 16MB of total computer RAM is
recommended. If you incur a memory error upon application launch or when running an instrument, try
increasing the Memory Allocation field in the SuperScope Il Get Info dialog (i.e. select the SuperScope 11
application icon from the Finder, and choose Get Info in the File menu).

SYSTEM COMPONENTS
The SuperScope Il product family includes the following systems:

SuperScope | BASIC PACKAGE HGWI -SS2-XXX
¢ SuperScope Il Software on CD

¢ SuperScope Il User's Manual

¢ SuperScope Il & SoundScope Reference Manual

¢ Eve™ security key

SUPERSCOFPE Il FIVE-PACK Multiple Systems #GWI -SS2-5pak-xxx

¢ Fiveadditional security keysfor a multi-station installation. At least one base system (Parts #GWI-
SS2) must be purchased in order to qualify for the Five-Pack purchase. Five-Packs cannot be broken
(e.g. you cannot buy 3 for 60% of the Five-Pack price).

Installation 1-3



Super Scope |1 User's Manual

OUR MISSION FOR THE 90'S(AND BEYOND)

The world of computing is currently evolving at lightning speed with computers the size of notebooks
doing what mainframes did only 10 years ago. And we believe this spectacular growth will continue at a
5%/month increase in price-to-performance-ratio well into the 21st Century (it's exciting). This, coupled
with the fact that the manufacturing cost of software is negligible, has led us to believe that companies
who invest heavily in developing ultra advanced software will be the winners at the turn of the century.

In 1989, we undertook the challenge of developing a highly advanced software product family. This
involved over 30 developers and three years of painstaking effort before it produced it's first fruit.
SuperScope Il is more than one computer instrument -- it is an environment in which the end user can
design their own instruments. We believe that the next revolution in computing will involve the end user
taking on the role of the developer; designing, prototyping, learning, and implementing new and unique
methodsin the field. Subsequently the SuperScope Il product family allows the end user to "program”
with an easy to use mouse/dialog box user interface.

Our Company Mission isto change the way scientists, engineers and medical researchers work in the
laboratory by devel oping computer based instrumentation which is faster, stronger, more accurate, more
capable, more flexible, less expensive and easier to use than the traditional benchtop counterparts. We
hope this product made a dent in this quest and wish to hear from you if you have ideas concerning future
releases.

| DEAS FOR NEW FEATURES
If you have any suggestions for improvements, please phone or write us Attention: New Products. We
develop products for you, the user, and want your feedback.

APPLICATION NOTES

GW Instruments collects 2 page summaries of common instruments. 1f you would like to write about
your instrument, or would like to read about someone else's, please call or write GW Instruments,
attention Application Note Program Coordinator.

REPORTING BUGS

To learn about dead bugs, known bugs and areas
under development please open file
"IDevelopment Status.note” in the "Programmer's Dear End User:

Bug Report Bureau

Notes' folder inside the "Goodies' folder. This If you found a bug and would like to inform the manufacturer, please
file can be opened using any text editor (e.g. pracaad with'the following steps:
Microsoft Word, Word Perfect). Thisfile expects *1 Press DK to exit this dialog.
tabs a/ery 4 Charmters (I e Choo% Optlons under #2 Press OK to COPY this message to the clipboard.

noAn #3 Ewxit this application and PASTE the clipboard contents (which
Journa| and then SGt the TabS tO 4 Chara(:ters)- include these instructions) to a word processor. If your bug is so awf
TO report a bug, p| ease: it doesn't allow you to do this, you can restart your computer, launch

this application, and press OPTION 'y’ to get to this point, and proceed
from there.

#1 |If the bug causes an Error Alert to appear (i.e. “4 Fill out the form below. ‘ ,
one W|th a Bug Report button), preSS the S Delete this letter and print your report in a small fixed character
magic button to open the Bug Report dialog,
pictured to theright. Alternatively, if the bug
does not cause an Error Alert to appear, press Option 'y', at any time, to invoke the Bug Report
diaog.

#2 Read the displayed instructions.

#3 Press OK to exit the dialog.

#4  Press OK to copy the bug report information to the clipboard.
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#5 Paste the clipboard text into a new word processor window.

#6 Describe the sequence of steps required to reproduce the bug (thisiscrucial). If we cannot see the
problem at GW Instruments, we probably cannot fix it.

#7 Delete the Dear End User letter at the top of thefile, to save trees.

#38 Printin asmall font (e.g. Courier 8) and send to GW Instruments via fax, mail, or electronic mail. If
you phone us, please do so while in front of your computer, if possible.

#9 If your bug isrea mean, please refer to Tip #413 in Appendix E of the SoundScope & SuperScope ||
Reference Manual.

SOFTWARE UPGRADES
To receive the latest version of the SuperScope Il software, please contact GW Instruments.

Part #GWI-S2-Upg-xxx

TECHNICAL SUPPORT
Please contact your SuperScope |1 Supplier for Technical Support.

PLEASE RETURN THE

OWwWNER REGISTRATION FORM

To RecelVE NEwWS AND UPDATES.
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Chapter 2
Tutorial: Quickstart

This chapter describes how to quickly build an oscilloscope or strip chart recorder instrument using
SuperScope |1 in conjunction with instruNet hardware. Front panel layout, acquiring data, creating tasks,
saving datato disk and on-line analysis will be covered in easy to follow steps.

In the instructions for designing the instrument, each step is preceded by a bullet symbol (). Itis
important to not miss a step, since many steps depend on previous steps. SuperScope |1 makes extensive
use of hierarchical menus (i.e. submenus) to provide direct access to waves, displays, journals and other
objects. Thismanual uses the » character to indicate a submenu. For example, "Select Load Data? A
from the Wave menu" is shorthand for "Pull down the Wave menu, drag down to the Load Data submenu,
drag acrossto 'A’, and then rel ease the mouse button to select it."

SUPERSCOPE Il OBJECTS

SuperScope I is designed to acquire, analyze, present, archive and control real-time-based waveform
data. It isused by two different audiences, instrument users and instrument designers. Instrument users
can begin work right away, using software instruments that were created by GW Instruments or by
colleagues. Instrument designers construct instruments by creating and customizing objects, and gluing
them together. There are several kinds of objects, and the instrument designer creates as many as needed
to build the application of his/her dreams. Objects are set up with mouse-driven pull down menus and
dialog boxes -- no previous programming experience is necessary. The different types of objects are
summarized below.

Waves are used to represent real world continuous data as a list of numbers that show a
waveform when plotted. Waves are digitized, synthesized, analyzed, edited, viewed, used
to hold the results of analysis, loaded from disk, and imported/exported to/from other
application programs.

Displays reside on the front panel and are used to view and edit waveforms. They are @~ & ~ |5y
extremely versatile with many customizable attributes such as horizontal and vertical SO AR T
controls, labels, markers and much more. Displays can be positioned on the front panel p Vo
in any pattern and in any number, space permitting. Each display can contain up to 8 . - - 1/D
waves and supports mouse-driven Cut, Copy, Paste, and drawing of waveform )0 msec |
segments. 3[50 ndir
Journals aretext regionsthat are used to enter, view and edit text in a manner similar J1

to that done with aword processor. The contents of Journals can easily be saved to disk

and then loaded by aword processor or spreadsheet program. Journal windows can be
resized and positioned on the front panel in any pattern and in any quantity, space
permitting.

Tasks are sequences of instructions that perform a series of operations. For Calculate Have
example, one could write atask to record data, analyze, update the screen, and then Pulse Analuysis
print the results. Tasks are easily created, viewed, edited, and debugged; and can be Sound Statistics
set up to run when a marker moves, when a wave changes, when a specific menu Statistics

item is chosen or when the user chooses Run Task. One “programs’ tasks using a powerful mouse/dialog
user interface. The neat thing about programming SuperScope I is you do not need to know a syntax —
the mouse-driven dialog boxes take care of you!

2- 2 Tutorial: Quickstart
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Instructions arethe building blocks used to create Send to journal:[_Data__| Log pulse number
tasks. There are over 30 kinds of instructions, each , - B tnax ninz e

dedicated to a specific function (e.g. save awaveto disk, | &L L avg

move amarker). A task contains alist of instructions that RSN s e
are executed in the order that they appear in the task; and stopet topes
each instruction can be viewed in it's own dialog box, s

edited, cut, copied, and pasted. o i e

Controls and Indicators are used to control and indicate the state
of Boolean true/false values, scalars, and text. Controls (e.g. buttons,
checkboxes, edit fields, knobs, sliders) reside on the front panel and are
controlled with the mouse and/or keyboard. From the task's
perspective, a control isavariable that is read. Also, controls can
trigger atask when moved. Indicators (e.g. dial, static text, bar graph)
are front panel objects that display avalue or string. From the task’s
perspective, an indicator is avariable that is written to.

Menubars areapowerful tool for modifying the current menubar, or creating your own. QuickTime
Each menubar consist of a set of menus and a set of items under each menu.

Markers aretypically used to mark atimein awave or display. The user can createas M1:¢-0.767>
many markers as he/she desires and can place any marker in any display. In displays, they
appear as vertical lines that can be moved left and right with the mouse.

Strings & Variables are used to hold text and numerical values. Many task instructions 1 1234
transfer data to and from strings & variables. .

Tutorial: QuickSart 2- 3
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BUILDING YOUR FIRST SUPERSCOPE Il INSTRUMENT

This tutorial assumes you have done Chapter 1 Installation & Chapter 2 instruNet Tutorial of the

Installation of this manual.

il

instruNet User's Manual. If you have not done so, please do this now.
il

Il software and instruNet, as described in Chapter 1,
[0 Open the SuperScope |1 application by double-clicking on itsicon.

Y ou will get an error message if there is not enough memory (RAM) to launch SuperScope l1.
SuperScope Il prefers 5 MB (5000 K) or more, but will run with aslittle as 3500K allocated for small
instruments. To determine if your machine has enough memory, select About this Macintosh (or About

the Finder) from the Finder's Apple (LJ) menu. You can

also quit other applications to increase the

memory available. Please see Chapter 1, Installation for a detailed discussion of memory issues.

After afew seconds, SuperScope I1's menubar will
appear at the top of the screen, and a blank front panel
will appear, as shown to the right. SuperScope Il
instruments are built by first laying out afront panel,
and then by creating tasks which add functionality to
theinstrument. The front panel of an instrument is built
by adding displays, controls and indicators, journals,
and waves to the blank panel. Tasks are alists of
instructions to be executed that can include instructions
for acquisition of data, output of waveforms, analysis
and displaying of data, and saving datato disk. The
instrument you will build in this chapter will bea 1
channel oscilloscope that calculates the absolute value
of the acquired waveform. Thisfirst instrument will
include 2 displays, 2 waveforms, 1 button, 1 task and 1

% File Edit Wave Display Journal Task Control instruNet

SuperScope 11

Please make sure your computer equipment is powered on, and that you have installed the SuperScope

s:14PM 2 B

[

journal. For your reference afinished version of thisinstrument named "instruNet First Contact” isin the
"Chapter 2" folder inside of the "Tutorial Instruments" folder; inside of the "instruNet Instruments" folder.

[0 Select New under the Wave menu. The wave
dialog will open as shown in the figure to the right.
A wave can be linked to an instruNet input channel
in which case it will store data acquired from that
channel in RAM, linked to an instruNet output
channel in which caseit will hold alist of valuesin
RAM to be output on an analog output channel, or
as an array used to store the results of calculations.

Click the Link to instruNet Channel button at the
bottom of the dialog to open the instruNet Channel
Selection dialog, as shown to theright. Every
channel in an instruNet network is defined by its

Wave:| 1IN |
Name:| W1 [ Format... | [ Edit.. |
Units: [ Points... ] [Synthesize]

Place wave into display:

1 If wave changes, run:

Seamless scrolling via: E
JLink to ioNet Ehannnkl

[Eumments][ Assist... ][ Cancel ] [T]

Network number, Device number, Module
number and Channel number. Any wave can
be linked to any instruNet channel by selecting
the desired channel using the 4 popupsin the
instruNet Channel Selector dialog.

el Channel
R sk Dipiiw
| *1 st || 1 #1000

Lhidiiii
| Chul e |

(oot )

Feldidiil
|| 1 #10d
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0 Click the Channel popup to view thelist of available channels. Thelist shown [~Ch1 vin+
to the right is what would appear if aModel 100 or Model 100B was attached as Ch2 Vin-
the first network device to your instruNet network. Note that all of the input and Ch3 Vout
output channels for the device are listed. If a second device was attached to your Ch4 Vin+
controller you would access its channels by first selecting that device in the Ch5 Vin-
Device popup in the Channel Selection dialog, and then select the desired channel Ché Vout
in the Channel popup. Ch? Vin+

Ch8 Vin-
Select Chl Vin+ in the popup. Thislinks Chl Vin+ to wave W1. Now, when Ch9 Uout
datais digitized from the Chl Vin+ screw terminal, it will automatically be stored in wave W1 in
RAM.

Click OK to exit the Channel Selection dialog.

O Click the Assist button in the bottom of the Wave dialog  eeecae s s o s ivwier o B8
to open the Wave Assist dialog. Click the OK button, =,
which causes a new display to be created, places the .
wave W1 (i.e. Chl Vin+) into that display and centers
the display on the front panel. A number of the object o |
dialogs (e.g. Wave, Display, Task, Journal) have Assist s B
buttons. These buttons allow you to save timein b
creating instruments by automating common steps.
Y our SuperScope |1 front panel should now look as
shown below.

[0 Select New Digitize... under the Task menu to

create anew task and to open the Task Editor as || (@MW) Task:
shown to theright. Functionality is added to a T BegIn e 2 scons? [
SuperScope || instrument by creating tasks. ok tiza ‘Boent €3008 ptafacam, 1.0 piafascy Heciife3
SuperScope |1 alows for the creation of two Plot Segent

types of tasks - digitizing and non-digitizing. A Slear & Update

digitizing task istypically created for the

purposes of acquiring data, saving data to disk, -
real time displaying of acquired data, and on-

lineanalysis. A non-digitizing task is created catculgte e Name: Tt |
for off-line analysis. The Task Editor contains Pulse falysis Help. ) (Assist— ) oK)
two scroll boxes. The larger scroll box at the Sallzuies options._) (Bebug) [ Cancel ]

top of the dialog contains alist of the
instructions to be executed when the task isrun. The smaller scroll box at the lower |eft contains alist
of instructions that can be added to the task to add more functionality. When anew digitizing task is
created a set of template instructions are automatically added to the task to implement the actual
acquisition and display of data. These are the bolded instructions shown in the dialog above. These
bolded instructions cannot be moved nor deleted. When a non-digitizing task is created no template
instructions are added.

(0 Double click on the Scan Loop Begin (2 Scans)
instruction to open the dialog as shown to the Scan Loop
right. Thisdialog isused to set the number of
scans of datato be collected. Set the number Runfromscan # [1 |toscan#

of scansto run from 1to 10. Click OK to exit

the dialog. ( cancel ] |[ ok ]|
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[0 Double click on the Digitize Segment
instruction to open the Timebase dialog as ) )
shown to theright. Thetimebase dialogis instruNet Timebase
used to set the sample rate, the number of
data points to be acquired per channel for Pts Per Scan: | 1000 | (pts/scan/chan)
each scan (Pts Per Scan) and the data .
acquisition mode (Strip Chart, Oscilloscope, Sample Rate: ||Il]00.l]00[]0[l | (pts/sec/chan)
or Oscillo Queued). Set the Scan Mode v Strip Chart
popup for Strip Chart and click OK to exit Oscilloscope
the dialog. For adetailed explanation of the Oscillo Queued
various modes please refer to The Record

Page section of Chapter 5 instruNet World
Application Programin the instruNet User's Manual.

[0 Change the name of the task to Acquire by deleting the
name T1 and typing the name Acquire in the Name field Assistant for [Acquire
in the lower right section of the task editor. Next click the
Assist button to open the Task Assistant dialog as shown [J Create button that runs this task -
totheright. Click OK inthisdialog and then OK againin . [ Reposition all front panel objects
the subsequent dialog that appears. The Task Assistant
automatically creates a button with the same name as the [ cancet J|[ ok |
task and puts the button at the top of the front panel.

Clicking this button will run the task.

[0 Click the Acquire button to run the instrument. This button actually runs the
Acquire task which was set up to acquire 10 scans of data at asamplerateof 1000 : = @
samples/sec and 1000 pts/scan in Strip Chart mode. If you haveasigna (e.g. a 0300 m
function generator) attached to Ch1 Vin+ you would see it plotting in the display; ~ 2[20emoiv 0]
otherwise if nothing is connected you will see astraight lineat OV. To view the entire waveform in
the display, click the horizontal up arrow in the lower right corner of the display, as shown to the
right, until a setting of 100 or 200 ms/div is achieved.

[0 Select Save As... under the File menu, enter a name for your new instrument and then click the Save
button.

[0 Select New under the Wave menu to create anther wave. Do et | i |
not link thiswave to an instruNet channel. Click the Assist - " B
button at the bottom of the wave dialog and then click OK in : o
the next two dialog boxes that appear. Thiswill automatically o

create a second display, put the second wave (W2) in the new
display and place the new display under thefirst display. No
horizontal scale adjustment or scroll bar will appear in the
second display since these two items are linked to the first
display. When you horizontally scroll the top display the
bottom display will scroll with it and when you change the

scal e adjustment on the top display, the scale adjustment on the
bottom display will automatically change to the same setting.
Thetwo displays are linked in time. Y our front panel should look like the panel shown to the right.
Select Save under the File menu to save your instrument to disk.

0100 200 300 400 50D 5600 700 800900 100D 1100 1200 1300 msec
(s P[B oo msecniv [0
iz g

o

B
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O Select Edit? Acquire under the Task menu to openthe  ([EJJM[E)[U]w)  tesk:[hcquire ]
I

Task Editor. The small box at the lower left is called Sean Loop Begin <10 scans)>

the Instruction Dictionary and contains iNStructionSthal | **Brgitize seasent <1000 pts/scan, 1000.0 ptsssec, Osciliod
can be added to atask. Click and hold down on the Segment Loop End k

Calculate Wave instruction (the first instruction in the Sean Loop End

list), drag it up to a position between the Digitize

Segment and the Plot Segment instructions, as shown &
in the figure to the right, and let the mouse button go. - Name: [meamrs

The Calculate Wave dialog will open as shown to the
right. Thisisthe dialog used to define general wave Calculate Wave

math instructions (e.g. add, subtract, integral, FFT).

Click the lower of the 4 radio buttons on the left of the olw 1-[w |

dialog. Select W2 in the wave popup to the right of the o[ wi | = (w1 | ] [o-000000 |
radio button. Select Abs (i.e. absolute value) in the

popup to the right of the = sign. Select W1 in the olwr _ ]-[w J[ -+ J[w |
Source popup. This defines the equation: W2 = Abs @[ W2 | =-[ fbs |

(W1), or in effect W2 = Abs(Ch1 Vin+). When done Source: [T

your dialog should look exactly like the dialog pictured

to the above right. Click the OK button to exit the dial og.

Y our Acquire task should appear as shown to theright. If you Task Begin

accidentally put the instruction in the wrong place, click onit once  |Secan Loop Begin <10 scans)
to highlight it, select Cut under the Edit menu, click once on the Segment Loop Begin
Segment Loop End instruction to highlight it, and select Paste (or 32' . ;;:e(us‘e)g'e"t (1000
Command-V) under the Edit menu. If you entered the wrong math Plot Segment
instruction double click on the instruction to re-open its dialog and Segment Loop End

then change the parameters to the correct settings. Click OK to exit Clear & Update

the Task Editor. scon Loop Ert

Click on the Acquire button to run the instrument. At the end of each scan an absolute value of the
data acquired on channel Chl Vin+ will be calculated, the results will be stored in wave W2, and
displayed in the lower display.

Select New... under the Journal menu to open the Journal Dialog. Enter the name Notes into the
Name field and click the Assist button and click OK in the dialog that appears. Note that the journal
"Notes" is placed beneath the bottom display. The journal works like a built in text editor where the
user can type comments, or collect numerical data.

Select Save As? W1 under the Wave menu to open the file
dialog as shown to theright. For thisinstrument we will save S fcquired Datav] = Hard Drive
datato disk manually. Saving data to disk and loading data et
from disk can also be automated within atask. Automatic :
saving and retrieval of datais covered in the tutoria instruments
described in Chapters 3 and 4 of this manual.
5| (Format..)
File name: Folder:
wi | Acquired |
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[0 Click the Format button to open the wave format dialog shown

to theright. SuperScope Il waves can be saved as 32-hit File Format

floating point, Text, or Audio IFF (AIFF). Click the Text O 16-bit intagey
(engineering units) button and click OK to exit the dialog. @ 32-bit floating point

Enter the file name Test Wave and click the Save button. Since () Text (engineering units)
the wave was saved in a Text (i.e. ASCII) format it can be O Magsaoeoh Lab (36-511 inl}
opened from text editors or spreadsheets as well as from IR

SuperScope . If the wave was saved in a 32-bit floating point ( Audio IFF

it could be opened using SuperScope 11 or programming languages (e.g. C, Basic) but could not be
opened using text editors or spreadsheets.

[0 Select Open under the File menu and select Test Wave. Thiswill load the wave back into SuperScope
Il for analysis and display.

Thisisthe end of the design of the first tutorial instrument. Chapters 3 and 4 of this manual cover
advanced topicsin instrument design.
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Chapter 3
Tutorial: Building Instruments

This chapter describes the main features of SuperScope 1, in tutorial fashion. From here, you can take
advantage of the familiar Macintosh interface to explore additional capabilities. This chapter assumes
you are working with Version 2.0 or later of the software.

SuperScope I is designed to acquire, analyze, present, archive and control real-time-based waveform
data. It'sfeatures are summarized below:

* Extensive analysis, mathematics, presentation, data management and file I/O capabilities.

» Simultaneously digitize, plot and save to disk continuous streams of data indefinitely! Filesizeis
only limited by hard disk capacity.

e Compatible with instruNet hardware.

* Includes RS-232 support.

» Powerful dialog-box based macro language and menu editor enables the end user to redefine the
menubar and link new menu commands to macros. This, in essence, enables the end user to design
his’her own menu-driven application program.

» Employs an object-oriented approach that supports the following kinds of objects: waves, segments,
markers, displays, instructions, tasks, journals, menubars, strings, and variables. Objects are created in
any quantity, memory permitting.

* Includes powerful debugging tools.

Tutorial: Building Instruments 3-1



Super Scope |1 User's Manual

PART 1. GETTING STARTED

[0 Inside the “SuperScope 1" folder on your hard disk, locate the instrument file called "4Ch iNet Demo
Demo" (inside the "Tutoria" sub-folder of the "instruNet Instruments’ folder). Double-click on the
SuperScope || application to start it. Select Open... from the SuperScope Il File menu and open the

"4Ch iNet Demo Demo" instrument.

After afew seconds, SuperScope I1's menubar will appear at the top of the screen, and the instrument will

load, asillustrated below:

% File Edit Wave Display Journal Task Control ioNet

IE 4Ch ioNet Demo EI

[F cwi

Wave" Calc" —[='=

Wave Plot
Display "D2"

Resul ts

TDDD
NS
BOO6

\g;;;

Recording /
Channels

Wave Plot
Display " D1"

Marker "Al1"

[0 Select Run? Record under the Task
menu. SuperScope |1 will respond by
clearing it's lower-most display and
plotting the 4 analog voltage inputs vs.
time. If you are running in demo mode
4 analog input channels will be
simulated. If you are connected to
instruNet hardware actual data recorded
from the first 4 channels will be
displayed. The screen will show a4
channel strip chart recorder that
acquires 10000 points per channel at
1000 samples/sec per channel, as shown
to theright.

0 Select Run? Average from the Task

menu to run the task and view it's results.

Marker " A2"

4Ch ioNet Demo
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Each instruction executes in the order = ach ioNet Demo——xon | [32 6w |
that it appearsin thetask. First, the =
journal "Results" is cleared, then the
point-wise average of the 4 input
channels are calculated, and then the
W1 pulses times and maximums are
logged to thejournal. At the end, the
display updates, as shown to theright. |,

5.000 13.000
65.000 —
117.000
. 169.000
5.000 221.000
5.000 273.000
5.000 325.000
S5.000 377.000
5.000 429.000
5.000 431.000
5.000 533.000
5.000 585.000
5.000 637.000
5.000 689.000
- 741.000
5.000 793.000
5.000 845.000
5.000 897.000
5.000 949.000

Calc

EERAREERE R
aaa
8388
888

DRUTFARDNZD
2]
=]
=1
=]

THE TASK MENU
Tasks are programs that consist of alistof |,
instructions, which are executed in atop-to- o
bottom muer]ce Ea:h |n5truct|0n iS not ; 1] 20 40 60 30 100 120 140 160. 180 200 msec L
typed, however, as donein traditional = (el e
textual programming environments; instead, each instruction has an associated dialog box from which the
user specifies, in detail, the instructi onsfunctlonallty -- with easy to use pop-up menus, check boxes,
radio buttons and edit fields. It'sas easy as forming a sentence!

<<t< <
s&gs B

0 Select Edit » Record in the Task menu
to open the Task Editor, shown to the OYUMEL@  Task:
rlght The tag( ShOWﬂ ISthe defaUIt gresc::‘ gfgbier:;inning of task journal Results g
dl g'tl Zer'bM'tag( Wlth one Scan Loop Begin (1 scans)
ajdltlonal InStI’UCtIOI’I "CIear aI seg[l-ie;ittil_zo:pS:gelgei:t <10000 pts/scan, le+15 pts/sec)
beginning of task Journal Results’. Plot Segment
The minimal instructions needed to Clu € Uptaty
run the digitizing task are bolded while Scan Loop End
the added instruction is not. None of ||
the minimal instructions can be Y
removed from thetask, whileadded || [ Analysis Name: [Record |
instructions can be modified, moved Carve Fitting. '
around or deleted. Digitizer-based- Pulse fnalusis (CHeip... ) [mssist.. J[__ok )
tasks are used to control the basic I/0 it i
functions of instruNet hardware. Sunthesize (options...] [ Debug... ) [_Revert ]

The user adds an instruction to atask by dragging one from the Instruction Dictionary, in the Task Editor
lower-left, to the desired position within the task. Alternatively, the user can double-click on an
instruction in the dictionary to position it at the end of atask. All bold-faced instructions are present
when atask is created. They form the skeleton functionality and cannot be moved. The non-bolded, user-
added instructions are easily moved with the standard select, Cut, Copy and Paste commands. To create
atask without the bold-faced Digitize Scan, etc. instructions, one would choose New under Task, instead
of New Digitizer under Task.

[0 Scroll the Instruction Dictionary until the item "Displays" under the header "Management” isvisible.
Double-click on Displaysto openit'sdialog. Thisisan example of a user-added instruction. After
viewing it, press Cancel. If you had pressed OK, it would have been added to the task.

[0 Double-click on each instruction in the Dictionary to view the many wonderful tools that are available
to you. Press Cancel to exit each dialog.

The beauty of programming with dialog boxes is they
coach you into doing the right thing.
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[0 Click on the Cancel button to exit the Task Editor. If you clicked OK your modifications would have
been saved.

0 Select Edit» Average from the Task menu to — -
view atask named "Average", shown to the n@@@ foske
right. Thistask first clears the display Clear journal Resul ts B

Cale = Ain0

"Results’, and then sums the four analog inputs, Calc = Calc + Rinf

Cale = Cale + Ain2

point-by-point, to produce the point-wise sum of || |eaic = calc + Airz
the four. 1t then divides this sum by 4 to yield Puise analgsis on AIRD Cpulse®, nax, tnax to Resul i5)
the average. Thisall occurs point-wise, which
means that the Nth point of the result isthe
average of the Nth point in the 4 inputs, for al —
points. The last instruction searches wave W1, Filten = 1%

Pulse Analys

for pulses and when a pulse isfound, it transfers Sound Stqtistics
the time and maximum value of the pulse to the Suntnasize

front panel journal named "Results’. Inthis
case, apulseisdefined in the Pulse Detection dialog as falling below 2V, crossing 3V in the positive

direction, and then falling below 2V again.

Name: Iﬂuerage

((Hewp... ][ ok

o] (options...] [ Debug... | [ Revert

— ) @

[0 Double-click on theline "Clear at beginning of —
task Journal Results' to open the Journals & dournal or string:[_Resuits ]
Strings dialog, shown to theright. Thisinstruction O Clear N | O Insert wave definitions
can clear, inert text, append, copy, and search- e e e et e
replace text within ajournal or string. Strings are Ocopyinto: [ Results | | & insert trace number
SuperScope |1 objects that are used to hold text. O Append onto:_Results_| | O Update all journals
Journals are similar, yet their text isshown in a © Remove row numver | (T
t;r;stt éegi on that supports typing, Cut, Copy and o Dnemoue column number [1 |[_From left column |

Use Dariables
(O Change |\t |to|,

Many analysis instructions send results, in atabular O Insert: |Hello.

format, to journals. Thistext can then be saved to

disk, or transferred to another application program ([ Hetp ][ Doit ] (_cancel ] (oK ]

(e.g. word processor, spreadsheet, database, etc) via
the standard Copy and Paste. Click OK to close of the Journals & Strings dialog.

0 Double-click onthe"Cac=W1"

instruction to open the Calculate Wave Calculate Wave

dialog, shown to theright. This

instructions supports over 80 waveform @[ _Calc_ |=[_Ain0__ |

mathematics functions, including signal

averaging, convolution, integration, O talc |=[ wi | (=] {[o.000000 |

derivative, Fourier analysis and much

more. Thisinstruction is currently setup to O Cale | -[ Wi I T |
copy datain wave W1 into wave Calc. o[ Caic ] -[sm I
Calculate Wave contains pop-up menus that Source: W1 |

are used to build a sentence, such as"Calc =
Calc + W1". When the Calculate Wave dialog
is closed, the sentence is placed into the task,
and when the instruction is executed, the - e
actual mathematics are calculated. To (Hetp ) (View bata](_ Dot J( Cancel J{__0K ]
calculate immediately, one would press the Do
It button.

[J use Dariables
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[0 Presson some of the pop-upsto gain a sense of how thisworks. Press Cancel when done with your

review.

Programming Super Scope | is as easy as forming a sentence;
therefore, it'slearning curve is surprisingly short, and previous
programming experience is not necessary.

Double click on the "Pulse analysis ..."
instruction. The Pulse Analysis dialog will
open, as pictured to theright. This
instruction is used to determine pulse
characteristics (e.g. time, width, area,
maximum value, etc) and sends the resultsto
journals, waves, markers, variables, strings
and/or front panel indicators. For example,
this instruction could be used to measure the
peak voltage on every pulse in awaveform,
and to send the results to another wave.
Hence, one could view aplot of the
maximums by placing the result wave into a
display. Inour current example, Pulse
Analysis sends the maximum value, and the

Pulse Analysis on:

Send to journal: X Log pulse number
t3 tmax min2 t4
| Atmax |
max +
{— avg2
v2
-t/ tet -t/ te2
e e
slopel slope2
areal max2
ol |/
] :f [ é é: [ augt v\/_/
min 2t a2 \
a3 - area2
t1 t2 tS
Transfers... I 0K I
Detection... (_ Help ] ( cancel )

time of occurrence, of each W1 pulse, to the journal "Results’. To enable a calculation to ajournal,
one simply clicks on the desired parameter. To disable, one clicks again. Selected parameters are
marked with an enclosing box (e.g. [max], [tmax]).

Click on the Detection button at the lower |eft to open dialog
pictured to theright. A pulseis currently defined as afall below

2V, arise above 3V and then afall below 2V. Having two

thresholds instead of one reduces false triggers caused by noise.

Notice that OV isirrelevant. Click Cancel to close the Pulse

Detection dialog.

Click on the Transfers button to open the dialog shown to the
right. Thisisused to send any of the 24 pulse characteristics to

waves, variables, strings, controls, and markers; in any

Pulse Detection
botd

~Thr
High threshold:

3.000
2.000

Dolt
Dolt

Low threshold:

-U1 and V2
@ U1 = Low threshold, U2 = High threshold

() Calculate: vl = (10.0

% of min to max

v2 = |90.0 | % of min to max

[J use variables
[JExit instruction after finding pulse

combination! A marker'svalueis derived from it's position; a (Wep ) [ cancet ) [ ok )

control'svalue is derived from it's setting; a string or journal’s

valueis derived fromit'stext (zerois _

assumed if the text does not contain a Pulse Analysis on:[_ 1 _]

number); and awave's scaar valueis Transfer... min to...

derived from one point, as specified in e :

the Wave Transfer Options dialog, Owave: | Calc | (stians...) (w]

discussed later. This method of [ variable:| error | (Botivns..) @

transferring values, to and from objects, O Journal: |_Results | (8ntiens...)

of different type, is used by avariety of Ostring: [_retvalve | [sptions..] (5]

Instructions. [ control: EI

] O Marker: | time

00 Please press Cancel twiceto return to the otl 2

I)afﬁeﬁgéﬁrbﬁgfhe” press OK to return (et ) (Ciear ) (Cancer) [ ok )
Tutorial: Building Instruments 3-5



Super Scope |1 User's Manual

Super Scope |1 supports the transfer of data between objects of different type.
Thisis called polymorphism, and is a powerful attribute of Super Scope ll's
object oriented design.

SCROLLING THROUGH A DISPLAY

[0 Presson the horizontal and vertical time-per-division arrows at the lower right to see the
correspondence between these controls and display contents. Also, play with the horizontal and
vertical scroll barsto see how the entire display contents can be shifted left, right, up or down. These
controls enable the end user to zoom in, and pan, on interesting sections of awaveform.

[0 Select Mouse? Vertical Adjust in the Display menu and then click once on the W1 wave label at the
left edge of the display. Notice that the wave label highlights after being selected. This means that
you have selected this wave for mouse activity. Since the display contains more than one wave, you
need to specify which oneisto be operated on.

There are a number of things the mouse can do to awave, one of which is always specified in the Mouse?
submenu under Display. Vertical Adjust is used to adjust awave vertically, and to therefore de-couple it
from the vertical scale at the right of the display. A double-arrow (¥) appears next to the wave labels of
de-coupled waves. Pressing on this double-arrow causes the wave to snap back into position. Verticaly
adjusting is useful if several waves are plotted on top of each other, and need to be separated.

[0 Grab the W1 wave with the mouse and drag it up and down to get afeel for Vertical Adjust. Notice
the T symbol that appears next to the label when the wave is first moved.

O Click onthe ¥ symbol to snap W1 back into position.

Other mouse modes include Edit, which is used to select, Cut, Copy, and Paste waveform segments,
Draw, which is used to redraw the waveform; Log Coords, whichisusedtologan X & Y waveform
coordinate position to ajournal; and Move Marker, which is used to move markers. Markers are vertical
lines that mark a position within awave.

THE INSTRUNET MENU

The instruNet menu is used to set up the instruNet hardware. It maps directly to instruNet World pages
and buttons, asillustrated below. For example, choosing the View submenu under Record opens the
instruNet World Record page, and choosing the other Record submenus are like pressing the
corresponding buttons in the instruNet World Record page. For information on these features please refer
to theinstruNet User's Manual.
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View Page | = OpensinstruNet World Network Page

Restore —f—= Presses Restore button in Network Page

Store ———== Presses Store button in Network Page
Open  ———== Presses Open button in Network Page
Save  — 1 == Presses Save button in Network Page
—w| Clear ——1 = PressesClear button in Network Page
Reset — 1= Presses Reset button in Network Page
View Page |—= OpensinstruNet World Record Page
Start ——f—= Presses Start button in Network Page
Stop  ——f—= Presses Stop button in Network Page
Open  ——== Presses Open button in Network Page
Save  ———== Presses Save button in Network Page
Options ———= Presses Options button in Network Page
Timing ———== Presses Timing button in Network Page
Trigger ———== Presses Trigger button in Network Page
Network P |- | Probe — 1 == Presses Probe button in Network Page
Record 4
Test —+—== OpensinstruNet World Test Page
Trigger —m= OpensinstruNet World Trigger Dialog
O Select Network » View Page to open the Network Page, as shownto [E ioNet World FE
theright. It isherethat one selects the channel parameters and [Restore][ store ][ open || save ][ ci
options such asfilters, sensor settings and ranges. Please refer to Channal et dev jmed || Value Input
Chapter 5 of the instruNet User's Manual for a detailed description I f e S —~
of the Network Page. Changes made here are stored in the e
SuperScope I instrument file. Click the upper left corner close box — [enizuims 07 1 oats
to close the instruNet window. R R L |
¢I I = 1 1 1 -0.072194
O Select Options? W1 under the Wave menu to open the wave dialog, etwe Record Test /o
and then click the Channel button to - Network Address
open the instruNet Channe Selection Network Device Module Channel
dialog, as shown to theright. This | [ Fisioti4 || 1#100 ][ 1#100 ]| ChiUin+ |

dialog provides 4 popups that select an
instruNet channel viaits channel address, as described in the instruNet User's Manual. Using this
dialog, any SuperScope |1 wave can be linked to any input or output channel viait's address (i.e.
Network, Device, Module and Channel). In this example instrument, wave W1 islinked to the first
anaog input channel on the instruNet network. When a digitizer based task runs, data digitized from
Channel Chl Vint isstored in wave W1. The other instruNet analog input channels are linked to
waves W2, W3 and W4, in this instrument.

SAVING THE INSTRUMENT SETUP
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To preserve changes in the setup, save the instrument to disk.

00 Select Save As... from the File menu.

[0 Type"4ChiNet Demo Demo#2" into the standard file dialog, and click on the Save button.
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PART 2: EXPLORING THE FRONT PANEL

This part of the tutorial continues to use the demo instrument "4Ch iNet Demo Demao”.

O Select Run? Record from the Task menu. The lower display will update as pictured below (or
something similar).

The Wave Plot display, named D1, i
shows a plot of the 4 recorded -30
channels (in volts) as afunction of flnd U
time (in seconds). Therecorded data 40
variesin amplitude from -10 Volts to 012 14 16 13 20 sec o
+10 Volts. Depending on the size of []2.03 sec/niv_[ft
your screen, and the software Lot Scroll Wave Plot Right \ Timescale/”
instrument that you select, the Wave Scroll Arrows

Plot display may not show the entire /frcr:)‘:,'v'
range.

Scroll

Box Displa
B AiFr)10')'/ Bar Arrow

SCROLLING AND CHANGING SCALE
If only a portion of the time wave isvisiblein the display, use the scroll bar to move around:

O Click or press on the right and left horizontal position arrows (&][2]) for precise movement, drag the
scroll box (I.}) to move to a specific location, or click on either side of the scroll box to move by
about 75% of a scornful.

To change the amount of time that is displayed, change the horizontal scale (seconds-per-division):

O Click the down time scale arrow ([2]) several times to zoom in on the time wave. Notice that the
msec/Div number decreases each timethe [3] is clicked. Then click the up time scale arrow ([&]) until
you can see the entire waveform.

O Asashortcut, click on the H button ([x]) in the upper right corner of the D1 display. SuperScope Il
will automatically set the horizontal scale so that the entire waveform fits exactly in the display.

M OVING M ARKERS

Specific time values in awave are specified with vertical marker s that are moved with the mouse. Two
markers, M1 and M2, are currently visible in the two displays. Each marker can be moved independently
of the other, and each maintainsits position until moved again.

[0 Click onceinside D1 (at the bottom of the screen) to make it active.

[0 Move the mouse pointer to the left-most marker, M1. When the mouse pointer lies directly on the
marker, hold down the Option key (which changes the cursor to ), press the mouse button and drag the
marker about half an inch in either direction. Release the Option key and the mouse button. If you
have trouble moving the marker, make sure you are placing the cursor exactly on top of the marker,
and then press the mouse button, and hold it down as you move the mouse left or right.

THE MARKER LABEL AREA
The row of text and numbers at the top of display D2 is called the marker-label-area, and it shows
information pertaining to marker positions. In thisinstrument, the marker names, time positions, (in
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seconds) and W1 values (e.g. Volts) are shown directly above each marker. The time difference could
also be shown, on the far left side of the marker-1abel-area.

O In D1, move markers M1 and M2 and notice how the numbers in the marker- label-area reflect the
positions of the markers.

The SuperScope Il front panel is completely customizable, allowing multiple displays, linked in time,
with the same markers shown in each display.

JOURNALS
SuperScope Il journals are ssmple text editors for storing data and notes.

[0 Select Mouse? Log Coords from the Display menu. Select Log Coordinates » Results from the
Display menu.

[0 Click once on the W1 label, at the far left of display D1, to select W1 for mouse activity. When

selected, it will become highlighted with a dark rectangle (GH&E). Y ou might need to click two times,
once to select the display, and once to select the wave.

[0 Click at severa points along W1 and notice the wave coordinates that are logged to Fiesul ts

. Aind
journal Results. X:sec Y:Ualt

1.976624 4.155
O Select Save As? Results from the Journal menu and then press Save when the File  |3.76937  —1.914
dialog appears. This savesatext fileto disk that can later be opened by aword ' '

processor, spreadsheet, or database.

This concludes Part 2 of the tour. The next section will cover waves, and introduce two different software
i nstruments.
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PART 3: WORKING WITH WAVES

Both acquired waves and the results of calculations are stored in SuperScope Il objects known as
"waves'. This section will demonstrate how to edit and analyze these objects. We will continue the
tutorial with the same instrument.

SELECTING A PORTION OF A WAVE

It is often useful to work with asmall portion of awaveform. The standard technique for selecting a
range of datais to drag the mouse. Y ou are accustomed to doing this with text, and in SuperScope 1, you
can do this with waves.

0 Click onceinside display D2 (at the top of the screen) to make it active.

O Select Mouse » Edit from the Display menu.

[J Drag over aportion of
the wave with the mouse. w
The selected portion will
become highlighted.

This portion is called the "Selected” wave , and can be analyzed like any other wave. Like segments,
the "Selected" wave shares the data with the host wave.

[J To savethe datain the highlighted

region, select Save As? Selected Save Wave Options
from the wave menu. When the File -File Format -Data
Save dialog appears, press the . _ @ All points
Format button to open the Save L il integer O From points:
Wave Options box, pictured to the ®)32-bik flsating polnt '
right. It'is herethat the user {O Texrt (engineering units) |_| to | 100 I
specifies one of the many file data O MaesSpeeeh Lab {16-bit inl) o
formats. 32-bit floating point and O Audio IFF Hg?:&?;;ﬁ;:rme
16-bit integer are the most common O Besouros (8n sn formal 1) [ Date
and are supported by both GW O P30T O] Time

1

Instruments products and Igor. Text
is compatible with word processors

and spreadsheets, yet is slow and (cancer | [ ok J

creates largefiles.

[0 Click Cancel to exit the Save Wave Options dialog, and then click Save to save the " Selected" wave to
disk.

WAVEFORM EDITING
The standard Macintosh Cut, Copy & Paste commands make editing a breeze.

0 Select Cut from the Edit
menu. The Selected W W
region will disappear,
and will be copied to the
clipboard.
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[0 Select the journal with one mouse click, and then choose Paste under Edit. The Resul ts
wave on the clipboard, which isjust alist of numbers, will be copied into the 4 65820312
journal, as shown to theright. In thisway, one can copy wave datato and from 4.49707021
many application programs. The Copy Wave Text command under Edit is 4.313964384
similar to Copy, except it transfers an entire wave, segment or Selected to the 410888672
clipboard. 3.88671875

3.64257812

[0 Click the mouse at any point on the waveform and select Paste from the Edit menu. The previously
Cut datawill be inserted into the wave.

In summary, waves are edited with Cut, Copy, and Paste; just like text.

W AVEFORM SEGMENTS
SuperScope |l offers a second technique for defining a portion of awave: any two markers and a source
wave can define a"segment”.

[0 Click onceinside D1 (on the bottom) to make it active.

[0 Change the scale to about 2 sec per
division (depending on your screen
size). Sincethe horizontal axes of both
displays are linked, the top display will
adjust to keep up with the lower display.
The vertical axes are not linked
however; therefore their scales can be adjusted independently.

[ Select Markers? D1 in the display menu and then click New in the Segment ~ ;-Segment: [_Segi |-

areaof the dialog. Thiswill create a new segment, called "Segl", and Name:
defined it as the section of wave W1 between markers M1 and M2, as shown
to the right. Click OK to exit the dialog. lave:
[0 Double-click on the region above the label or choose Options D1 under Bound:
Display to open the Display Options dialog. R Warrs
ew eletle

[0 Noticethetwo listsin the Contents area of the dialog. The Waves list, on the left, shows all

available waves, 1/0 channels and
segments; the Display list on the Displag:[_ D1 |
right shows which waves, 1/0 Contenits
channels and segments are to be Name: |[IIEEEEEEEN Waves Display
plotted in thisdisplay. Drag . AIND &
channel Seg from the Waveslist to Tupe: Ain1 B
any dlot in the Display list as :in;
pictured above. Press OK to exit in
the Display Options dialog. S ted
seq!
O Select Mouse? Vertical Adjust in a
the Display menu and then click v
once on the Segl wave label at the
left edge of the display. Notice (Hetp.. ) [cancer ][ ok
that the wave label highlights after
being selected.
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0 Vertically adjust segment Segl (i.e. drag the mouse) to offset it from it's
host wave, as pictured to the right.

0 While holding down the Option key (which will change the cursor), move  gino
the left marker one-half an inch to the left, and then move the right marker
one-half an inch to the right. Notice the segment updates accordingly.

O Select Mouse? Draw in the Display menu. The mouse will change to a pencil. Now
draw on the Segl wave (i.e. drag the mouse) to update it's data. Notice that W1's data ,_\/j
changes aswell. Thisis because both segment and host share the same data. If you
select Grid Snap on in the same menu the mouse will be restricted to drawing straight lines.

From atask's perspective, a marker islike avariable that contains avalue. This value corresponds to the
position of the marker. For example, amarker at 0.123 sec contains the value 0.123. This value can then
be read or updated by atask instruction, just like avariable. When amarker is moved by the user, it's
value updates accordingly.

EDITING WAVEFORM VALUES

On the computer, waves are represented as a series of numbers. These numbers are often referred to as
"points’, "values' or "samples’. Each sample represents the digitized voltage (typically in the range of
+10V) at aparticular time. 1t is sometimes useful to examine and edit the actual list of numbers.

00 Choose Edit Values? W1 from the

Wave menu. The Wave Editor shows Edit Dalues:
the index in the left-most column, and sec
the wave values in columns #2 through 0.000[ . 0.0000  0.4880 0,977 1.4500 1
#6. The individual data points are read g;;g i?gg 3:;3 3;1?; 33;2 2
|left to right, top to bottom, with five. O B B 4 S
samples on each row. For example, in 0.460] 4,619 4,409 4,155 3,867 3.
the picture to the right, point#1 is 0.000, e A T T-71 P
point #5 is 1.914, point#6 and is 2.358. 0.690( 0,977 0,488 0,000  -0.488. -0,
Point#6 is at 0.115 seconds, relative to 0.804| -1.450: -1,914; -2,358 -2,778. -3,
point#1, which is at 0.000 seconds. 0.919)..-3.339:  -3.867; -4.159.  -4.409; -4,
1.034 -4.785 -4.902 -4.976 -5.000 -4.

In the Wave Editor, the value of any sample rOptions : :

may be changed by typing anew number indew . format Units - Tuping oo (K
intoitscell. e Typing option is 0 | A Point O Be Internal Insert

Overwrite, the value in the selected cdll is (OPoint Obes Olnternal O Inser

overwritten; otherwise, the entire wave is
shifted forward each time the user clicksin acell. And hence, one can "insert" a point into awave.
Ranges of cells can be selected, Cut, Copied and Pasted within the Wave Editor, and to and from
SuperScope I journals and displays. Additionally, this text can be transferred to and from third-party
spreadsheets, word processors and application software. When waves are represented as text, each point
is separated with a carriage return. Subsequently, they appear as a column of numbers in a spreadsheet or
word processor window.

O Click OK to exit the Wave Editor.

W AVE STATISTICS
The user can easily calculate Statistics on awave, 1/0 channel, segment or selection.
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[0 Select Run? Average from the Task menu. The point-wise average of the four channels will be
placed into the upper-most display.

[0 Choose Wave Statistics? Calc from the
Wave menu to view wave statistics. Select Wave: Statisti
another wave in the upper-most pop-up ave: [_Calc____| statistics
menu to view statistics on another wave. . .

Number of points in memory: 1000

Thirs]isan example ofotlaloinlg analysie? manually Data sampled at: 43.509 points / sec

with a menu command. Alternatively, one - .

could set up atask to do this automatically and Minimum: -5.000 Uolt (at 21.70 sec)

send results to ajourna, wave, marker, Magimum: 5.000 Uolt (at 22.43 sec)
control, indicator, variable, or string,
Mean: 0.092 Uolt

O Choose Filter » Ain2 from the Wave Standard deviation: 3.635 Volt
menu, and then change the Frequency Cutoff
for the filter to 5% of the samplerate. Stay
with the Low Pass HAM (Hamming Window) Root mean square: 3.637 Dolt
filter. Click OK to apply the low passfilter. Duration: 22.961016 sec

The display willhshow that the hihgh-frgquency Sum of points: 92.131348 Volt
components in the square wave have been
attenuated. Many of the higher order
harmonics were filtered out to |eave something
[0 Click OK when done with your review.

Area under wave: 2.118 Volt - sec

FILTERING

similar to asine (i.e. the wave got

smoother). Filter:

The Filter dialog contains several resident Type: [ Low Pass HAM | (Custom...)
filters, yet in many cases, they will not suit

your specific needs. In these cases, you Freq Cutoff: | 5% (% of sample rate)
need to des agn acustom filter with another Boundaries: _zero pad

application program, and store thisfilterina || . _

SuperScope || instrument. For awonderful . Freq Cutoff: 2.1 Hz Phase: linear
little $99 product to do this, please contact . Stopband: -42 dB Taps: 40

Zola Technologies, order #Z-WLFDAP,

TEL# 404/843-2972, FAX# 404/843-0116. '

EXPLORING SUPERSCOPE ||

Using the techniques that you have learned, please explore SuperScope |1 on your own. Try loading other
instruments and waves. Test out any menu item or front panel control. If you get stuck and need some
help, please feel freeto give usacall.

QUITTING SUPERSCOPE ||
The next section covers the instrument design features in SuperScope I1. If you do not want to tackle that
quite yet, you can quit and explore more at another time.

0 If you do not wish to continue, select Quit from the File menu.
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PART 4: DESIGNING INSTRUMENTS

Waves, markers, displays, journals, controls, variables and tasks can be combined like building blocks to
create software instruments. A few pre-defined instruments have been included with SuperScope 1.
This section describes how to customize SuperScope |1 by modifying an existing software instrument, or
creating a new one from scratch.

The following pages demonstrate how to change the front panel layout and add anew display. Before
starting, reload the instrument used in Part 1.

[0 Select Open from the File menu, and choose "4 Channel instruNet.demo”.

THE FRONT PANEL
The main SuperScope Il window is referred to asthe front panel. It contains displays, front panel
journals, controls, indicators and pictures. Y ou can change the size and position of

each front panel object with
Panel Edit Mode. For —
example, you may want a B

wider journal to enter more 2 2
substantial comments, as . .

illustrated to the right. 3 1

[ E=——— 4 Chan Scan Line
02

In Panel Edit Mode, all 1
displays, journals, controls,
indicators and pictures can be
moved, resized, and deleted.
When Panel Edit isturned on,
arectangular outline of each Before After
front panel object appears, with the object name in the upper left corner, as
shown to theright. If an object is selected, its name appears bold. To
resize, one simply drags the resize box (i.e. little black square at lower
right). To reposition, the user drags the actual object. To reposition an
object one pixel at atime, the user selects with the mouse, and then taps on

the < 4 T—= keys. Toresize one pixel at atime, one selects with the

mouse, holds down the Option key, and then taps on the <= L T- keys. Thisisvery similar to working
with rectangles in MacDraw.

.......................

SuperScope Il prohibits shrinking displays below a practical minimum size to ensure readable content.
Individual items within objects cannot be resized, independent of the object. Should displays or journas
overlap, awarning isissued (i.e. "Invalid Panel" in status bar) and the user is prohibited from leaving
Panel Edit Mode until the overlapping is eliminated.

[0 Select Panel Edit On from the Display menu.
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[0 Resizethe D1 display by
pressing on the small black
box in the lower right
corner and dragging to a
new position.

[0 Resizethe Resultsjournal
by the same method.

[0 Movethe Resultsjourna so
it isdirectly under display
D1. Makesureitis
touching D1, yet not

overlapping.

[0 Resizethe displays and
journal as shown in the
figureto theright. (Tip:
hold down the Option key

Before

and use the right and left arrow keysto resize one

pixel a atime).

[0 Select Panel Edit Off from the Display menu. You
can now use the new layout. Congratulations! Y ou
have created your first SuperScope |1 front panel.

After

B oW
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O To savethisinstrument for future use, select Save As
from the File menu, type "4Ch iNet Demo Demo 3"

into the file name field, and then click the Save
button. Y ou have now added a new instrument to
your portfolio.

CREATING DISPLAYS AND WAVES

In addition to rearranging a front panel layout, you may
want to add objects to the front panel. We will show you [EEIIZ

how thisis done by adding awave and a display to the
4Ch iNet Demo Demo instrument. Objectsin
SuperScope Il can appear in any quantity, memory
permitting.

@
z

4 Channel Scan.demo

M1:3.219¢INaN1)

112:6.298C (Nall 1)

Calc

B N

20

BE

Volt
10

laELE

—==
558

&=l

nsec
O8] 735 msec/niv_[{

[0 Select Open from the File menu, select the original "4Ch iNet Demo Demo" instrument, and press

OK.

[ To create a new wave, select New from the
Wave menu. The Wave Options dialog will
appear, as shown to theright. It isfrom here
that one can view and modify awave'sinterna
data and length.

O Typeinthename"Sine" and click on the
Synthesize button to open the Wave
Synthesizer.

The Synthesizer is used to load awave with asine-
wave, square-wave, triangle-wave, ramp, constant
value, gaussian noise, or uniform noise. Sine,

Wwave:| W1 |

Name: |1 ( Format... | [ Edit... ]
Units: (" Points... | (Synthesize]
Place wave into display: E

(] If wave changes, run:

Seamless scrolling via: [_< |
[JLink to ioNet [Channel

(Comments ] [ Assist... ][ cancet || ok ]|

Triangle and Square waves are specified with the
Points-per-cycle and Peak-to-Peak Amplitude

fields, the Ramp is specified with the levels at the
two end-points, the Gaussian noise (histogram is a
gaussian curve centered about 0) is specified with an
RMS (Root Mean Square) value, and the Uniform
noise (histogram isflat) is specified with a+range
value.

[0 Click the OK button to load "Sine" with a 200
point, 52 point-per-cycle, 10V peak-to-peak sine-
wave.

[0 Click the Edit button to view your data. Click OK
when done.

Synthesize:
points

® Periodic: |52 points/cycle
10.000 Dolt amplitude

@ Sine (O Square OTriangIeE

Length:

ORamp:  {0.000 | to [5.000

() Constant: ICI Volt
) Guassian: Uolt rms noise
) Uniform: (10.000 Uolt random noise ()

( Hetp ] [ Doit ] [ cancel |

|voit
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O Click the Points button to view several internal
parameters.

Thisdialog is used to view and edit the amount of
data storage (in points) assigned to the wave, the
number of valid data points, the sample period
(time between points) and the first point time. The
storage length is the amount of memory allocated to
the wave in terms of # of points, and the number of
valid data points is the # of valid data currently in
that storage buffer. The # of valid points will range
from O to the storage length, and the storage length
will range from O to that permitted by available
memory. 16bit integers consume 2bytes per point
and 32bit float consume 4 bytes per point; therefore
a 250K point float wave would consume 1IMB, for
example. If Save Data With Instrument Fileis
checked, SuperScope Il will save the wave's datain
the instrument file. If it is not checked, the waveis

Data Points: Sine

Storage Length: ||200
Valid Data: | 200
sample Period: |0.0010000000 | sec
|0.0000000000 | sec

| points

| points

First Point:

Last Storage Location: 0.1990 sec
Last Ualid Point: 0.1990 sec
Sample Rate: 1000 pts/sec

[J] save data with instrument file

] [ cancel |

[ Help

saved with O points of data. Including wave data in an instrument file increases the size of that file by the

space required to hold that data.
[0 Click OK twiceto return to the front panel.
[0 Select Panel Edit On from the Display menu.

[0 Resizethe Resultsjournal to make room for a
new display, as shown to the right

[0 Select New from the Display menu to create a
new display and to open it's Options dialog,
pictured to theright. Use the default display
name D3, and make sure Wave Plot is chosen in
the Type pop-up menu. Drag the Sine wave
from the Waves list into the top dot of the
Display Contents list, as shown in the
illustration to the right.

[0 Click OK to accept the changes and exit this
diaog.

==——— 4 Channel Scan.demo

M1:3.219¢(NaN1) 12:6.298¢ (NaN1)

0735 1471 2206 20942 3677 4413 5148 5884 6619 c
] B[ 735 msec/Div

............................................................. Contents ..
Name: 3

Wave Plot

Controls...

i

Type:

Calc
Selected
Sine

Features...

Markers...

Labels... 1]

Comments

( Heip.. ][ cancel ][ ok
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[0 Move and resize D3 until it fills
the lower right corner of the
panel, as shown to the right.

[0 Select Panel Edit Off from the
Display menu. Y ou can now
use the new layout.

O To savethisinstrument for

|

E=—— 4 Chan Scan Line
02

future use, select Save Asfrom
the File menu, type "4Ch iNet
Demo Demo 4" into the dialog,
and click on the Save button.

E=——— 4 Chan Scan Line
02

Before

After

This new instrument is very similar to the "4Ch iNet Demo Demo", although it has an additional display.
Display D3 is used to hold the "Sine" wave, yet it could also be used to display the results of a calculation

or to show an additional 1/0O channdl.
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PART 5: CREATING A NEW INSTRUMENT

This section shows how to

[E==simple ioNet Instrument = |52 6w |

create a simple instrument e
from scratch. This Valt
instrument, pictured to the 2 ‘}28
right, contains two wave plot 1o =
00 320 340 Hz O

displays, ajournal, several
waves, several markersand a
segment. It also contain one
digitizer-based-task and one
regular-task, named Acquire
and Analyze respectively.
Acquire does the following
10 times (i.e. 10 scans):

[8] 20 Hz/Div [{r

T %g o
-~
[G[a5e o=

C:)IO' S0 msec/Div IQ

Sc o

o

-~
5= BI=

* Digitize 4100 points at a
50ps per-point rate from

L-s
o|3[50 msec/niv [{3]

one analog input channel.

« Cdculatethe point-wise [0 The End ! |
average of W1 (i.e. 2 esz [
SigAvg = N
SignalAvg[W1]).

* Update the screen.

The Analyze task moves marker A3 to the peak of the FFT wave, and then transfers the maximum FFT
value (the intersection of the marker and the FFT wave value to the journal.

If you are running a demo version of SuperScope |1 2.0 it will simulate an instruNet hardware system
consisting of 1 controller and 1 Model 100 network device. Thistutorial is applicable to both the demo
version of SS1I 2.0 and thereal version. If you are using the real version of SuperScope Il in conjunction
with an instruNet controller and network device you might want to connect asignal (i.e. asignal
generator) to channel Chl Vin+ following the directionsin Chapter 3 of the instruNet User's Manual.

Y ou can do the tutorial with the real version of SuperScope Il and without connecting a signal but the
incoming signal will be aflat line (0 Volts) and the analysis will not provide meaningful results.

[0 Select New Instrument from the File menu and click OK in the confirmation dialog. This command
deletes all objects, allowing you to proceed with a“clean date.” Creating a new instrument does not
erase the old instrument from disk, it merely deletes it from temporary RAM memory.

THE INSTRUNET NETWORK & INPUT CHANNELS

[0 Select Network » View from the instruNet menu. Thiswill open the instruNet World
Network Page described in the instruNet User's
Manual and is the starting point for setting Channe | net idev imod || Filter
channel parameters (e.g. sensor options, filter Chi Uin+ 1 1 1 off
options). Horizontally scroll through the
Network Page to the left until the column labeled Filter appears. Click the Filter cell for the Chl Vin+
(i.e. thefirst row in the Network Page if you have amodel 100 network device installed) to open the
Probe Dialog set up to display the Low Pass Filter settings. Select Elliptic in the Filter popup and
then click the enter button at the bottom right of the dialog to turn the filter on. If you have asigna
connected to the Chl Vin+ channel you should see the immediate affect of implementing the filter in
the snapshot display at the bottom of the dialog assuming your input frequency islarger than the low
pass cut off frequency. Try several different filter settings and then click OK to exit the dialog. For a
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complete description of the Low Pass filter dialog please refer to Chapter 2 in theinstruNet User's

Manual.

WAVES

We will now create three waves, one to store the data acquired on channel Chl Vin+ and the other two to
hold the results of analysis performed on the acquired data.

O Select New from the Wave menu to create
anew wave and open the wave dialog.
L eave the default name of W1 and click
on theLink to instruNet checkbox. This
will open the instruNet Channel dialog

[ #1siot14 ][ 1 #100 ][ 1 #100 ][ cChi Vin+ ]

-ioNet Ch

Network

Device Module Channel

[ Cancel

J Lo )

which is used to specify which instruNet channel islinked to this particular SuperScope Il wave.

Press OK after selecting a channel.

[0 Create a second wave by clicking in the Wave popup
at the top of the Wave dialog and select New Wave.
Type"SigAvg" into the Namefield. Click the Format
button and note the default setting is 32-bit floating
point. Data can either be stored in 16-bit integer or
32-hit floating point format. Recorded instruNet data
isalways stored in 32-bit floating point format and
waveforms used for calculations are frequently set to
32-hit floating point for accuracy and speed. Click

Cancel when done with your review.

O Create one more wave, nameit “FFT”, and

then press the OK button to exit the Wave
dialog. FFT will also be a 32bit floating
point wave.

DISPLAYS
We will now create three displays.

Data Format: SigAvg
{® 32-bit Floating Point (Dolt)

(O 16-bit Integer

Internal

Uolt

[ Help ] [Cancel

]

[MEXEN | Sighvg

Name:|SigAvg

New Wave %W

| Edit...

Units: ( Points...

] [Sgnthesize]

[0 Select New from the Display menu.

[0 Dragwave W1 from the Waves list to
any slot in the Display list, as
illustrated to the right. Thiswill cause
wave W1, which will contain the data
acquired from channel Chl Vin+ on
the instruNet network to be shown in

display D1.

Name:

Type:

01 Waves Display
Wave Plot FFT it wi
SigAvg
ui
A_S1
s
(Comments] [ Help... ][ Assist... |[ Cancel | 0K
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[0 From the upper-most pop-up, select
New Display and then type Display:|v D1
“AvgDisp’ inthe Namefield. Notice
that the display typeis currently set Name:
to Wave Plot. If we wanted to plot
one wave against another, we would set the display typeto XY Plot.

I]I| Display

[0 Drag wave SigAvg from the Waves list into the Display Contents list.

[0 Click the Assist button at the bottom of the Display dialog and click OK in each of the dialogs that
appears. The Assist button automatically places objects on the front panel in an orderly fashion.
Clicking OK in the Assist dialog links the horizontal scale in the second display to that of to the first
display. Thistime-locks the displays such that changing the horizontal scale in thefirst display, or
scrolling through the first display will have the same affect on the second display.

[0 Create one more new display and nameit "FFTDisp", and then drag the "FFT" wave into it's Display
Contents area. Click the Features button in the Display dialog and set the Horizontal Unit field to Hz.
Click Okay to exit the dialog. Click the Assist button again but when the first dialog appears turn off
the "Link horizontal axisto Previous display” option. Since the FFT wave has a horizontal unit of
Hertz, and not seconds, it would not make sense to link these two displays.

[0 Click OK to accept the changes and exit the Display dialog.

JOURNALS
We will now create two journals.

Journal 1 |

[ Select New from the Journal menu. We'l use the Name: Font:
default journal name, "J1", for now. Position: Mode:[ Spread Sheet |
View: X Show name
[ Select New Journal in the upper pop-up menu to D o Vet o bordar oL horiz scroll bar
Create anOther journal, and then preSSA$St C“Ck Options: []Save contents with instrument file
OK In the d|a|0g that appeal’s NOt E'Ihejourna|S are Runtime: [] Prefix notes with: @ Seconds ) hrs:min:sec
placed immediately below the displays. [ show notes in display[_o |

iHdim ] inshas

Tab: characters

[ Help ] [ Assist... ] [ Cancel ][[ 0K ]]

|

At this point your front panel should look like the one [E=simpie ioNet instrumentt
displayed to theright. The three displays are b -
automatically placed on the top of the display and the

two journals are placed on the bottom. Using the Assist
button helps you to quickly design afront panel. If you
don't like the Assisted layout, turn panel Edit On (under
the Display menu), and adjust the front panel as needed.

30 40 S0 60
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M ARKERS & SEGMENTS
We will now create three markers and one segment.

U

0

At thistime, markers M1 and M2 should be visbleinthe D1 and
AvgDisp displays, and marker M3 should be visible in the FFTDisp, as

Select Markers? D1 from the Display menu to
open the Markers & Segment dialog, pictured to
theright. Take amoment to survey this
powerful dialog. Itisdivided into three aress.
The Display area determines which markers are
shown in each display. The Segment areais used
to create, modify and delete segments; and the
Marker areais used to create, modify, and delete
markers. We will use al three areas of this
dialog.

In the Marker area, press the New button once.
You've just created your first marker!

In the same way, create a second marker.

Both marker names will appear in the Show Markerslist, in the
Display area. Click M1 and then click M2 to specify that both are to

be displayed in the D1 display.

In the Display pop-up menu, select AvgDisp and then click M1 and
M2 again to place these markers in the AvgDisp display.

In the Segment area, press the New button once. W1, M1 and M2 are
automatically selected in the lower three pop-up menus. You have
just created the segment Segl, which is defined as the section of wave

W1 between the markers M1 and M2.

In the Marker area, press the New button once to create a third marker.

In the Display pop-up menu, select FFTDisp, and then click once on

the"M3" marker.

Click OK to exit the Markers & Segments dialog.

pictured to the right.

CUSTOMIZING THE DISPLAYS
The next step isto modify the appearance of the three displays.

Markers & Segments
-Display: [ D1 |- ~Segment: [ |-
Show markers: .
g veme [ ]
wave: ]
~Marker: I—I -----
[ New ] [Delete]
[ Window: sec
([ New ][ pelete ] [ Help.. ] [ cancel ]
~-Display: | D1 |

Show markers:

-segment: [ Segl |-
Name:
Wave: | W1 |
Bound: | M1 |
Bound: | M2 |
[ New ] [ Delete ]

Ee==—T
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[0 Select Controls? D1 from the Display
menu to open the dialog pictured to the
right.

Thisdialog isdivided into two areas. The
upper area determines the horizontal scale
(e.g. Time/Div) and position controls; and
the lower area determines the vertical scale
(e.g. Voltg/Div) and position controls.
Notice that the Horizontal Position is set to
Scrollable and the Horizontal Scaleto is set
to Adjustable. This meansthat a scroll bar
controls the horizontal position (i.e. the left
edge of the display) and up/down scale
buttons control the number of horizontal

units-per-division (i.e. seconds-per-division).

[0 Click onthe"Add H auto adjust button”
checkbox to add a magical little button
(H]) to the display. When this button is
pressed, the horizontal scale and position

..Horizontal

Position:| Scrollable |

Scale: | Adjustable |

[JAdd "H" auto adjust button
[ Auto-scroll seamless data

- ertical

Position:| Scrollable |

Scale: | Adjustable |
[JAdd "D" auto adjust button

[ Fix sample period to (0.001000 |sec/pt

will automatically adjust to accommodate the wave. The left edge of the display is set to the first
point of the left-most wave; and the right edge of the display is set to the last point of the right-most

wave.

[0 Inthe Vertical area, select Fixed in the Position pop-up.  :-Uertical
This removes the vertical scrollbar and fixes the center of . position: [ Fixed | at |0.000000
thedisplay to O (e.g. Volts). Wewill leavethe Vertica = ...

Scale to Adjustable. Thiswill enable the end user to
update the Volts-per-division, as desired, with the front panel controls.

[0 Click in the Controls popup at the top of the dialog and select display SigAvg. Select Fixed in the
Vertical Position pop-up menu or the SigAvg display and leave the Vertical Scale pop-up menu set to
Adjustable. Thiswill alow for vertical scaling with the center of the display fixed at 0 Volts.

[0 Select FFTDisp from the upper-most Controls pop-up menu.

[0 Set the Horizontal Scale, Horizontal Position, and Vertical Position pop-up menus to Automatic; and
leave the Vertical Scale set to Adjustable. Automatic causes the display to automatically adjust to fit
the wave (the left edge of the display aligns with the first point of the left-most wave, etc.).

[0 Click OK to exit the Controls dialog.

We will now modify afew attributesin the AvgDisp and D1 displays.
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We will now add a marker label line, pictured to theright, to

Select Features? D1 from the Display
menu. The Display Features dialog
will appear, as pictured to the right.

Select None from the Grid pop-up
menu to eliminate the dotted lines that
in the plot region.

De-select the Add Wave Labels
checkbox to remove left-edge wave
label region. Wave labels are useful
when more than one wave is shownin a
display, and you need select one (i.e.
click on awave label) for Mouse Edit,
Draw, Vertica Adjust, or Log
Coordinates.

-Plot Region

Plot: [ Lines

width:[1 |

[ Add asis labels

Background:

[J Hide entire display

] unit: l:'

[] hrs:min:sec

(< Add asis labels

-Display Labels

] unit: |:]

[J Add label: [D1

(< Add wave labels

([ Help... ] [ cancel |

Use the upper-most pop-up to make the same modifications (i.e. turn off grid and disable wave labels)

to the other two displays and then click OK to exit the Features dial og.
|M1)\/|2| time /Ml time /MZ time

show the positions of markers M1 and M2.

U

Select Labels? D1 from the Display menu to open the

Display Labels diaog, shown to the right.

M1 is selected in the upper-most pop-
up menu. Select the "Show X value"
option under this pop-up to enable the
M1 position label.

M2 is selected in the other Marker pop-
up menu. Click the "Show X value"
checkbox, below this pop-up, to enable
the M2 position label.

In the Delta VValues area, click the
"Show delta X" checkbox to show the
time difference between markers M1

0.015 0.013 0.033 H
10
e [° 2

(< Show ¥ value
[ show ¥ value of

wove: (0T

[J Show marker name

. [ Show delta H
O shaw geita ¥
[ stoss detta ¥ delia 8

(4 Show ¥ value
[ Sshow ¥ value of

wove (1]

[ Show marker name

[ Help... ] [ Cancel ]

and M2.
Click OK to exit the Display Labels dialog.
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DIGITIZING TASKS
We will now create a digitizer-based-task to collect and signal average datafrom a single analog input

channel.

[0 Select Task » New Digitizer
from the Task menu, and when DIME)(v][w)  Task:
the Task Editor opens, rename Task Begin [
%hi fh task r:tAchi re", aspictured sear gL:::t Bff;: ;jg Scans?
o the rignt. Digitize Segment (4100 pts/scan, le+15 pts/sec)
Plot Segment
Take amoment to survey the Task Cleor € Update
Editor. It isdivided into two main Scan Loop End
areas, the Task Region and the
Instruction Dictionary. -
The Task Region, at thetop, shows || [ Analysis ————————— . -
the actual contents of the task. Curce Fitting. Nome: [Rcquire |
When atask is Run, instructions in Bilen Bralusis o) (Bssist
this area are executed, oneline at a gg;ﬁ;}gfﬂics [Hen... | (Rseist.. )
time. The user can easily add, Sunthesize (options...] [ Debug... ] [ Cancel |

delete, view, Cut, Copy, and Paste
instructions. The five bolded instructions form the skeleton of a digitizer-based-task.

The Instruction Dictionary, at the bottom of the Task Editor, contains alist of all available Instructions.
These are the building blocks that are used to create tasks. The instructions are divided into several
categories (e.g. Analysis, Data Transfer) and are explained in detail in Chapter 6 of the SoundScope &
SuperScope || Reference Manual.

The indentation after the Scan Loop Begin instruction tells us that the indented instructions will to be
executed repeatedly. The Scan Loop Begin instruction determines how many times they are executed.
Thisloop count, which is currently set to 2, is easily modified by double-clicking on the Scan Loop Begin
instruction. Currently, thistask is setup to execute instructions in the following sequence: Task Begin,
Scan Loop Begin, Digitize Scan, Scan Loop Begin, Scan Loop Begin, Digitize Segment, and Scan L oop
End. Thisisillustrated in the following figure:

Scan#l time=0 Scan#2 time=0 )
: : > Time
- |
5 g g, 5 g o

12 i [ o~ |
| 5: Controler Digitizes Trace #1 12 ! g 1 Controler Digitizes Trace #2 : = ‘% |
e U e U e - Y aWalk !
T s S g C |
& s B 8 S8
.‘8 2 ©, % 7 % |
l«<——— Scan Loop #1 >l< ScanLoop #2 ———>!

The Task Begin instruction is always the first instruction and is used to initialize several internal variables
-- you can ignoreit. The Digitize Segment instruction digitizes per its settings (pts/scan, sample rate, strip
chart/oscilloscope) and the Scan Loop End instruction tells the task to jump back to the Scan Loop Begin
instruction. Digitize Segment grabs asmall (e.g. .1sec) chunk of digitized datafrom the instruNet
channels that have been linked to SuperScope Il waves. Instructions after Digitize Segment can be used
to process this data.

We will now modify thistask to digitize 10 scans instead to 2 and to calcul ate the point-wise average
scan.
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(0 Double-click on the Scan Loop Begin
instruction, and when the dialog opens, as
shown to the right, set the upper scan bound
to 10. Press OK to return to the Task
Editor.

[0 Drag the Calculate Wave instruction from
the Instruction Dictionary to the space
directly under the Segment Loop End
instruction. The instruction will appear as
a dotted line while being dragged.

Rel ease the mouse button when the
instruction isin position, asillustrated to
the right.

When the mouse button is released, the
Calculate Wave dialog will appear, as shown
totheright. Thisdialogis used to access
over 85 waveform and operators including
integration, Fourier analysis, derivatives, and
much more.

Scan Loop

Run from scan # ‘:] to scan # D
Coonee ) C )

OOEEDE s Chare ]
ifi

Task Begin
Scan Loop Begin (2 scans)
Segment Loop Begin
Digitize Segment (4100 pts/scan, le+15 pts/sec)
Plot Segment
Segment Loop End

Clear & Update
Scan Loop End \

Calculate Have
Curve Fitting
Filter

Pulse Analysis
Sound Statistics
Statistics
Synthesize

Name: |chuire

( Help... ) [mssist.. | oK

— A (]

5| (Options...] [ Debug... ] [ Revert

The Calculate Wave dialog contains severd
rows. Thefirstisused to copy the contents
of one wave into another. The second is
used to +/-/*/+ a constant with each point in
awaveform. Thethird isused to +/-/*/+ two
waveforms (e.g. W1 =W2 + W3) in point-
wise fashion. The forth isused to apply a
mathematical function to each waveform
point (e.g. W1 = deriv(W2)), and thefifthis
used for functions such as Fourier analysis
and waveform smoothing.

[0 Click on the various pop-ups to
familiarize yourself with how it works.

In sSummary, one Uses pop-up menus to

Calculate Wave

@ [_w ] =_w |
o[ | = [ wi ] (_+_][0.000000 |
o[_m | = w1 |+ ][ w |
O w | =[ Ssin |

Source: [ Wi ]

[J use Dvariables

(Help ) (view pata)(_ Do 1t _)( cancel )| oKk ]

form a sentence, which isimplemented

when the instruction is executed.
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© EI ] :::2232}:2?::; ..............................................
Q lEl = ggz:procal
S R —
o i ¢§?s;:,g|nug ..............................................
Source: :::‘ent
. Use the pop-ups to set up the sentence "SigAvg = SignalAvg (W1)", asillustrated to the

right. Thiswill cause the SigAvg wave to be loaded, when the task is run, with the point-wise average
of al analog input scans acquired since the task started execution.

O Click OK to close the Calculate Wave dialog and to install this new instruction into the task.
O Click the Assist button in the Task dialog and then click OK in the Assistant dialog and the
next dialog that appears. The Assistant will automatically create a button with the same name as the
Task, and place it on the front panel. When the newly created Acquire button is pressed it will run the
Acquire task.

NON-DIGITIZER-BASED TASKS
We will now create atask that calculates the frequency spectrum of the averaged wave (SigAvg),
displays the results, and logs the spectrum's peak value to ajournal.

[ Select Task » New from the Task menu to create a new non-digitizer-based task, and to open
the Task Editor. Non-digitizer-based tasks are similar to digitizer-based-tasks, except they do not
contain the bolded template instructions that form the skeleton digitization procedure.

OOAD@@  resk: Cnaigze |
]

Task Begin
FFT = MVFFT (SigAvg, 0.00000)>

2]

------------ Analysis —-—-—-——-—-————-
Calculate Wave

Curve Fitting

Filter

Pulse Analysis

Sound Statistics

Name: [Analyze |

(CHep.. ) (mssist... ) ok |

Sunthesize (options...] [ Debug... | [ Revert |
[ Rename this task "Analyze", and then drag the Calculate Wave instruction to the position

directly under Task Begin, and then let go, asillustrated to the right.

[ When the Calculate wave dialog appears, set up the sentence "FFT = MVFFT (SigAvg)" and
then press OK to install the instruction. The second parameter in this function is used to specify the
number of points for the FFT; O specifies as many points as available.
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(0 Scroll the Instruction Dictionary to find the Move
Marker instruction (under the Management heading).
Drag thisinstruction to the position directly under the

MVFFT instruction and let go. The Move Marker dialog

will appear, as shown to the right.

(0 Click on the various pop-ups to learn how this instruction

works. Again, one uses pop-up menusto form a
sentence.

Move Marker: E
Move to [ absolute time H | of wave [ FFT
-~0ptions
P Help
[ use variables [ 0K ]

We will now set up this instruction to move marker M3 to the 0.000 position (i.e. the left edge) of the

FFTDisp display.

0 Select M3 in the upper-most pop-up, select Absolute Time X in the left-most pop-up, select FFT in
the right-most pop-up, and then enter 0.0 in the X time field that appearsin the Options area. Click

OK to exit thisdialog and install the instruction.

0 Add another Move Marker instruction directly below the one we just created, and set it up to move
marker M3 to the Next Maximum of wave FFT. Click OK to exit and install.

We will now set up an instruction to transfer the value of the FFT wave, at the marker M3 position, to

journal J1.

0 Scroll the Instruction Dictionary to the Data Transfer section, and then drag the Log Marker Values
instruction to the position below the last Move Marker instruction.

When you release the mouse button,

the Log Marker Values dialog will Marker [_M3 | and Wave [_FFT Intersection

appear, as shown to the right.

Transfer... value to...

0 Select M3inthe Marker pop-up point# i Owave: [ W1 | (8ntians... ] @
and then select FFT in the wave time O] variable:[ _error | (Botivas...] (V]
POp-up Mmenu. daytime =

set value X Journal: [ J1 | [Opllons...]

O Click onthe Vauelinein the OIstring: [_retalue | (Bptions...) (5]
Transfer list, and then select the . ;

J A . [JControl: | Acquire (
Journal checkbox. Thiswill \:n :) r
cause the FFT value, at the M3 g | DMerker L ime
position, to be transferred to the
journal J1. ((poit | [ clear ) [ cancel |

The Transfer Areaisvery powerful

since it can transfer the values of multiple parameters to any combination of objects, in any combination.
For example you could transfer the Point# parameter to wave W1 and to marker M1; and then transfer the
Vaue parameter to journal J2. This general purpose transfer environment exists in a number of

instructions.

0 Click OK to exit and install the Log

Marker Values instruction and to return to @@@ Task:

the Task Editor.

O If your task does not appear as pictured to

Task Begin
FFT = MVFFT (SigAvg, 0.00000)
Move marker M3 to the 0.00000 position

j[he rlght, pleasecorrect it. Reca” that Move marker M3 to next maximum of wave FFT
instructions can be Cut, Copied, Pasted; Marker M3 & wave FFT intersection (value to J1)
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and their dialog's can be opened by double-clicking.

[0 Click the Assist button. Click OK in both dialogs that appear. Thiswill automatically create a button
named Analyze that will run the Analyze task when clicked. Y our front panel should look like the
figure below, although at this time the displays and journals will be empty.

Simple ioNet Instrument

RUNNING THE

INSTRUMENT e : molze -

[0 Select Run? Acquire from the \/\/\N\/\/\/\/\/\/\/\/\/\/W\/'° o

Task menu and watch the — e e M N N M e Y e ]

instrument simulate asingle OS]0 50 meec/iv °

channel oscilloscope, with a I~

/D

O Select Run?® Analyze from the [ O]

Task menu to calculate the o [

frequency spectrum and send the ? 2

peak spectral energy to journal J,L O R e e e
\]1 D 27.8 55.6 283.4 111.2 166.8 222.4 278.0 333.6 389.2 444 .8 Hz

J1 J2

FFT
value

[0 Click onceinthe J2 journad, to volt [

select it, and then type "The
End". Y our screen should appear
as shown above.

SAVING THE INSTRUMENT
Save your new instrument to disk for later use.

[0 Select Save Asfrom the File menu, type "my instrument” into the file dialog, and then click the Save
button. For your reference their exists a completed version of thisinstrument, named Simple iNet
Instrument, in the "instruNet Instruments” folder.

Y ou may want to practice working with this instrument -- feel free to make additional changes. Also, feel
free to copy and modify the instruments included with SuperScope 11, or swap instruments with friends
and colleagues. If you create a special-purpose instrument, please consider sending it to us so we can
shareit with others.

Congratulations! 'Y ou have completed the tour and are well on your way to becoming a SuperScope ||
expert.

WHERE TO GO FOR M ORE INFORMATION
Chapter 4 provides atour of the more advanced topics, Chapter 5 covers the building blocks used in
instrument design, and Chapter 6 describes two of the instruments that are included with SuperScope I1.
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Chapter 4
Tutorial: Advanced Techniques

One dilemma encountered in designing software involves the tradeoff between the number-of-features
and the ease-of -use. Products with few features tend to be easy to learn and use, and those packed with
features tend to be more challenging. In some cases, simple applications will not satisfy a user's
reguirements, forcing them toward complex applications that require steep, time consuming, learning
curves. We have worked very hard to make SuperScope |1 both featureful, and easy-to-use. Simple
instruments can be set up in aminimal amount of time, and complex instruments can be designed without
knowledge of a conventional programming language.

SuperScope Il alows customersto tailor their instruments to their own needs. It's powerful design
environment includes a menubar editor (for designing custom menu bars), a dialog-driven command
language, and a powerful set of database export tools. The Menubar Editor enables an instrument
designer to create a menubar, and assign tasks to each menu item. The menubar may contain any number
of menus and commands; subsequently making it possible to create a very simple instrument, with only a
few menu commands.

This chapter provides atour of an instrument, named Adv Tutorial .iNet, that digitizes two signals,
analyzes the acquired data, and sends the resultsto a FileMaker database. Adv Tutorial.iNet coversthe
main features of SuperScope |1 including menu editing, acquisition, decision making, data export,
analysis, continuous recording, and debugging.

O If SuperScope Il is aready open, please choose Quit under File.

(0 Findthe Adv Tutorial.iNet instrument, select it, and choose duplicate under the File menu. Thiswill
cause the file to be duplicated and renamed to "Adv Tutorial.iNet copy"”. It isgood to work with a
copy of an instrument when doing design; so you can return to the starting point, if desired. Also, as
you are designing, it is always good to save your instrument every now and then with a different file
name (e.g. fredl, fred2, fred3, etc), to keep a running log of you work.
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[ Double-click on Adv =——— Adv Tutorial.ioNet ———| 9 Gwl |
Tutorial .iNet copy; or launch start Y Noise FFT Filter Pulse
?)%%ﬁﬁ?ﬁ%? llzllig?(()j ltgz%‘%]eoose Log Calc stats Clear Help Print

N
instrument. The Adv IS P
Tutorial .iNet instrument will vort |
appear, as shown to the right. p 630760 msee 5}
This instrument contains a suite ] 8]0 neee/viv_ |8 -
of buttons, three journals, three .
displays and a custom menubar. vore 198
20 130 muolt ]
Select Choose Menubar » Full S0 10 wve1 t/0iv |G
under Edit to turn off the custom -
menubar, named "MyMenu", and Vol t u‘g
enable the default Full menubar (it h S0 100 150 200 250 300 350 400 450 SO0 S50 600 650 700 Hz " %
may already be selected). L ]850 Hz/Div o] |
Notes Resul ts User
Select Panel Edit On from the
Display menu to view the front
panel objects, as shown to the
right.
Select Panel Edit Off from the
Display menu when done with
your review. Controls
AN N\
| Adv Tutorial ioNet =—— N\ [22 ewi |
Start HY Noise FFT Filter Pulse
Log Calc Stats Clear Help Print
01
Displays (D1, D2, D3)
\\ \\
|
02 \ \
\ o
D3 AN
||
Notes Results User
Journal Notes Journal Results Journal User
||
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SUPERSCOPE |l OBJECTS

SuperScope Il instruments are comprised of objects that are created by the user, and assembled like
building blocks, to form an instrument. Waves, segments, variables, strings, journals, datapipes, and
markers are used to hold data. Displays and journals are used to display data; and tasks are used to

acquire, analyze, present and move data. For details on objects, please refer to Chapter 5 of this Manual.

The Adv Tutorial contains many objects, illustrated below:

Displays Markers Channels
D1 v M1 AinO
D2 M2 Ain1l
D3 M3
Journals String Waves
EHPORT retlalue wi
Notes message w2
Results PeakFFT FFT
Sinlal Area Noise
TEMP comma Selected
User Sinl Segl
Variables Controls Tasks
v error Start
ST [.3]2 FFT
UDP . Filter
1Y i HY
s g = -+
area Clear
Aug Pulse
StdDev Log
m”_“ Stats
i HCMDr
Noise
Menubars Segments Datapipes
v Full Segl Data
Short
MyMenu
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FRONT PANEL CONTROLS
SuperScope Il offers acomplete line of controls and indicators; including lights, buttons, switches,
dliders, dias, meters, numeric fields, static text, and lists. Adv Tutorial uses buttons to start tasks.

‘m- FILE
SN I/D
Dout0
Lights Buttons Switches
indicate the state of a Boolean |[ often initiate the execution of || specify atrue/false Boolean
true/false value. atask. condition.
18"
5 -
Velume
. _ Offset 1 Current C
Sliders Dials Meters
control a scalar quantity. control a continuous or indicate a scalar quantity.
quantitized scalar quantity.

4.88 : Channel 0O

Numeric Fields
control ascalar quantity or a
text string.

Duration = 12.52

Static Text
shows a scalar quantity or a
text string.
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O Select Options? Clear under Controls
to open the Control Options dialog,

Control:| Clear |

pictured to the right. _Object
Thisdialog is used to specify the style, \EUTH[Clear |
attributes and behavior of controls and
indicators. The Type and Style pop-ups Type: Style:
determine if the object is a switch, button, value:[0.000000
dial, knob, etc. The Name field Blue:| |
determines the object's name, and is used Jon | _mouseup  |run|_ Start |
by tasksto reference the object's value.
For example, atask could be setup to -Options
beep if switch "Fred" was set to the On . g g g
position. In the Boolean world, Falseis Main:[v] Label: v Readout:v| Ruler:v]
represented by 0.000; and Trueis ) o
represented by all other values, with This area is still in development (be careful)
1.000 being the most common True
value. Therefore, atask could read the

value of Fred, and beep if Fred'svalue

was hot zero. Other itemsin the Control Options dialog specify the range for adial or dlider, the label
shown next to the object, and the task that is executed when the control is moved with the mouse.

Controls are positioned and resized in Panel Edit Mode
just like displays and journals. Attributes of elements
within objects are adjusted by Option clicking on the
element (hold down both the and Option keysand
then mouse down). This causes a floating menu to
appear, illustrated to the right, that lists the various
adjustable attributes; such as Data Range, Precision,
and Text Format. For example, one could set alabel's
font by Option clicking on that label, and then
choosing Text Format from the floating menu.

[0 Press OK to exit the Control Options dialog.

Temp:

0.12 1=
) Hide Label
Data Range...
Precision...

Text Format...
Show Border
Options...
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THE MENUBAR EDITOR

SuperScope || contains a powerful menubar editing Choose Menubar  p MZaTI
environment for creating custom menubars. The user

can create as many menubars as he/she desires, and Short

can quickly move from one to the other with the MyMenu

Choose Menubar command under Edit, illustrated
above. With the Menubar Editor, one can edit an existing menubar, create new menubars, and attach
tasks to menu items.

Attaching tasks to menu itemsis a powerful feature, sinceit
enables the End User to add functionality to menu commands,
which ultimately enables one to design their own menu
driven application program!

Editing a menubar entails hiding entire menus (e.g. File, Menus
Edit, Wave), hiding menu items (e.g. Cut, Save, New), / ‘L
adding menus, and adding items to menus. For example,
one could create a very simple menubar with severa ® File Edit "
commands to acquire, analyze and save data; as { A - %
illustrated to the right. | CQUITE 1<« o
Analyze | < <
[0 Select Edit Menubar » MyMenu under Edit to open save <« 5
the Menubar Editor, pictured to the right. | S
|
The Menubar Editor contains two editing areas. The top Menubar
areais used to add, hide, and rename menus; whereas the
bottom areais used to add, hide, rename and link-to-
task menu items. Each SuperScope Il instrument Custom Menubar:[_MyMenu |
contains several menubars, one of which is specified in .
the upper-most pop-up menu of the Menubar Editor. Name'
Each menubar can be renamed or deleted viathe ~Menu:|_File |
upper-most Delete button (except the default Full and @ Show default text "File"
Short menubars). To create a new menubar, one O Show custom text: [File |

chooses New Menubar in the upper-most pop-up.
Menus and menu items are easily renamed by selecting
"Show custom text:" and then typing anew namein ~1tem:[ New Instrument... |
the adjacent field.

) Show default text "New Instrument..."
O show custom text: [New Instrument... |

) Hide menu

O Notice that the "New Instrument” item, in the

lower area, under File, has been hidden with the ©Mide item .

Hide Item radio. Click on the Item pop-up menu i L
and select Save. The Save item has not been

hidden. Look at the other itemsin the Item pop-up

and note that most are hidden.

[0 Click on the Menu pop-up and select Edit. Notice that the Edit menu is not hidden, yet most of it's
itemsare. All of the other menus have been hidden except for the Task menu.

[0 Select Task from the Menu pop-up. Notice that this menu has been renamed to "MyMenu". Menus
and menu items are easily renamed by selecting " Show custom text:" and then typing a new namein
the adjacent field.
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0 Play with the Item pop-up menu. Notice that the standard Task items have been hidden, and that two

"User Items" have been added.

0 Select User Item 1. Thismenu item has been renamed "Acquire” and has been set up to run task

"Start" when chosen.

(0 Click onthe Run Task pop-up to see the list of available tasks. Any User Item can be set up to run

any task.

0 Select User Item 2 in the Item pop-up. This menu item has been renamed "Analyze" and has been set

up to run task "Calc" when chosen.

O Click OK to exit the Menubar Editor.

[0 Observe the custom menubar, and when done, Choose Menubar » Full under Edit to enable the Full

menubar.

STRIP CHART RECORDER

The Adv Tutorial.iNet digitizes and analyzes several signals simultaneously. It can be run with either the
demo version of SuperScope Il in which case it will ssmulate 2 input channels or with the real version of
SuperScope || connected to instruNet hardware in which case it will record directly from the first 2 analog

input channels.

0 Click once on the Start button in the upper-
left corner of the instrument. Thiswill cause
the "Start" task to run, which in turn executes
severa instructions that implement atwo
channel real time strip chart recorder
(smulated if you are using the Demo
digitizer).

O Select Edit?» Start under Task to view the
task. Itissimilar to the digitizer-based-task
reviewed in Chapter 2, yet contains six
additional instructions; three are used to
clear displays and three are used to set
markers to the 0.000 position.

The Adv Tutorial has three displays and three
markers. The bottom display, named D1,
contains two markers (M1 & M2) and the top-
right display, named D2, contains one marker
(M3).

O Click OK to exit the Task Editor.

N N P g N N

0 194 380 583 778 972 1167 1361 1555 1750 1944 2133 2333 2528 2722 2916 msec

Task Begin
Move marker M1 to the 0.00000 position
Move marker M2 to the 0.00000 position
Move marker M3 to the 0.00000 position
Clear Display D1
Clear Display D2
Clear Display D3
Scan Loop Begin (2 scans)
Segment Loop Begin
Digitize Segment (10000 pts/scan,
Plot Segment
Segment Loop End
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XY ANALYSIS

[0 Click onthe XY button to plot the cosine of
W1 against the average-to-date of W2. This
button causes the XY task to run, which
calculates:

0 90 mVolt 4
-] 1o mueitoiv 3

W3 = Cos(W1)
W4 = AvgToDate(\W?2)

Display D2 plots the pointsin wave W3 against those in W4, in XY fashion; and is updated automatically
when the task is finished executing.

O Toview the XY task, select Edit » XY from the Task menu. Thistask
uses two Calculate Wave instructions to do the wave mathematics.
Press OK when done with your review.

Task Begin
W3 = Cos (H1)
W4 AvgToDate (W2)

SPECTRUM ANALYSIS
[0 Click on the FFT button to calcul ate the frequency spectrum
of W1. This button causes the FFT task to run, which 10

calculates: Volt it
FFT = MVFFT(W1, 1024) i

/D

Display D3 plots the pointsin wave FFT; and is updated , o ol

automatically when the FFT task is finished executing. D 20 40 60 Hz
Frequency in Hertz is represented along the horizontal axis, while ] 23] 20 Hz/Di {13
frequency magnitude is shown on the vertical axis. Notice that
W1lisa5V amplitude (10V peak-to-peak) sine wave with afrequency of approximately 20Hz (this may
vary, depending on your setup), and the spectrum analysis shows one point at { 20Hz, 5V}. To show dB
along the vertical axis, one would substitute Spectrum() for MVFFT(). For details, please see the
Spectrum Analyzer example at the beginning of Chapter 7 in the SoundScope & SuperScope |l Reference
Manual.

O Toview the FFT task, select Edit » FFT from the Task menu. Task Begin
Thistask uses one Calculate Wave instruction to calculate the FFT = MYFFT <M1, 1024.00)
frequency spectrum.

[0 Double-click on the FFT = MVFFT (W1, =
1024) instruction to view the Calculate ® |_FFIT sl lidl
Wave sentence. When the result wave "FFT" is plotted, we see the frequency amplitude between OHz
and half the sample rate (166Hz sample rate + 2 = 83Hz = Nyquist frequency). The frequency
resolution (i.e. # of Hz between each frequency point) isthe Nyquist frequency divided by half the
number of FFT points (83Hz + (1024 + 2) = .16H2).

[0 Press Cancel to exit the Calculate Wave instruction, and then press OK to exit the Task Editor.

W AVEFORM STATISTICS
[0 Click on the Stats button to automatically calculate the average value, maximum value, standard
deviation, and rms of W1. When the file dialog appears, press Save to save the results to disk.
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[0 To view the Stats task, select Edit » Stats from the

Task menu.

Double-click on the Statistics instruction to view it's
dialog. Thisinstruction calculates statisticson a
wave, channel, segment, or selected region. Severa
statistical parameters are supported, each of which
can be sent to awave, variable, journal, string,
control or marker; in any combination. Recall that a
marker's value is derived from it's position; a
control's value is derived from it's setting; a string or
journal's value is derived from it's text (zero is
assumed if the text does not contain a number); and a
wave's scalar value is derived from one point, as
specified in the Wave Transfer Options dialog,
discussed later.

Task Begin
Statistics on W1 {qug to Results; max

Choose Save As... Results Under Journc

Transfer...

min
+ man
H# at min
H at max
area
v std dev
<rms

Statistics on:‘E'
avg to...
it
0 wave: FFT

O string:
] controt

O Marker: Mi T

In this case, four parameters are calculated and their results are sent to
journal Results, in tabular fashion, as pictured to the right.

(0 Click on the Journal Options button to open the Journal Transfer

Options dialog box. This dialog determines the precision of the

transferred data, as described below.

Precision Digits after Example
Low 1 1.1
Medium 3 1.093
High 7 1.0927861

[0 Click OK to exit the Journal Transfer Options dialog.

=
Resul ts
HA WA WA
avg max std dev
Volt Volt Volt
0.060 S.000 S.000

Journal Transfer Options

Precision: O High

Increasing journal tab spacing
can increase precision.

{® Medium
) Low

[ cancet J|[ ok ]|

[0 Click onthe various Transfer parameters (e.g. avg, min, max, X
at min, X at max) and view the various transfers that have been enabled (e.g. avg to journal Resullts,
max to journal Results).

Tutorial: Advanced Techniques



Super Scope |1 User's Manual

[0 Click on the Wave checkbox to enable
the transfer of a statistic to awave, and
then click on the Wave Options button
to open the Wave Transfer Options
dialog, pictured to the right.

Transferring a scalar (i.e. one number) to a
wave is alittle tricky since one must
specify the waveform point that isto
receive the scalar. Thisisaccomplished
with the Wave Transfer Options dialog.
Thefirst value transferred in atask is either
sent to a specific point number (where point
#1 isthefirst point), or to the end of the
wave. Each subsequent transfer (in a
running task) is either done to the Next

Wave Transfer Options

1st Transfer: ® Point #

) Append to last point of wave
Next Transfer: @ Next location (O Same location

If hit wave end: @ Transfer to point #1
(O Stop transfers yet don't stop task
() Stop task and show alert
{0 Try to enlarge wave

Upon new trace: @ Continue (O Transfer to point #1

Wave size: 200 points minimum

Point Location, or to the Same Location. If the wave's last storage location is exceeded: the value is
transferred to point #1, the transfer does not occur, the task is stopped, or the wave is enlarged and the
valueistransferred normally. When a new scan is acquired in a digitizer-based-task, transfers occur
normally, or they can reset to point #1. At the beginning of atask, all waves are resized, as requested by
the Wave Size field. Wave enlarging occasionally fails due to memory limitations; in which case, an alert

is shown.

0 Click Cancdl twice to return to the Task Editor.

[0 Double-click on the Choose Save As
instruction to open the Choose Menu
dialog.

Choose Menu is used to simulate the
selection of a menubar command, or a key
press (e.g. choose Print under File, press
Option '€, etc). Inthis example, Save As?
Results under Journal is chosen,
automatically, when thisinstruction is
executed. Subsequently, the standard Save
As dialog appears and the journal is saved
to disk, as atext file, when the user presses
the Save button. Thisis very powerful since

Choose Menu

® Menu:

Command: | Save fs...
O Key press: ID

) % Key: [:I
) Open instruction number[:] in task

|[ Results |

[J Automatically press encountered OK buttons

[ Hetp.. ][ Doit ][ cancet || ok ||

isbrings al menubar and keyboard commands within the scope of task instructions.

[0 Click Cancel to exit the Choose Menu dialog and then click OK to exit the Task Editor.

[0 Choose Clear » Results under Journal to delete the data.

SCALARS, STRINGS, SEGMENTS & PROGRAMMING

[0 Click on the Calc button to analyze several waves and
send the results to the Results journal. If an alert

appears, press OK.

Resul ts

Max FFT wvalue = 4.99995a0
Area = 0.7839148
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O Toview the Calc task, select Edit
» Calc from the Task menu.

Thistask is listed on the following
page with comments and line
numbers. A textural description of a
task can be copied to the clipboard by
choosing Copy Task under the Edit
menu. Alternatively, one can copy a
complete textural description of the
instrument by pressing Shift Option
'‘A'. To view or print the description,
one can paste the text into aword

Task Begin

Mouve MZ to absolute time X of FFT

Mouve M2 to next maximum of FFT

Marker M2 & waue FFT intersection <

Insert "Max FFT valus = into jour

I (String PeakFFT > 4 _.5S002> then
Append text onto the end of Resu

Jump to Yout”®

I f =nd
Insert "Low” into journal Resul ts
Beep
Beep

processor or into ajournal. For a

quick view, one can choose Show ? Clipboard under Edit, and then resize the clipboard window as

needed. If ajournal by the name of "read
name is the standard repository for user d

" exists, it'stext isincluded in the description. A journal by this
ocumentation of an instrument If the user presses Option 'a

(i.e. lower case 'a), amore brief textural description is sent to the clipboard. The brief version does not
include the ReadMe or the Menubar description. These documents look best when printed with a small
fixed character width font such as Courier 9. Task text isnot afunctional description of atask, since
many settings are not included; it is only used as areference.

01
02
03

Task Begin
Move M3 to next maximum of FFT

Insert "Max FFT value =" intojrnl
If (String PeakFFT > 4.500) then ...

Move M3 to absolute time X of FFT

move marker M3 to OHz
move marker M3 to the frequency peak

Marker M3 & wave FFT (valueto PeakFFT) copy peak amplitude into string PeakFFT

Results  insert text into journal Results

if amplitude value is greater than 4.5 then ...

07  Append text onto the end of Results with data from string PeakFFT

08  Jumpto "out" jump to the "out" label (6 lines below)

09 Ifend end of theif (>4.5) case

10 Insert "Low" into journal Results insert text into journal Results

11 Beep make a beep sound

12 Beep make a beep sound

13 Show Alert: "Max FFT Low!" show alert to say that frequency peak is <4.5V
14 out: target for a Jump instruction

15 Insert "\r" into journal Results insert a carriage return into journal Results
16 Move M1 to absolutetime X of W1 move marker M1 to 0 seconds

17 Move M2 to absolute time X of W1 move marker M2 to 0 seconds

18 Move M2 to next peak of W1 move marker M2 to the 1st peak in W1

19 Move M2 to next peak of W1 move marker M2 to the 2nd peak in W1

20 Move M2 to next value of W1 move M2 to the next place where W1 crosses -1
21 Move M1to next valley of W1 move marker M1 to the 1st valley in W1

22 Move M1 to next value of W1 move M1 to the next place where W1crosses -1
23 Pulse analysis Segl (area2 to area, Area) send area of segment Segl to variable & string Area
24 Insert"Area="into journa Results insert text into journal Results

25 If (String Area> 0.1000) then ... if area valueis greater than .1 then ...

26  Append text onto the end of Results with data from string Area

27  Jump to "out2" jump to the "out2" label (6 lines below)

28 Ifend end of theif (>0.1) case

29 Insert"Low" into journa Results insert text into journal Results

30 Beep make a beep sound

31 Beep make a beep sound

32 Show Alert: "ArealLow !" show alert to say that area value is <0.1
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33 outz: target for a Jump Instruction
34 Insert "\r" into journal Results insert a carriage return into journal Results

The first 4 instructions locate the maximum frequency amplitude value and transfer it to string
"PeakFFT".

0 Pressthe(s] button (Task Editor
upper-left) and then choose String: | PeakFFT |
PeakFFT in the upper pop-up
menu. 4.9999590

[©

Strings are used to hold a series of
characters of any length, memory
permitting (e.g. "hi", "1.2"). They are
easily created, renamed, and deleted,;
and their text is easily viewed and ||
edited in the String dialog. Many task it
instructions transfer text to and from PArAMELOrS —mmns

strings. Name: [PeakFFT__|
The PeakFFT string currently contains Units: (“Delete ) [ Revert )

"4.999", as shown in the text editor.
Thisareaisvery powerful sinceit
supports the standard Cut, Copy, Paste, and user typing -- just like ajournal or text editor window!

[0 PressOK to exit the String dialog.

TheC, J, M, S, V and W buttons are used to view and modify controls,
journals, markers, strings, variables, and waves; during, before, or after @ @ @
running atask. Thisishelpful when a"problem"” is encountered. These buttons create a new object if one

does not already exist; otherwise, they open the dialog for the first item in the corresponding object list.
Several instructions, such as Statistics, contain these buttons, for your convenience.

[0 Pressthe W button, at the upper-left, to open the Wave Options dialog. From here, one can view a
wave's values with the Edit button, or the number of points with the Points button, for example. To
view another wave, simply select it in the upper pop-up menu. Press OK to exit the Wave Options
dialog.
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O Double-click on instruction #5,

Thisinstruction is used to clear, insert
text, append, copy, and search-replace
text within ajournal or string. It isvery
powerful and often used to prepare text
before being transferred (i.e. "inserted")
into ajournal. Inthiscase, we are
inserting the text "Max FFT value =" into
journal Results. The insertion occurs at
the location of the insertion point, which
istypically at the end of the journal or
string.

Scalars are either sent to journalsin a
tabular or a scrolling text fashion,

"Insert Max ...", to open the Journals
& Strings dialog.

Journal or String: _

() Clear i O Insert wave definitions
(O Clear at beginning of task (O Insert today's date

(O Copy to clipboard (O Insert today's time

(O Copy into: ) Insert trace number

) Append onto: : i O Update all journals

() Remove row number ‘E (top row is #1)

) Remove column number EI (first column is #1)
(> Change |\t |t0 |, |
@ Insert: (Max FFT value =

([ Hetp ][ Doit | [ cancel | [ ok ]

illustrated below. Tables are constructed by transferring scalars directly to journals (e.g. the Statistics
instruction's transfer-to-journal area). Scrolling text is produced by first transferring a scalar to a string,
and then inserting it viathe Journals & Strings instruction. Thistypically requires three instructions:
insert label into journal, insert value into journal, and insert carriage return (\r) into journal. The Calc task
uses the latter technique with both the maximum frequency amplitude value, and the area value, as
illustrated below.

If.
If..

Resul ts
W1 W1 W1
avg max std dev
Uolt Uolt Uolt
0.060 S.000 S.000

Tabular Format

Max FFT value = 4.99993590
Area = 0.7839148

Scrolling Text

Press the Cancel button to exit the Journals & Strings dialog.

Double-click on instruction #6, "If
(string peak..", to open the If...Then
dialog box, pictured to the right.

..Then in SuperScope Il issimilar to
.Then in any conventional programming

language such as'C' or BASIC. A
conditional statement is evaluated, and if
True, the body of the If...Then is executed;
otherwiseitisnot. Inour case, instructions
#7 and #8 are executed if the PeakFFT
string contains a number in excess of 4.5.

Selectinsirudtion If-Then

String PeakFFT> 4.500

Edit Conditional...

(o) C)
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[0 Pressthe Edit Conditiona button to
open the conditional dialog, shown to
the right.

Play with the pop-up menus to see how
this dialog compares the value in two
objects. Recall that amarker'svalueis
derived from it's position; a control's
value is derived from it's setting; a string
or journal's value is derived from it's
text (zero isassumed if the text does not
contain a number); and awave's scalar
value is derived from one point, as

Scalar Conditional

| String |

| PeakfFFT |
Gutians...
4.99996 Volts

Value |

I
|4.500 |

Gutians...
4.50000

[ Help... ][

Do it

] [ cancel |

specified by the Wave Transfers Options dialog, discussed earlier. For your convenience, the current
value of each object is shown at the base of the dialog. Again, thisis as easy as forming a sentence!

Cancel again to exit the If...Then dialog.

Scroll to the bottom of the Instruction
Dictionary and then double-click on
the Arithmetic instruction, illustrated
to theright.

Play with the pop-up menus to see how
this dialog arithmetically combines the
scalar value in two objects, and then
transfersit to athird. Again, the
current value of each object is shown
at the base of the dialog, and it's as

When done with your review, press Cancel to exit the Scalar Conditional dialog, and then press

Scalar Arithmetic
[Variable ] . [Dalwe )
error ~— |0.00000000 |
|
1.00000 Volts 0.00000 1.63552 |
( Help.. ][ Doit | [ cancet ]| ok |

easy asforming a sentence. The conditionals (e.g. <, >, <= less then or equal to, >= greater then or
equal to, == equal to, !=not equal to) return 1.000 if the expression is True, and 0.000 if the
expressionisFalse. "AND" & "OR" are bitwise operators.

Select instruNet in the upper right

popup and then press the lower . ioNet Field
Options button to open the instruNet . Network Device Module Channel
Field dialog. Thisdialogis used to [ #1sioud |[_1#100 | 1%100 ]| _chivine |
saelect an instruNet field for readi ng Settings Field Current Dalue: E
or writing. In fact, it allows one to [_General | [ balue Input ;| 0.396343
access al fieldsin the instruNet
Network page, where each cell of the (cancer J[__ox
network spreadsheet corresponds to
oneinstruNet field. Press cancel to Ve Y yoiue Input
exit theinstruNet Field dialog and Constants User Name
cancel again to exit the Scalar lllisnlau - Zohif:‘l:;ﬁate
H H H owpass riter
Arithmetic dialog. Highposs Filter
Bandpass Filter
Bandstop Filter
File
Driver Ram Buffer
User Ram Buffer
4- 14 Tutorial: Advanced Techniques



Super Scope |1 User's Manual

(0 Double-click on the Assignment
instruction, illustrated to the Scalar Assignment
right. Play with the pop-up

menus to see how this dialog [ Dariable | Dalue |
transfers a scalar value from one -
object into another object. Press [ error | ¥ |o.000

Cancel when done with your

review. Bp2UBAS...

1.00000 Volts 0.00000

[0 Double-click on the
Transcendental instruction,
illustrated to theright. Play with || [ Help... ][ Doit ][ cancel |
the pop-up menus to see how
thisdialog calculates a
transcendental function (e.g. sin,
cos, abs, In) on one object, and Scalar Transcendental
then transfers the scalar result

into another object. Press (Dariabi ! i |
Cancel when done with your ariable P alue
review. [ error | ~ -m 0.000
Gutians...
O Double-click on the 1.00000 Volts 0.00000

Programming instruction in the
Instruction Dictionary.

[ Help.. ][ Doit ][ cancel ]

Programming supports common
programming features such as:

If...Then, Goto, While Loop,
Loop N Times, Define ) .
Subroti ne, Jump to Select mstructmn.
Subroutine, Execute another Add Subroutine ki
task, Insert Comment, and Jump to Subroutine
Insert Label (used as atarget 3:;;““9'
for Goto). Add Comment
Add Subroutine creates a gz Ezz:g ﬁ Lf:ﬁ‘::
subroutine, which is an Loo Y
independent program hen
sequences that is executed While Loo ol
with aJump To Subroutine P
command, described below.
Upon completion of a Bk
subroutine, program flow
returns back to where the
subroutine was originally
called.
Subroutine "mySub" begins here:
Jubmp To Subroutineisused to jump to the designated Subroutine return
subroutine.

Jump to subroutine "mySub”
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Add Label isused to insert a program label, for purposes of documentation, and to | Lobsl:
provide atarget for the Jump instruction. Labels are suffixed with a colon (e.g. "Jump e
Here:").

Jump is used to divert program flow to a program label (which is set up with |Jump to "myLabel "
Add Label).
Add Comment inserts acomment, for documentation purposes. [® Hi, my name is spoonman.

L oop isused to implement an unconditional loop. The body (i.e. one or more Task Begin
instructions between Loop N times and Loop end, that are added by the user) is Loop 5 times
executed several times, as specified in the Programming Instruction dialog. Body W1 = W2 + W3
instructions are indented 4 characters.

Loop end
If-Then conditionally executes several instructions. The Task Begin
body (i.e. one or more instructions between If...then and If If ¢Mave W1 > Mave U2) then ...
end, that are added by the user) is executed if the conditional, W1 = W2 + W3

which is defined in the Programming Instruction dialog, is

True. Body instructions are indented 4 characters. LE

Whileisused toimplement aconditiona loop. Thebody [rask Begin

(i.e. one or more instructions between While...do and While  [rite ¢laue M1 > MHave U2) do . ..
end, that are added by the user) is executed repeatedly, W1 = W2 + W3

while the conditional (which is defined in the Programming While end

Instruction dialog) is True. Body instructions are indented
4 characters.

[0 Presson the various instructions to see how this dialog creates common programming constructs.
Press Cancel when done with your review.

The Programming instruction is used widely in the Calc task.

05 Insert "Max FFT value="Into jrnl Results  Insert text into journal Results

06 If (String PeakFFT > 4.500) then ... if amplitude value is greater than 4.5 then ...
07  Append text onto the end of Results with data from string PeakFFT

08  Jumpto "out" jump to the "out" label (6 lines down)

09 Ifend end of theif (>4.5) case

10 Insert"Low" intojourna Results insert text into journal Results

11 Beep make a beep sound

12 Beep make a beep sound

13 Show Alert: "Max FFT Low!" show alert to say that frequency peak is <4.5V
14 out: thislabel isatarget for a Jump instruction

Instructions #7 and #8 are executed if the frequency amplitude is greater than 4.5; otherwise, #10, #11,
#12, and #13 are executed. The former causes the maximum frequency amplitude to be transferred to the
journal; whereas the latter resultsin "Max FFT value = Low" being transferred to the journal and an alert.
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[0 Double-click oninstruction
#13, "Show Alert...", to open
the Alert, Beep & Delay Alert, Beep & Delay
instruction, pictured to the (O Beep
right. () Stop task
Thisdialog is used to sound a (0 Break out of Trace Loop
beep, show amessage in an alert, (O Wait for mouse down
stop the task, wait until the mouse )
button is pressed, wait until the (O Wait for mouse up
mouse button is released, wait for () Wait for key [\r |press
a specific key press, freeze for a
specified duration, or synchronize (O Delay for|2.000 seconds
to a specified duration. Inthis
case, the instruction shows an {2 Synchonize to|1.000 second intervals
alert with the"Max FFT Low!"
message. @ Show Alert:|Max FFT Low!
0 Press Cancel when done with
your review. [ Hetp ][ DoIt ][ Ccancel |

[0 Double-click on the User
Prompt instruction in the User Prompt
Instruction Dictionary. Message

.. . i ?
This instruction shows a [Po you cook with gas?

custom alert with an optional
response field and an
optional Cancel button. The

alert message, default [] Response:

eporeied Leiiuion | e ook et i ep__
all specified in this dialog. CJLeft Button:[Nope |

00 Pressthe Do It button to Variable "error" is loaded with 1 if Right button is pressed; 2
invoke the custom alert. otherwise. String "retDalue"” is loaded with response text.
Press Yep to exit the

aert. [ Hetp ][ DoIt |

[0 Enablethe Response field
and Left button

checkboxes, and then press Do It again. An alert 0 K with qas?
will appear, as pictured to the right. # AAHEROE SREEARst

00 Press Nope to exit the aert, and then press Cancel to
exit the User Prompt dialog. [No, 1 cook electric. |

[0 Pressthe(s] button and then choose retVauein the ([ Nope || ver
upper pop-up menu. The string should be loaded
with the response, "No, | cook electric.”. Upon exiting the custom alert, string "retValue" isloaded
with the response text. Also, variable "error” isloaded with 1 if the Right button was pressed, and 2 if
the Left button was pressed. Variable"error”, and string "retValue" are system objects, and are
loaded with information after each instruction is executed. Please refer to Appendix D of the
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SoundScope & SuperScope |1 Reference Manual for details on who returns what. Instruction
feedback is often used to break out of aloop. For example, one could continuously call the "Move
marker to next peak™ instruction, in aloop, until it returned an "error" code of 3 (marker hit end of the
wave).

Press OK to return to the Task Editor.

[0 Click on severa functionsin the scroll areato familiarize yourself with this environment, and then
press Cancel when done with your review.
16 Move M1 to absolutetime X of W1 move marker M1 to O seconds
17 Move M2 to absolutetime X of W1 move marker M2 to 0 seconds
18 Move M2 to next peak of W1 move marker M2 to the 1st peak in W1
19 Move M2 to next peak of W1 move marker M2 to the 2nd peak in W1
20 Move M2 to next value of W1 move M2 to the next place where W1 crosses -1
21 Move M1to next valley of W1 move marker M1 to the 1st valley in W1
22 Move M1 to next value of W1 move M1 to the next place where WL crosses -1
23 Pulse anaysis Segl (area2 to area, Area) send area of segment Segl to variable & string Area
24 Insert "Area="into journa Results insert text into journal Results
25 If (String Area> 0.1000) then ... if area valueis greater than .1 then ...
26  Append text onto the end of Results with data from string Area
27  Jump to "out2" jump to the "out2" label (6 lines down)
28 Ifend end of theif (>0.1) case
29 Insert "Low" into journal Results insert text into journal Results
30 Beep make a beep sound
31 Beep make a beep sound
32 Show Alert: "AreaLow !" show alert to say that area value is <0.1
33 out2: thislabel is atarget for a Jump instruction
34 Insert "\r" into journal Results insert a carriage return into journal Results

Segment "Segl" is defined as the section of wave W1 between markers

M1

about the second pulse in wave W1, causing Segl to become this pulse, as
illustrated to the right. /Vp\/l\//ﬂ\

O

<
N

T
and M2. Instructions #16 through #22 move markers M1 and M2 M1

S

Instruction #23 calcul ates the area under Segl (in units of "volts * /Sga\
seconds"), and transfers the result to variable "ared" and string "Area’.
Instructions #24 through #34 inserts the area value into journal

Results, if it is greater than 0.1; otherwise an alert indicates the areais /’\\/f"\.\v/
too low.

Press OK to exit the Task Editor, and then press the front panel b 104 2380 583 778
"Noise" button to add Gaussian noise to wave W1. W1 will fuzz-up,

as pictured to the right (your screen may look ©
alittle different, depending on your setup). WwWWWWMMWMWWWWMWWWW g
To view the Noise task, select Edit » Noise

from the Task menu. The task will appear, as
illustrated below.

D194 389 583 798 972 1167 1361 1555 1750 1944 2139 2333 2528 2722 2916 3111

01 Fill wave'Noise with 5.000 Volt RMS gaussian noise, 2200 points
02 Read W1 internals (start timeto ST; sampletimeto SR; etc)
03 Set wave Noiseinternals (ST to start time; SR to sample time; etc)

-
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04 W1=W1+Noise

[0 Double-click on instruction #1, "File wave
...", to open the Synthesize dialog. This
instruction is currently set up to load wave
"Noise" with 2300 points of 5Vrms
Gaussian noise. Instruction #4 will later add
each point in wave Noise, to each
corresponding point in wave W1, and place
the results into wave W1.

[0 Press Cancel to exit the Synthesize dialog.

Since waves cannot "add" unless their sample
periods are identical, we first set wave Noise's
sample period to that of wave W1. Also, adding
two waves results in their time-wise intersection
if oneistime shifted with respect to the other, or
if oneislonger than the other. For example,
adding a 0-10sec wave to a 5-15sec wave results
in a5-10sec wave, asillustrated to the right.

Synthesize:

2200 points

Length:

) Periodic: (52 I points/cycle
10.000 Uolt amplitude

@ Sine

(O Square (O Triangle

ORamp:  [0.000 | to 5.000

) Constant: ICI Volt

{® Guassian: Uolt rms noise

|voit

e

Qi

| LT

- 1 KN

_—_l_ Exﬁ-

Subsequently, instruction #2 is used to transfer the W1 sample Osec 5sec 10sec  15sec
period, start time, # of valid points, and data storage size to W1l LT : |
variables SR, ST, VDP and DS, respectively; and instruction #3 | | | |
is used to set wave Noise's internal's parameters to these values. | w2! 1 :
W3! =W 1+W2 I_|_Iil :
= | |
[0 Double-click oninstruction #2,
"Read W1 ..", to open the Read Read Wave Internals:@
Wave Internals dialog, pictured to Transfer start time to
theright. Thistransfer areais T etart tim
simi Iar_to that in StatIStl csand Pulse Iie {;} Owave: | FFT | (eptions...] @
Analygts- Pla}C/lWIth the {ranztrer v,:”a:fg gr‘: ptst ] variable:| ST | (options... ] @
parameters and pop-upsto get a valid data pts _
better feel for this environment; it's e ntn sion Ddou_rm_’" _CHPORT__ | (ptions. )
used by amany ingtructions. Press Cost sine Ostring: [_retvalue | [sptivns...] (s
Cancel when done with your review. min I1U code L] Control:
o £ o Ovorker: [M1_Jume [+
[ Do it ] [ Clear ] [ Cancel ]
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O Double-click on instruction #3,
"Set wave ...", to open the Set set Wave Internals:
Wave Internals dialog, pictured to ) )
theright. Thisisvery similar to ts lime 5 witn...
Read Wave Internalss, yet sends ¥ samble fhne ()
data in the opposite direction: #palid pre pts (V)
from waves, variables, journals, + #valid data pts [ Read:[ Dariable|[ ST ]
strings, controls, and markers to pre size _ —
internal wave parameters. The ‘/g:;? ::;: Current value: 0.00000 sec m @
With... areais similar to that in the -
Assignment, Arithmetic and m:,",{'.uuccooddee
Transcendental instructions. The min EU value ™)
checkbox enables the transfer, the
first pop-up selects the type of ((Doit ] [ Clear | [ cancel ]
object, and the second pop-up, or

edit field, selects the specific object or value. The value below the Type pop-up shows the current
value of the object, and the Options button opens a Wave, Journal or Variable Transfer Options
dialog, described earlier. Play with the"Set ..." parameters and pop-ups to learn how this works, and
then press Cancel when done with your review.

[0 PressOK to exit the Task Editor, and then click on the front panel FFT button to recalculate the
frequency spectrum of wave W1. Notice the broad-band energy that has been added to wave W1.

[0 Now click on the front panel Filter button to low passfilter W1. This
causes the high frequencies (mostly noise) to be attenuated, and the
low frequency sine component to continue on it's merry way. The
Filter button runs the Filter task, which executes the Filter instruction,
which is similar to the Filter command under the Wave menu,
discussed earlier. For details on this, please consult the Filter
discussion in Chapter 6 of the SoundScope & SuperScope Il Reference
Manual.

Pre-filter FFT |4

_ _ Post-filter FFT [*

[0 Click again on the FFT button to recalcul ate the W1 frequency 2 4
spectrum. Notice that the higher frequency energy has disappeared, as 2
illustrated above. o |8

30 40 hz 4
| s[10nzmiv_ 3

BUILT IN HELP AND PRINTING

[0 Click on the Help button to open the built in help =] Help e
journal. = =
J This journal contains built in ir

0 To view the Help task, select Edit » Help from the help 1!
Task menu.

Thistask islisted to the aboveright. A textural description  [Task Begin

of atask can be copied to the clipboard by choosing Copy
Task Thetask consists of one instruction only - the Choose
Menu instruction. Thisisapowerful instruction that allows
any menu item to be executed from any SuperScope task. In thisinstance the Choose Menu instruction is
being used to show the window journal Help.

Choose Show Help Under Edit

[0 If you have a printer connected you can click on the Print button to print the front screen. The Print
task uses the same instruction that the Help task uses - the Choose Menu instruction. To view the
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Print task select Edit » Print from the task menu. Double-click on Choose Print... Under File and view
the options available. Any menu item in any menu can be selected.
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DATABASE ACCESS

After datais acquired, it is often saved. Waves are often stored in binary files on disk, and text is often
saved in a database or spreadsheet. Formatting text for export isrelatively easy, as shown in the
following pages.

[0 Click the front panel Clear button to clear al journals. User:
Bart Simpson

[0 Typeyour namein the User journal and then type a comment in the Notes journal,

asillustrated to the right. Notes:
Hey Man!

0 Select Show » TEMP under Edit to brings TEMP into view.

0 Select Run? Log under Task to gather datafor export, and to save it on disk as atext file. Press Save
when the File Save dialog appears and remember where you put the data.

[0 Select Edit» Log under Task to view Log, illustrated below.

01 Clear at beginning of task journal TEMP

02 Statisticson W1 (avgto TEMP; minto TEMP; areato TEMP; std dev to etc)
03 Statisticson FFT (max to TEMP; X at max to TEMP)

04 Insert today'stimeinto journa TEMP

05 Insert today's date into journal TEMP

06 Append text onto the end of TEM P with data from journal User
07 Insert"," intojourna TEMP

08 Append text onto the end of TEMP with data from journal Notes
09 Change"\t"to"," injourna TEMP

10 Removerow #1 from journal TEMP

11 Removerow #1 from journal TEMP

12 Removerow #1 from journal TEMP

13 Change"\r* to"" injournal TEMP

14 Choose Save As... TEMP Under Journa

Instructions #2 through #8 fill journal TEMP with various statistics, parameters, and journals, as pictured
below.

|§[]EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE TEMP
WA W1 H1 H1 H1 FFT FFT Time Date
avg min areq std dev rms max X at max
Vol t Vol t Volt-sec Uolt Vol t Volt Hz
3.16e-3 -5.000 0.016 3.534 3.524 4.242 19.531 23:53:00 3/26/96

Instructions #9 through #13 then format this data into 11 neat datafields, each separated with a comma, as
shown below.

0.013,-5.322,0.167,2.677,2.677,3.488,2.572,19:29:16, 1/2/93,Bart Simpson,Hey man!
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SEND DATA TO A SPREADSHEET

If you have a spreadsheet application, such as Microsoft Excel, you could open the recently saved text file
into a spreadsheet window, as shown below. When importing text into a spreadsheet, commas can separate
columns and carriage returns can separate rows. In the case of Excel, commas need to be specified
explicitly in the Text Options dialog, which is accessed by pressing the Text button in the Excel File Open
dialog.

HE——— TEMP
A B [ D E F G H | J K

1 0.013:-5.322:0.167: 2.677: 2.677: 3.488: 2.572:19:29: 16: 1/2/93:Bart SimpsoniHey man!
2

SEND DATA TO A WORD PROCESSOR

If you have aword processor,  [Feaaa———e0———— TIMP e—aa00ta—r—c=

such as Microsoft Word, you —= Ny

could open the data directly

into aword processing B=== E== BE= ([ 8

window, as shown to the right. |0 L [ \ |2 | I3 L 14 L 15
0.013-5.322,0.167,2677 2677,3488,2.572,19:29:16, 11293 Bart

SEND DATA TO A Simpson,Hey man!

DATABASE

If you have a database S((=———————— Test Results

application, such as Claris's Caqout #1

FileMaker Pro, you could ;
import the data into a database, .,
as pictured to theright. The =
database shown hereisincluded
on the SuperScope 1 disk, in !

file"Adv Tutorial Database". secords: i DEMOGRAPHICS
i i i User Test Time Test Date
wilﬁMs%%rgc%Z?fx Included — Bart Simpson P28 Poi2as

1 S A AN LTI WAL TR TR
]

- i_;
A —

Tutorial: Advanced Techniques 4- 23



Super Scope |1 User's Manual

To import datainto FileMaker Pro, — )
one must choose Import under Filein Specify field order for import
FileMaker. This causes anew record Data In: “TEMP” Fields In: “Test Results”
to be created, and it's fields to be D015 | 3] AvgAin0 ]
|oaded Wlth datafrom atext file. _The 0167 || Areaain0
latter step involves aligned incoming 2677 | 3| StdbevAind
data to database fields, as shown to 3.482 || maxFFT
the right_ 2572 || HzFFT
19:29:16 [—»| Time
1/2/93 || Date
Bart Simpson (—#|User
[0 Press OK to exit the Task Editor. Hey mant |3 Notes
[0 Hidethe TEMP window by Lk
pressing it's close box. (¢<] scan Data [>>] Record 1
® Add new records
{_) Replace data in current found set

[

N
1
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DEBUGGING

When debugging SuperScope Il instruments we recommend that you first debug and verify the instruNet
hardware, your cables, your sensors and your signals with instruNet World software -- without running
SuperScope Il. Please refer to the instruNet User's Manual for details on how to do this. When you are
satisfied with your configuration, click the Store button on the Network Page to save the instruNet World
field settings.

Then launch SuperScope |, select Network » Open under the instruNet menu and press the Restore button
to load the instruNet World field settings you previoudy stored. Also when you save a SuperScope ||
instrument file the current instruNet field settings are automatically saved in the SuperScope Il instrument
file, such that loading the SuperScope Il instrument causes the instruNet field settings to be restored to
their pervious state.

THE TASK80 JOURNAL
One of the most powerful SuperScope Il debugging featuresisthe Task80 journal. If ajournal exists of
the name "Task80", status text iswritten to thisjournal, in real time, after each instruction is executed.

[0 Choose New under Journal to create another || Adv Tutorial.ioNet [i2 6wl
journal. When it's Options dialog appears, start HY Noise FFT Filter Pulse
choose Window in the Position pop-up (to |_toa Lalr Stals o -tiear el Brint

specify that thisjournal isto haveit'sown
window), renameit "Task80", and then
press OK. When the window appears,
reposition and resize as pictured to the right.

|

0 Now choose Run » Calc under Task. Aseach
task instruction is executed, it's statuslineis
printed in the Task80 journal, asillustrated
below.

The status line contains the first 30
characters of each instruction, the value of
the "error" variable after the instruction is
executed, and the action taken. For
example, the "If (string PeakFFT > 4.5)
then" lineresulted a" (5 > 4.5)" test, which
produced True, causing the body of the

If...Then statement to be executed. i Task8) DY——mee—————————=—

2|

[

The "error" variable is loaded
with a SuperScope |1 Error Code . : R o
after each instruction is executed
A value of 1.000 meansthings Move manker M3 to the 0.00000 e 1.000000 o d th k
. ove marker o the 0. . we move e marker
went OK. For a||$ Of Move marker M3 to next maximu e 1.000000 ® ywe moved the marker
Marker M3 & wave FFT intersec e 1.000000 ® vyqalue=4 242
SuperScope Il Error codes, please
H H Insert "Max FFT value = " int e 1.000000 L
see Appendix D inthe If (String PeakFFT > 4.500> t e 1.000000 e <4.242 > 4.500) = fals
Soundscope& SupefSCOpeH énsert "Low" into journal Res e }gggggg L
eep . . .
Reference Manual. Beep e 1.000000 e
Show Alert: "Max FFT Low!" e 1.000000 .
H H out: e 1.000000 .
O Try runni ng Se\/eral taSkS Wlth the Ihsert """ into journal Resu e 1.000000 .
un ?” menu command to a Move marker M1 to the 0.00000 e 1.000000 ® we moved the marker
Run? d to get
R Move marker M2 to the 0.00000 e 1.000000 ® we moved the marker
better feel for thlSpOWGrfUl Move M2 to next peak of W1 (t e 1.000000 ® we moved the marker

feature. If the Task80 window
ever becomes hidden, choose Show » Task80 under Edit to bring it to the front. If the journal
becomes too cluttered, you can always clear it by choosing Clear » Task80 under Journal.
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THE BENCH JOURNAL

Since data acquisition involves time, it is often important to know how much time is consumed by each
instruction. If ajournal exists by the name "Bench", benchmark information iswritten to thisjournal, in
real time, after each instruction is executed. The benchmark indicates, in seconds, the amount of time
required to execute the instruction. The time required to write to the Bench journal is not included. Also,
the amount of time required to do house-keeping chores in-between each instruction is not included. This
"in-between" time can vary from 20pusec to 200msec in aworst case scenario (100usistypical). An
exampl e bad-case would be the sending of update events to an application running on aremote hard disk
via System 7.0 file sharing. The user can easily specify which in-between chores are executed with
settings in the Task Options dialog, detailed in Chapter 3 of the SoundScope & SuperScope Il Reference

Manual.

Benchmark times are accurate to =.25pus if an instruNet controller isinstalled in your computer;

otherwise, the durations are accurate to +16ms.

[0 Choose Options» Task80 under Journal,
rename the journa "Bench", and then
press OK.

[0 Now choose Run» Calc under Task. The
Bench journal will fill with instruction
execution times, in units of seconds, as
shown to theright. This example was
done with a Quadra 650 and Model 200
controller.

It turns out that most time is spent updating
front panel displays and journals. Therefore,
reducing their size and number tends to
expedite tasks the most. Waveform
calculations are coded in highly optimized C;
and therefore execute very quickly with long
waveforms (e.g. 3.64ps per point when
adding two 32bit floating point waveforms
with a Macintosh 11fx).

=l Bench ===
Task:Calec Date:3/27/96 Time:00:11:28 Al
0.045241 Task Begin

0.001981 Move marker M3 to the 0.00000
0.002676 Move marker M3 to next maximu
0.001389 Marker M3 & wave FFT intersec
0.007026 Insert "Max FFT value = " int
0.000919 If (String PeakFFT > 4.500) t
0.005944 Insert "Low" into journal Res
0.173509 Beep

0. 165564 Beep

1.019424 Show Alert: "Max FFT Low!"

0. 000000 out:

0.005086 Insert "\r" into journal Resu
0.002165 Move marker M1 to the 0.00000
0.002206 Move marker M2 to the 0.00000
0.002574 Move M2 to next peak of W1 (t
0.002339 Move M2 to next peak of W1 (t
0.002615 Move M2 to next position wher
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ONE THING ATA TIME

Many tasks are best debugged by executing each instruction, one at atime, and viewing source data
before each execution, and result data after each execution. Thisis easily facilitated with the Task
Debugger buttons.

[0 Choose Options? Bench under Journal, rename the journal "Bench_", press OK to disable the bench
marking feature, and then click on the Bench_ window's close box.

O Now choose Edit » Noise under Task to open the task Editor.

The Go, Step and Stop buttons at the Task Editor upper right are used to
run and debug tasks. Go executes atask while the Task Editor isopen. A

triangular instruction pointer (P), at the left edge, follows the execution
and indicates to the user which instruction is being executed. While the
task is running, the user can either press Step, to freeze execution; or Stop to halt execution and move the
instruction pointer to the top. When execution is frozen via Step, the instruction pointer stays whereitis
and the user isfreeto either view and alter data (e.g. withthe C, J, M, S, V, and W buttons), press Go to
continue running, press Step to execute another instruction and then freeze, or press Stop to halt execution
and move the pointer to the top.

[ 6o |[Step][s108)

[0 Pressthe Step button, once, to execute thefirst line. The pointer will advance, [Task Begin
as shown to the right. Fill wave 'Noise

0 Pressthe W button to open the Wave Options dialog. Then press the(__Edit.. ] button to open the
Wave Editor. Notice how you can switch from one wave to another, by clicking in the upper pop-up
menu. When done with your review, return to the Task Editor.

[ Pressthe Step button again to execute the next instruction, and then press the V button to inspect the
ST, SR, DS and VDP variables. Return to the Task Editor when done.

[0 Play with the debugging features to better acquaint yourself with these tools. In some cases, viewing
data on the front panel is adequate, yet in others, the C, J, M, S, V, and W buttons are necessary. EXxit
the Task Editor when done.

Sepping is an extremely powerful debugging tool, since it helps you verify
hat each instruction does as expected; and if there is a discrepancy,
it places you at the heart of the problem.

THE ULTIMATE STRIP CHART RECORDER

SuperScope I1's fundamental architecture is based on the concept of the ultimate strip chart recorder,
which simultaneously acquires, analyzes, plots, and saves to disk continuous streams of acquired data and
waves containing the results of analysis performed on the acquired data.

This part of the tutorial uses an instrument that is designed specifically for an instruNet system consisting
of 1 controller and 1 Model 100 network device. If an instruNet systemis not installed on your computer,
this instrument will simulate a system consisting of 1 controller and 1 Model 100 network device.

0 Findthe"2Ch iNet Strip Chart" instrument which is located in the "Tutoria" subfolder inside of the
"instruNet instruments" folder, and duplicate it.
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O Double-click on"2Ch iNet 2Ch ioNet Strip Chart [ 22 6wl
Strlp Chart copy" (le the Start I LoadData I Analyze
duplicate instrument); or T RN
launch SuperScopeIl,and  [* : : :

then choose Open under File

to load the instrument. The
2Ch iNet Strip Chart will

appesar, as shown to the rlght D200 400 600 500 1000 1200 1400 1600 1500 2000 2200 2400 2600 2800 3000  msec
[<al [3] 200 msec/ni

2=

EEIEEE

abs

This instrument does three beri | -
things. Pressing the Start button : i

runs atask that digitizes two e peceoe e e ettt o s s e o e S - S T
analog input channels ("W1" and SRR SR SR A
"WZH), Ca|CU|aIeSthe abSO|Ute e .... .... .... .... - - - - . .... .... .... L-s50
vaueof W1 (i.e.abs= | .. SSOOUNNE IO SURNNNE OO0 SO SOOUUNE IO NN UOOOOE SN SOOPUOE IO SONNNNE OO S SO Mo
Abg[W1]), takes the derivative Notes Analysis

of the absolute value (i.e. temp = |:

o

EIEEIEE

Deriv[abg]), scales the derivative
(i.e. deriv = temp * 30), sends
the pulses times of W1 to the
journal Notes, and saves the ' '
waves W1, W2, calc & deriv, and the journals Notes and Analysis, to disk.

Pressing the LoadData button runs a task that allows you to open and scan through a previously acquired
data set.

Pressing the Analyze button runs atask allows you to select a previously recorded wave and then runs the
Pulse Analysisinstruction on it.

The ability to simultaneously acquire, analyze, and present
continuous streams of data makes Super Scope Il an extremely
power ful waveform recording tool.

O Pressthe Start button. When the

Save File dialog appears, enter a | 2Ch ioNet Strip Chart | |52 6w
name for the folder in which the —_—r ) loadlais | T -
waves and journals will be saved : e U N S f
and press OK. 1 =
N N A N A AL R TN N G 0
The screen will plot five S0sample/sec mgmmsusz ITh e I~ o
wav Eforms, n pseUdO I’e_al -t me,_ fora h_ 200 400 600800 1000 1200 1400 16001900 2000 2700 2400 2600 2800 G000 msec o
total of 25 seconds. While running the = =

screen will appear as shown to the
right. What is pseudo real-time?
WEell, you may have noticed apausein [,
the plotting at the scan breaks (every
5sec). During this pause, the computer

was saving scansto disk. This does '
noteffeCt Fhe d-ata hOWa/er, S nCe gg %?2/?2 gc‘lr?.os?ipsons Experiment l:; 1
digitizing is being done by the ¥4 End of Experinent T e
instruNet controller in the background. g 112
L T 2250 —

[0 While datais being acquired click
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once in the journal Notes and then type in acomment (i.e. "Thisis Bart Simpsons Experiment").
Press carriage return on the keyboard and type in another comment.

Comments entered into the journal "Notes" will be

automatically prefixed with atime annotation, and H2
also al'ltomatlcally placm into the dISplay "Dl", |This is Ba;“t Sir;psons; Expe'r‘iment
which islinked to the journal "Notes". If a 2600 2700 2800 2000 3000 3100 3200 3t

comment is entered into the journal "Notes" at 2.2
sec it will appear at the bottom of display "D1" at
2.2 sec, asindicated in the figure to the right.

The time annotation that is automatically entered der i
for each comment entered in the journal "Notes' is abs
the time between the beginning of the trigger
condition that initiated data acquisition in the
"Start" task, and the time the first keystroke was
entered for the comment.

. . X 0.0 3/28;”96 03:53:3? )
Entering a carriage-return ends a note, and the first |7§.3 This is Bart Simpsons Experiment

key stroke entered after the carriage return starts End of Bxperinent
the beginning of anew note. If no trigger
CO!’]dItI onwas SpeCIerd (l;e- Trigger Nor_]e in the Comments entered into the journal “Notes’

Trigger Dialog) then the time annotated in the are automatically time annotated & placed

journal isthe time since the execution of the Scan o thedisplay’ DX, whichislinked to

Loop Begin instruction (for the first scan) in the :

Start task. Instruments can be designed with multiple runtime journals, each linked to separate displays.

Pressing the Start button on this instrument runs the "Start" task which acquires 5 scans of data and saves all
of the waves (i.e. "W1", "W2", "abs" & "deriv") after each scan, and the journals (i.e. "Notes' &
"Analysis") once at the end of thetask. The two sets of acquired waves "W1" and "W2", along with the
waves "calc" and "deriv" which contain the results of calculations performed on the acquired waves, are
saved to disk under their wave names prefixed by the scan number (e.g. "00000001 W1", "0000002 W1",
etc.). A total of 22 files, 5 for each channel and 1 for each journal, are saved to disk. Each of the acquired
waves "W1" and "W2" are contiguous across scans as are the analysis waves "abs" and "deriv". Neither the
acquired data nor the results of analysis are affected by scan breaks.

O After theinstrument is done acquiring data, choose Options? Notes under
Journals to view the Runtime options for ) ) ) )
the "Notes' journal as shown to the right Runtime: [ Prefix notes with: @ Seconds O hrs:min:sec
below. The"Show notesin display" popup (I show notes in display[_D1 |
links a Runtime journal to adisplay. Each
display can haveit's own Runtime journal and more than one Runtime journal can be linked to a
display. If experimentsarelong (e.g. hours or days) it may be more optimal to enable the
"hrs:min:sec" Radio button. Click Cancel to exit the journal dialog.

[0 Choose Datapipe? Data under File to open the Datapipe dialog, shown to the
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right. Click the Folder... button to view the available
hard-disks and folders to which the Datapipe "Data’
can point. If you want to change where the Datapipe
is pointing do so now in the File dialog. Click
Cancel (or OK if you have changed where the
datapipe points) to exit the file dialog and then click
OK again to exit the Datapipe dialog.

After creating a datapipe and specifying where the
datapipe points, any Disk I/O instruction that is added to
the instrument that saves waves, journals or strings and
that specifies that datapipe as being the location where
the datais to be saved, will automatically send datato
whatever hard-disk or folder that the datapipe points to.

-gptions

[ Turn on and off with %-U

Hard Drive: Desktop Folder:

Come ) )

The power of datapipesisthat they limit the bookkeeping required in storing and keeping track of

waveforms associated with particular experiments.

[0 Choose Edit » TakeData under Task to view the acquisition task, shown below.

01 Clear at beginning of task journal Notes
02 Clear at beginning of task journal Analysis

04 Scan Loop Begin (5 scans)
05 Segment Loop Begin

12 Pulse analysison W1 (pulse#, t3 to Notes)
13 Save wave W1 to disk

14 Save wave W2 to disk

15 Save wave absto disk

16 Save wave deriv to disk

17 Scan Loop End

18 Save journal Notesto disk

19 Save journal Analysisto disk

03 Create new folder for Datapipe "Data’ and prompt for name

06 Digitize Segment (250 pts/scan, 50.000 pts/sec)
07 abs= Abs (W1)

08 temp = Deriv (abs)

09 deriv = temp * 30.000

10 Plot Segment

11 Segment Loop End

The segment loop works as described below each time it is executed:

#1 Small chunks (e.g. .1s) of digitized data from W1 and W2 are loaded into

SuperScopel 1.

#2 The absolute value of the recently acquired Scan Loop Begin (5 scans)

W1 datais calculated, and placed into wave
abs.

#3 Thederivative of W1 is calculated and placed
into temp.

#4 The most recent temp chunk is scaled, and
copied to wave deriv.

The Scan Loop instructions (#4, #12, #13, #14,
#15, #16, #17 & #18) execute once for each scan

Segment Loop Begin

Digitize Segment (250 pts/scan,
abs = Abs (W1D

temp = Deriv {(abs)

deriv = temp * 30.0000

Plot Segment

Segment Loop End

and operate on whole scans. In other words, the segment Loop instructions continuously fill buffers (250
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points long, in our case), and after the buffers are filled, the Scan L oop instructions crunch on the 250
point blocks of data. After this, the segment Loop instructions fill up the buffers again, and over-write the
old data. And the cycle repeatsitself, fivetimesin our case. Notice this means the instruction after
Segment Loop End, #12, waits until a complete scan is acquired (i.e. continuous stream points #250,
#500, #750, #1000, and #1250), before it executes. While it waits, datais acquired by the instruNet
Controller. Thisprocessisreferred to as the Segment Seamless Collection Mode, and isillustrated below.

—™ 1~—— Task Begin
[
—™1 I*+— Scan Loop Begin
| |

e

T T e

| | | J_I

| T T T e
| | |

|

|

|
| [P T T T e T T T 4
[

[

[

[ :
[ |
[ | | | |
[ | | | |
[ | | | |

|
|

|
II
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—<— waitfortrigger |
|-—
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-— time=0
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N N | L
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I —
|
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|
|

—= i=— Scan Loop Begin
1'——:«—>:<— Segment Loop Begin
| ___]'__:——:<—>:<— Di gi tize Segment
:‘_’Ju_ - ]'_ —: -—- —:<—>:<— Pl ot Segnent

| [ _I_I

<> 1~~~ -~ 7%+»m= ( ear &Updat e
Lo Lo

L

|
| : | : |
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! il time

|
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time

I ‘
’ »

Tutorial: Advanced Techniques



Super Scope |1 User's Manual

[0 Double-click on instruction #3, "Create new folder for datapipe "Data’ and
prompt for name" to bring up the
Datapipe dialog, as shown to the right.
The Datapipe dialog offers three
options, one of which (the one enabled
for thisinstrument) is "Create new
folder and prompt for folder name".

Datapipe:

{ Show datapipe's Folder Dialog
® Create new folder and prompt for folder name
) Create new folder with default name, don't prompt

[ Help.. ][ Doit [ cancel | [[ oK

When thisinstruction is executed adialog
will appear prompting the user for the name
of anew folder that will automatically be
created. Entering a name into the dialog and
clicking OK will create afolder with the name entered, and put it on the computer at the same level asthe
datapipe "Data". For instance, when thisinstruction is executed, if the Datapipe named "Data’ currently
points to a hard disk named "HardDisk", and you enter the name "Flow Data Set 1" into the dialog that
appears, then afolder named "Flow Data Set 1" will be created and put on the hard disk "HardDisk".
After thisinstruction is executed, any Disk 1/O instructions that are run in the task that save waves,
journals or strings to disk, and that direct that their data be saved to the Datapipe "Data’, will save their
filesin the folder "Flow Data Set 1". Datapipes can save alot of work in record keeping. Asan example,
in thisinstrument, each time the start button is pressed, the user is prompted for the name for a new
folder, and all data (i.e. waves & journals) are stored in that folder. After anumber of experiments are
run each data set (i.e. Waves and Journals) is stored in an individual folder inside of a designated folder
(i.e. the Datapipe) on the computer.

[0 Press Cancel to exit the Datapipe
instruction and then Double-click
on instruction #13, "Save
wave..", to open the Data
Transfer dialog, shown to the

Data Transfer

@ Save | wave || w1 | to disk

right. Thisinstruction saves and
loads waves and journals to and
from disk, transfers data between
waves, journals and strings, and
deltesfiles. The currently
selected option isto save the
wave "W1" to disk.

Press on the Options... button to

(O Load | wave || abs | from disk

) Delete last saved file
) Delete last loaded file

[ File... ][l]ptions...] [ Help ][ Cancel ]

open the File Options dialog, pictured to the right below. The "Prefix file name with incrementing
integer” is selected which causes files to be saved with an index attached to their file name, as
illustrated to the right of the File Options dialog. This option must always be enabled
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when designing Strip Chart

=)= Data Folder =0F|

instruments that stream Fi i , -
. ile Options 20 items 327.9 MBin disk 1
continuous waveforms to .
disk. Click Cancel to exit fDatabase =
the File Options dialog. . [ Prefix file name with incrementing integer g sggggg: :bs'
[J Prefix file name with ualue: D) 0000001 we:w

0 Press trl;le Fi||e... butgogl to [] Prefix file name with ualue: D 0000001 W2
open the File Save dialog, . [JPrefix file name with value:[ error D 0000002 abs
shown to theright. This - D 0000002 deriv
dialog is used to specify the X Upon file error, show an alert el
file name, and the path to & Upon file error, stop all running tasks g gggggg; :;25
wherethefileissaved. The Ol 000050z derte
datapipe "Data" is selected
in the Folder: popup. This
means the file "W1" will be
saved to the folder specified by the datapipe. Press
Cancel twice to exit to the Data Transfer instruction..

0 Double click on theinstruction “Save journal "Notes" 0 S0eee e
to disk" (#17). The Disk 1 8800001 1
[/O instruction that is used to save wave datato disk is N BHBHREHT Y
also used to save journal datato disk, but with one D BHBBBHL abs }
modification. Click on the Options... button to view ) BBBHHDL deriv
the file saving options for saving the journal "Notes" L BBDBBHZ Wit
to disk. The "Prefix file name with incrementing L BBBBBEY H2 (Format... )
integer" option is not enabled for saving the journal File name: Folder:
"Notes' to disk. Thisis becausethejourna "Notes' is [wi | [(Data__|
only saved once at the end of the experiment and not

at the end of each scan as is the case with the waves.
Click Cancel to exit the Options dialog. Click the

File... button to open the File dialog. The datapipe "Data" is selected
in the Folder: popup which directs the Disk 1/0O instruction to always

save the journal "Notes" wherever the datapipe "Data" points when -Database

File Options

thisinstruction is executed. [ Prefix file name with incre

[0 Open the folder on your computer that contains the data that was just
acquired
with thisinstrument (i.e. the folder you named in the File 1/0O dialog

[ Prefix file name with valuq
[ Prefix file name with valu
[J Prefix file name with valui

right after you pressed the Start button) and view it's contents. It
should look like the folder shown to the right.

Each of the four waveforms (i.e. "W1", "W2", "abs" & "deriv") will appear 5
times; each time having the same name but prefixed with an incrementing
integer. The journals Notes and Analysis will only appear once and will not
be prefixed with an integer.

The Start task is designed to loop 5 times, and since a Disk /O instruction is
installed for each of the 4 waves inside of the Scan loop, each wave will be saved
to disk at the end of each scan; each time having the same name but being
prefixed with an incrementing integer. If the "Prefix file with Incrementing
Integer" option was not enabled then only 1 copy of each waveform would appear
ondisk -- in fact "W1" and "W2" would contain the data acquired in the last scan
and "abs" and "deriv" would contain the results of the waveform analysis of the

=)= Data folder =013

20 items 3279 MBindisk 1

Marme

O 0000001 abs
[ 0000001 deriv
[ 0000001 W1
D oooooo1 w2
[ 0000002 abs
[ 0000002 deriv
D oooo002 W1
[ ooooo02 w2
[0 0000003 abs
[ 0000003 deriv
)
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last scan. In summary if the "Prefix file name with Incrementing Integer” option was not selected,
running the Disk 1/0 instruction at the end of each Scan would overwrite the data from the previous scan.

Since the Scan Mode popup in the Timing dialog is set to Strip Chart each file of wave data saved is
continuous across scans. The last point of the wave "0000001 W1" is continuous with the first point of
the wave "0000002 W1". Thisisalso true of the waves "abs' and "deriv" used to hold the results of
waveform analysis - the last point of the wave "0000001 abs' is continuous with the first point of the
wave "0000002 abs'. Waves saved to disk in asimilar fashion (i.e. inside of a Scan Loop) in instruments
designed with the Scan M ode popup set to "Oscilloscope” or "Oscillo Queued” are not continuous across
scans.

The journals "Notes" and "Analysis" only appear once in the folder since the Disk 1/O instruction that is
used to save them to disk only appears once at the end of the Start task.

[0 Pressthe button LoadData which will run the Task "LoadData" illustrated below. Thistask will load
in the four waves ("W1", "W2", "abs" & "deriv") and the two journals ("Notes' & "Analysis") that we
previously saved to disk. Thefirst instruction executed (#1) "Show Datapipe "Data" Folder Dialog
Box" will open the File Open dialog. When the File Open dialog appears, find and open the folder in
which the waves and journals were saved when you ran the instrument (i.e. the folder you named in
the dialog that appeared immediately after you pressed the Start button), and click OK. Thefirst item
in the folder will automatically be highlighted. The next 6 instructions (#2, #3, #4, #5, #6, #7) will
each in turn load either awave or journal that was saved to disk.

01 Show Datapipe "Data" Folder Dialog Box
02 Load wave W1 from disk

03 Load wave W2 from disk

04 Load wave abs from disk

05 Load wave deriv from disk

06 Load journa Notesfrom disk

07 Load journa Analysisfrom disk

[0 Scroll through the loaded data set using the horizontal scroll bar on the top display. Thejournal
"Notes" isloaded with the original comments that were entered into it for this data set, and the
comments appear in the bottom of display "D1" aswell. Using thistask you can load in any
previously acquired data set and scroll throughit.

[0 Choose Options... » W1 under the SuperScope || Wave menu to open the Wave
Optionsdialog. The datapipe "Data’ is selected in

the Seamless Scrolling via: popup, as shown in the .
figure to the right. This determines which datapipe Wave:[ WT__]
the wave "W1" will pull wave scans from when Name: (1 | (Format.. ) (Eait. )
scanning through previously acquired data. o
Units: [Volt [ Points... ] [Synthesize]
In this example instrument SuperScope Il saved the Place wave into display: [_o |
waves "W1", "W2", "abs" and "deriv" to disk at the end [ 1f wave changes, run:
of each scan prefixing each scan into the datapipe seamless scrolling via:
"Data’, with an incrementing integer. SuperScope || 5 Link to ioNet [Channel
allows you to scan through the individual scans of
acquired data asif it were one continuous wave, (Comments] [ Assist... ) [ Revert | [ ok |
keeping track of which scan follows another on a given

wave by the integer number prefixed to its name.

Each time the button LoadData is pressed and you select afolder in which wave datais stored
SuperScope will alow you to scan through the individual scans of acquired data asif they were one
continuous scan.Click OK to exit the Wave dial og.
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In Super Scope 11, folders are used to hold the results of each experiment.
Each folder may contain many wave and journal files, and these may
or may not be indexed with an incrementing integer. Foldersare
typically accessed via a datapipe.

0 Pressthe button Analyze which will run the Task "Analyze" illustrated below. When the File I/O
dialog appears select and open the folder containing the waves and journals acquired when you ran the
Start task. If thisis done correctly the first item in the folder will be highlighted. This task then will
load each of the 5 scans of wave "W1" and run the Pulse Analysis instruction on them, treating them
asif they were one continuous wave. The results of the analysis will appear in the journal Results.

01 Clear at beginning of task journal Analysis
02 Show Datapipe "Data" Folder Dialog Box
03 Loop5times

04 Load wave W1 from disk

05 Pulseanalysison W1 (pulset#, area2, ...
06 Loopend

[0 Double-click on the instruction "Show Datapipe "Data" Folder Dialog Box" to
open the Datapipe instruction, as shown to the right.

Thisis the same datapipe instruction that was used in batapipe: [ Data |
the Start task to prompt the user for the name of a new ' e ' =
folder to be created, but in this case the option " Show s Show dateplpe's Foider Dialog

() Create new folder and prompt for folder name
() Create new folder with default name, don't prompt

datapipe's Folder Dialog" is enabled, and the datapipe
"Data’ is selected in the Datapipe: popup at the top of
the dialog. When executed, this instruction directs the (_Hep... ][ _Dort ][ cancel ][ ok |
user to select afolder that contains wave and journal
data that was previously acquired when the Start task was run. When you select a data set to be
loaded you must make sure to open the folder containing the previously recorded data. Click Cancel
to exit the Datapipe dialog.

[0 Double-click onthe"Loop 5 times' instruction to bring up the Loop dialog as
shown to theright. The Loop instruction is a subset of the Loop
Programming Instruction. The Loop instruction allows you to set
the number of loopsin the edit field, or by using avariable. If you
want to set the number of loops using a variable enable the Use 00 N
Variable option which will turn the edit field into a popup listing all oo [p |1
SuperScope variables, and select a variable in the popup.

End Loop
[J use Dariables

Whenever you add a Loop instruction to atask it will automatically
add both the "Loop X' times* (#3) and the "Loop End" (#6) items to define the beginning and end of
the loop. When the task executes a Loop instruction it runs all of the instructions in the loop, in the
order in which they are listed, and does this for the number of times specified by the loop. In this
example, in the first loop the first scan of wave "W1" (i.e. 0000001W1) will be loaded and then the
Pulse Analysisinstruction will berun oniit. In the second loop the second scan of wave "W1" (i.e.
0000002W1) will be loaded and processed. Click Cancel to exit the Loop diaog.

[0 Double-click on the instruction "Load wave W1 from disk" to bring up the Data Transfer dialog.
Click the Options... button to bring up the Options dialog. The "Save file name with incrementing
integer” option is selected, which is the same option used when saving the wave "W1" to disk.
Because this option is enabled the Loop instruction will automatically load the waves from disk in the
order in which they were saved -- that is the first time through the loop it will load wave "000001W1"

Tutorial: Advanced Techniques 4- 35



Super Scope |1 User's Manual

and the second time through the loop it will load wave "000002W1". Whenever you are building a
task to load previously stored objects (i.e. waves, journals or strings) always set your options
identically to the way the object was saved. Click cancel to exit the Options dialog.

Click the File... button to open the File dialog. Since the Folder: popup points to the datapipe "Data",
thisinstruction will always |oad data from the folder as selected in the instruction " Show Datapipe
"Data"’ Folder Dialog Box". Thisisthe power of datapipes, they keep track of what folder you are
currently working out of, for all instructions that access that datapipe. Click Cancel to exit the File
dialog, and click Cancel again to exit the Data Transfer dialog.

[0 Double-click on the instruction "Pulse analysis on W1(pulse#, ..." to bring up
the Pulse Analysis dialog, as shown to the right.

The three measurements "tmax", "dtmax" and Pulse Analysis on: [ W1__]

"area?" are all selected. To select a

measurement to be performed click onit. To send to journal:_Analysis ] ~ Bdtog pulse number

send the measurements to ajournal select a « ¥ -

journal in the Send to Journal popup. " 7 >J,/ - a2

-t/ tet -t/ te2

[0 Click on the Detection... button to open the slopel Bé? slope2

Pulse Detection dialog shown to the N

right. The"High Threshold" isset to 1 Volt and A - VA v B W

the "Low Threshold" isset to .9 Volt. Any o pyrguiiin [eresz]

pulses that cross the specified threshold ! 2 e

conditions will be detected and the selected measurements

will be performed on the pulse. If there are pulsesin your Pulse Detection

waveform but they do not cross the threshold conditions Thresholds

they will not be detected. Click Cancel to exit the Pulse High threshold: [1.000 | volt

Detection dialog and click Cancel again to exit the Pulse Low threshold: D900 | telk

Analysisdialog. Click OK to exit the Task editor.

-U1 and V2

In thistask the Pulse Analysisinstruction will treat the wave @® U1 = Low threshold, U2 = High threshold
"W1" as one continuous wave, that isit will analyze O Calculate: v1 = [10.0 | % of min to max
contiguously across the individual wave scans stored to disk. v2 = [90.0 | % of min to max

If the start of a pulse is at the end of wave "000001 W1" and
the end of the same pulseis at the beginning of the wave = ) o
000002 W1" the pulse analysis instruction will detect this as LJEwit instruction after finding pulse

one pulse and analyze it correctly. (_Hew ] [ cancer ][0k J

[] Use Dariables

This concludes the tour. We hope you enjoyed it, and hope
you share in our enthusiasm for, what we believe, is the worlds most advanced recording tool.

COMMON QUESTIONS
Why break continuous streams into scans?

#1 There may not be enough physical memory to contain the entire data stream, and the waves used for
analysis on the data. Each data point in each waveform takes up 4 bytes of RAM.

#2 The user may want to do analysis or data management on whole blocks of data, periodically, during
the acquisition of along stream.

Many analysis instructions support seamless scansin aloop. For example, in the TakeData task, Pulse
Analysisis performed on wave W1, and the results, placed into journal Notes, are not effected by the
scan-breaks at 5sec, 10sec, 15sec, etc. Notice that it found the W1 pulses correctly at 7, 15 and 22
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seconds. Inthetask, Pulse Analysisis executed five times and analyzes 250 points in memory each time,
yet never sees the entire 1250 points at one time.

Does this mean that the Pulse Analysisinstruction can evaluate a continuous stream of data indefinitely?
Yes, it can, provided you don't save the stream to disk like we do in TakeData. Pulse Analysisis
independent of disk I/O.

Do al Task instructions support the evaluation of long streams of data via seamless scans in the Scan
Loop? And do all task instructions support the evaluation of segmentsin the segment Loop? Some do,
and some don't. To see who does what, please refer to Appendix C in the SoundScope & SuperScope ||
Reference Manual.

What is my maximum sample rate when operating the Segment Seamless Data Collection Mode? It
depends on the speed of your computer, what you place in the Segment L oop, what you place in the Scan
Loop, your scan size, the # of channels digitized, settings in the Scan Options dialog, and the objects on
the front panel. For example, a Power Macintosh 7100 can digitize and plot one channel at a 90
ksample/second rate. The user determines the maximum rate empirically by telling SuperScope |1 to run
fast (e.g. 100K samples/sec), and then letting it hit alimitation, stop the task and recommend a slower rate.
It may do this several times, since there are a number of mechanisms that limit the maximum rate.

Data acquisition parameters are set by the user as described in the following table.

Parameter Where Parameter Is Specified
# of digitized channels Specified by linking a SuperScope Il wave to an instruNet
channel via the Wave Options dialog.
# of sets of scansto acquire Specitied in the Scan Loop Begin dialog, which Is opened by

double-clicking on the Scan Loop Begin instruction in a
digitizer-based-task.

# of points-per-scan Specitied in the Digitize Segment dialog, which is accessed by
opening the Digitize Segment instruction in the Task Editor

sample period Specitied in the Digitize Segment dialog, which 1s accessed by
opening the Digitize Segment instruction in the Task Editor

Trigger source & method Specitied in the Trigger dialog, which is opened by choosing

Trigger under instruNet. Choices are Off, Auto, or Norm.
Scan Mode (determines it scansare | Specified in the Digitize Segment dialog, which 1s accessed by
seamless w.r.t. each other.) opening the Digitize Segment instruction in the Task Editor.
Choices are Strip Chart, Oscilloscope, Oscillo Queued. For
details, please see Chapters 2 in the instruNet User's Manual.
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Chapter 5
Principles Of Instrument Design

It is said that, in the future, programmers will not program (in the traditional sense) due
to the development of sophisticated software that facilitates programming by the end user, "programming”
being defined as the act of building an application program. SuperScope Il is another milestone in this
evolution since it provides an environment where the end user can design their own menu driven
application program. We refer to these applications as SuperScope |1 "instruments”, and have included

several with the product.
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SUPERSCOPE |l OBJECTS

The SuperScope Il user creates and customizes objects with mouse driven pull down menus and dialog
boxes -- no previous programming experience is necessary. There are severa types of objects, as shown
below. One can create as many of each type as needed to build the application of their dreams. Each type
hasit's own dialog where one can view and edit attributes, such as the object's name. This chapter
summarizes these powerful building blocks.

M1:¢-0.767>

Markers

QuickTime

Offset 1

Journals Controls Menubars

Calculate Have
Pulse Analusis

abcdef 1.123 Sound Statistics
Statistics
Strings Variables Tasks
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WAVES

Waves are used to represent real world continuous dataas alist of values,
which when plotted, produce awaveform. Waves can be digitized,
synthesized, analyzed, edited, viewed, used to hold the results of analysis,
loaded from disk, saved to disk, sent to the clipboard as a column of
numbersin text format, and sent to the clipboard as a graphical image.
Typical instruments have 3 to 10 (or more) waves and wherever you see a - :
squiggle in SuperScope |1, you are looking at a Wave object. Waves are stored in memory as allst of 16-
bit integer (+32,768) or 32-bit floati ng point values and their maximum lengths are limited by memory
(each point consumes two or four bytes depending on the storage format).

Waves are created by choosing New under Wave. The wave dialog appears and it is from here that one
can view and edit the number of points (viathe Points button), view and edit the internal storage format
(viathe Format button), view and edit the individual wave values (viathe Edit button), or synthesize.

The Value Editor is a spreadsheet-like environment that shows the 35 705 35 415
individual points with 5 points displayed in each row. Cells can be selected, g :

cut, copied and pasted with the mouse. Additionally, selected cells can be 31..393
edited numerically with the keyboard. Wave segments on the clipboard are 26,020 24,030
stored as a column of numbersin atext format and can easily be transferred
to agraphics, spreadsheet or word processing program.

The Wave Synthesizer loads awave with aconstant value, ramp, sinewave, triangle  —__—.__

wave, square wave, uniform noise (flat histogram), or gaussian noise (gaussian
distribution). :

One can easily edit a wave by moving wave segments to and from the clipboard via the
standard Macintosh Cut, Copy and Paste commands. The user identifies a segment by
dragging the mouse over the region of interest. Theinsertion point is positioned by
clicking the mouse once. Cut, Copy and Paste commands correspond to the selected wave :
(awaveis selected by clicking on its wave label; or, if thereisonly one wave in the

display, clicking in the display).

DISPLAYS

Displaysreside on the front panel and areusedtoview [ |~ T S - Te0
waveforms and perform calculations. They are extremely : : IS
versatile with many customizabl e attributes such as SR SO SO O 1=
horizontal/vertical scroll/position controls, labels, waves, : " : it
markers and much more. Displays can be positioned on the : : : |
front panel in any pattern and in any number, space | 4] beeefhee SasgboeyeeF20 (20
permitting. Each display can contain up to 8 waves and : : : ?8
supports mouse-driven cut/copy/paste of waveform segments, : : : 0
drawing of waves, and logging wave valuesto ajournal. o 1 Y Keec 3|
To create adisplay, one must choose New under Display. E‘D (2] 8] 1 ksecspiv|{r

Subsequently, the display dialog appears and it is here that one specifies which waves are to be displayed
(thisis done by dragging wave names from the waves list box to the display contents box). There are four
display types: Wave Plot, XY Plot, Analysis and Snapshot. Wave Plot is used to plot 1 to 8
waves across the screen, XY plots 1 to 8 wave pairs, Snapshot analyzes (e.g. frequency spectrum) atime
wave at a marker position, and Analysis analyzes a segment of atime wave. Customizable labels,
controls, axes, grids, plot graphics and markers are easily adjusted with dial ogs accessed by choosing
Features, Labels, Controls, and Markers under Display.
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The user can easily redraw awaveform segment by placing SuperScope Il in Draw mode
(choose Mouse » Draw under Display) and then drawing in a Display with the mouse. ,_\;j

The user can vertically re-position a waveform by placing SuperScope Il in
Vertical Adjust mode (choose Mouse? Vertical Adjust under Display) and then
dragging the selected wave up or down in adisplay. A double headed arrow is
appended to the wave name of a vertically adjusted wave to indicate that it no longer correspondsto the
vertical scale at the right of the display region. Clicking this double arrow once will cause the vertically
adjusted wave to snap back into its original position.

JOURNALS

Journals are text regions that are used to enter, view and edit text in a J1

manner similar to that done with aword processor. With commandsin [cojumbus =ailed the

the menubar, the user can Clear, Save, View, Saveto Clipboard, Print, |ocean blue in fourteen
Delete and Create Journals. The contents of Journals can easily be hundred and ninety-two |
saved to disk and then loaded by aword processor, graphics, or
spreadsheet program. Journal windows can be resized and positioned
on the front panel in any pattern and in any number, space permitting. ‘
Many task instructions transfer text to and from journals.

To create a Journal, one chooses New from the Journal menu. Subsequently, the Journal dialog opens,
and it isfrom here that one specifies several Journal options such as journal name, the number of
characters between each tab, and whether or not the journal’s contents are stored with the instrument file.

Each journal can operate in one of two modes: Word Processor or Spreadsheet. The Word Processor
mode works with a fixed page width (e.g. 7 inches) and supports automatic wrap-around. Thismodeis
useful when one wants to send the journal contents to aword processor or print the journal with alimited
width format. The spreadsheet mode is more like atraditional spreadsheet with an unlimited width, no
wrap-around, and horizontal scrolling that will go asfar right as necessary. Thisisuseful whenitis
necessary to send the journal's contents to a spreadsheet. Tabular numeric datain SuperScope Il journals
transfer nicely to spreadsheets, with each value being placed in its own spreadsheet cell. Thisis made
possible with a TAB delimiter between each column and a CARRIAGE RETURN character between
each row. Thisisawonderful standard for text files since it insures compatibility between journals, word
processors and spreadsheet application programs!

The user can log points to a journal by placing SuperScope Il in Log X:Hz YV dB
Coordinates Mouse mode (choose Mouse » Log Coords under Display) andthen ~ 2278.63  18.060
clicking the mouse on a selected wave (recall that you select awave by clicking 2339.68  18.060
onitslabel; or, if thereisonly one wave in the display, clicking in the display).
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CONTROLS & INDICATORS
Front panel Controls and Indicators, shown below, allow the adjustment of, Boolean true/false values,

scalars, lists, and text. These objects appear in avariety of styles, sizes, fonts, and colors; and their states
are easily read and updated with tasks.

N Power
. 0 On
Dout0 Off
Lights Buttons Switches
indicate the state of aBoolean || often initiate the execution of || specify atrue/false Boolean
true/false value. atask. condition.
18-
5 -
Velume
. - Offset 1 Current C
Sliders Dials Meters
control ascalar quantity. control a continuous or indicate a scalar quantity.
guantitized scalar quantity.

4.88 : Channel 0O

Numeric Fields
control a scalar quantity or a
text string.

Duration = 12.52

Static Text
shows a scalar quantity or a
text string.
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M ARKERS

Markers are typically used to mark atimein awave or display. The user can create as many markers as
he/she desires and can place any marker in any display (viaMarkers under Display). In displays, they
appear as vertical lines that can be moved left and right with the mouse. Additionally, the display can be
set up to show marker labels at the top of the display (choose Label under Display). A neat trick isto use
two markers and one wave to describe another wave, called a"segment”, which is defined as the section
of the original wave between any two markers (via Markers under Display). The segment and the source
wave share the same data.

The cursor window is used to numerically view
specific points along awaveform. The contents of the

cursor window corresponds to the location of the mouse. Wave | Horizontal | Vertical

Thisis opened by choosing Show » Cursor under Edit. mouse 3162.500 dB | 22.34375 dB
snap 3162500 dB 9540 dB

M ENUBARS

Menubars are a powerful tool for modifying the

current menubar, or creating your own. In some Custom Menubar:[ MyMenu |

cases, it isdesirable to have avery smple

menubar to limit a user's options. Menubars are Name: MyMenu |

easily created, renamed, and deleted. Each —

menubar consist of a set of menus and a set of ~Menu:_File |

items for each menu. Each menu and item can ® Show default text "File"

be renamed (e.g. change "Open..." to "Open I

Sesame"), hidden, or set up to run a Task when - S'.mw custom text: “F"e l

chosen. {0 Hide menu

~1tem:|_User Item 1 }
) Show default text "User Item 1"
® Show custom text: |0pen Movie... |
() Hide item

[ Run Task UDenMouil Delete
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TASKS

Tasks are little program sequences that
perform a series of operations when run.
For example, one could write atask to
record data, analyze, update the screen, and
then print theresults. Tasks are easily
created, viewed, edited, and debugged; and
can be set up to run when a marker moves,
when a wave changes, when a specific
menu item is chosen or when the user
chooses Run Task. One "programs' tasks
using a powerful mouse/dialog user
interface. The neat thing about
programming SuperScope Il is you do not
need to know any syntax -- the mouse-
driven dialog boxes take care of you.

INSTRUCTIONS

Task Begin

Clear at beginning of task journal Data

Clear, Calculate and Redraw Display Analusis

Uoiced = Uoiced (time)

Move M1 to absolute time X of time

Move M2 to absolute time X of time

Loop 3 times
Pulse analysis on Uoiced (pulse# to Data; t3
Sound Statistics on Segment (shimmer (APO> to
Loop end

Move M1 to first peak of Uoiced

Move M1 to relative time X of Uoiced

Instructions are the building blocks used to create tasks.
There are over 30 kinds of instructions, each of whichis
used to perform a specific function (e.g. save awave to
disk, move a marker, choose a menu item, calculate the
derivative of awave, etc.). Each task containsalist of
instructions that are executed in the order they appear in
the list; and each instruction can be viewed, edited, cut,

------------ Analysis
Calculate Have

Pulse Analysis

Sound Statistics
Statistics

Datapipes
Disk |/0

copied, and pasted.

DATAPIPES

A datapipe isareference to afolder on ahard disk or floppy disk. Technically, a datapipe is a pathname
to afolder. Think of it as a pipe, through which you squirt data between SuperScope I and afolder on
disk. Datapipes are often used to access folders from within tasks, where the name of the folder may
change with each experiment. The Datapipe instruction can be used to create a new data folder, and to
attach a datapipe to that folder. The Disk I/O instruction could then be used to push data into the
datapipe, and ultimately into the new folder. Datapipes, like other SuperScope |1 objects, are created,
deleted, and named. To view or modify a datapipe's folder, choose Datapipe Folder » under File.

Principles of Instrument Design
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VARIABLES

Variables are used to hold one 32-bit
floating point value (e.g. 16, 2.3,
1.34e6). They are easily created,
renamed, and deleted; and their
values are easily viewed and edited.
Many task instructions transfer
values to and from variables.

STRINGS

Strings are used to hold a series of
characters of any length, memory
permitting (e.g. "hi", "1.2"). They
are easily created, renamed, and
deleted; and their text is easily
viewed and edited. Many task
instructions transfer text to and from
strings.

Dariable: [ D1

~~~~~ Parameters

Name: | D1

Cancel

Dalue: |1.23135

Units: |Dolts

Delete

ol

String: | H

Now is the time for all good men and women to come to the [

aid of their, of others, country.

Parameters

Name: |H |

Units: |llolts |

[ Delete ][ Cancel ]
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TASKS AND INSTRUCTIONS

SuperScope Il provides an easy to use environment by which one explicitly defines acquisition, analysis,
archival and presentation features. From this environment, one defines little programs called Tasks, each
of which can be created, edited, viewed and run. These little programs consist of alist of instructions
which are executed in atop to bottom sequence. Each instruction is not typed however, as donein
traditional textual programming environments; instead, each instruction has an associated dialog box from
which the user specifies, in detail, the instruction's functionality -- with easy to use pop-up menus, check
boxes, radio buttons and edit fields. These dialogs appear when one initially adds an instruction to a task,
and when one edits an instruction by double clicking on it'stext. Instructions are added to atask by
dragging one from the Instruction Dictionary; deleted from atask by being selected and then removed
with the Delete key; moved from one position in atask to another via the standard Cut, Copy & Paste
clipboard features; and modified by double-clicking with the mouse. An example instruction isthe
Calculate Wave instruction which enables the user to place mathematical expressionsinto atask (e.g. W1
= AutoCorrelation(W2)). The instructions are summarized below:

ALERT, BEEP, OR DELAY isused to sound a
beep, show amessage in an aert, stop the task, wait
until the mouse button is pressed, wait until the

Alert, Beep & Delay
() Beep

mouse button is released, wait for a specific key
press, freeze for a specified duration, or
synchronize to a specified duration.

() Stop task
(O Break out of Trace Loop
() Wait for mouse down

() Wait for mouse up

O Wait for key press
(O Delay for|2.000 seconds
(O Synchonize to second intervals

{® Show RAlert:|Masx FFT Low!

([ Hetp ][ Dot

][ Cancel ][[ 0K ]l

ARITHMETIC isused to arithmetically combine

Scalar Arithmetic

two objects (e.g. +, -, +, *) and transfer the result to
athird. Objectsinclude variables, strings, waves, [ Journal o [Marker [ Wave
markers, journals and controls. [[view ~ M [wi
0.00000 0.01000 0.00000 Volt

( Help.. ][ Doit | ((cancet ]| ok ]
A SSIGNMENT is used to copy the scalar value of )
one object into another object. A marker'svalueis stalor Gssignment
derived from it's position; a control'svalue is i
derived from it's setting; a string or journal's value =
is derived from it's text; and awave's scalar vaueis
derived from one anons...

1.00000 Volts 0.00000
[ Help... ][ Doit [ cancet || ok ]|
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CALCULATE WAVE isused to perform

waveform calculations; such as FFT, cos, +, or *.

Over 80 functions and operators are supported.

CHOOSE M ENU isused to select a menubar
command or press akey (e.g. choose Print under
File, press Option '€, etc). Thisisvery powerful

since is brings all menubar and keyboard commands

within the scope of task instructions.

CURVE FITTING fits awave to alorentzian, sin,

gaussian, polynomial, exponential or linear
expression.

DATAPIPES is used to show a datapipe folder

dialog, create anew folder for data, or create a new

folder and prompt for afolder name.

Calculate Wave

O [ RAino | = [ Ain0 |
O [ Rino | = [ Aino ] C_+_][o0.000 |
O [ Aino | = [ Ain0 ][ + ][ nRinO |
@®| W3 | =| Histogram |
Min: [J use Dariables

(__Help ] (view Data](_ Doit ][ Cancel J| o0k

Choose Menu

® Men:

Command: | Save fis... |[ abs |
{0 Key press: D

O % Key: D
() Open instruction number|:| in task | TakeData

[J Automatically press encountered OK buttons

( Help.. ][ DoIt ] [ cCancel | 0K

Curve Fit:
..Method
Model:[ Polynomial | # of terms: D
a0 +aly + a2y'2 + ...
--Results
[] Replace source wave with result
([ Hep ] [ 8eit ] [ Cancel | K
Datapipe:

® Show datapipe's Folder Dialog
() Create new folder and prompt for folder name
() Create new folder with default name, don't prompt

(CHetp.. ) (Do1t ) (Cancel
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Disk 1/0 is used to transfer awave or journal to
or from disk, delete afile, transfer wave datato a
journal, or transfer journal datato awave.

DisPLAYS is used to clear, calculate, or redraw a
display. Thisisimportant since updating a display
takes processor time, and therefore should not be
done redundantly or too seldom.

FILTER is used to run alow-pass, or high-pass
FIR filter on awaveform. Alternatively, you can
provide your own FIR filter coefficients to
implement a custom filter.

GET TIME obtains immediate time information
for purposes of absolute time, and duration
measurements. For example, one could use this
instruction to read the time since the beginning of
the task, twice, accurate to £.25 s, and then
subtract the two values to produce a duration
measurement accurate to +.25ps.

Data Transfer

(O Save [ wave ][ Fo | to disk

@Load | journal || Data | from disk

() Delete last saved file
() Delete last loaded file

(o1t J|[ ox

(_ File... ] [options...] [ Hetp ] [ cancel ]

@ Clear display
{0 Clear, Calculate and Redraw display
{0 Calculate and Redraw display; don't Clear

{0 Clear, Calculate and Redraw all displays
which are not current with the latest data

][ Cancel ][[ 0K ]]

[ Help.. ][ Dot

Type: | Low pass (FIR)

FreqCutoff:
Boundries:

Freq Cutoff: 125.0 Hz
Stopband: -98 dB

| (Custom...)
(% of sample rate)

Phase: linear
Taps: 99

[ cancet J|[ ok |

Get Time

Transfer... month to...

‘ day Owave: [ Wi | (gtians...] (W)
year [ variable:[ error | (Botivas...] @
hour
minutes X Journal: [_Task80 | (options...]
seconds [ String: | retlalue | [&}gm’mzsm] @
power on secs
apl launch secs (] Control:
begin task secs O Marker: | time M)
trigger secs )

[ peit ] [ clear ] [ cancel || oK

-
-
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JOURNALS & STRINGS is used to clear, insert
text, append, copy, and search-replace text within a
journal or string.

L OG MARKER is used to send the marker
position, or wave value at a marker position, to
journals, waves, controls, strings, variables, and
markers.

MOVE MARKER is used to move markers to
waveform minimums, maximums, local minimums
("valleys"), local maximums ("peaks'), upstrokes,
downstrokes, specified points, and specified wave
values. Thisinstruction supports seamless traces;,
subsequently, trace breaks have no effect (e.g. ten
seamless traces would be viewed as one long trace).

PROGRAMMING supports common programming
features such as If...Then, Goto, While Loop, Loop N
Times, Define Subroutine, Jump To Subroutine,
Insert Comment, and Insert Label.

Journal or String:| Task80

) Clear () Insert wave definitions
@ Clear at beginning of task (O Insert today's date

( Copy to clipboard O Insert today's time

(O Copy into: () Insert trace number

O Append ontu: (O Update all journals

(O Remove row number IZI (top row is #1)

() Remove column number |1 (first column is #1)

(O Change |\t to|, |
) Insert: |Hello.

([ Hetp ) Doit ) [ cancel | [ ok ]

Marker E and Wave E Intersection

Transfer... value to...
>
point# Owave: [ W1 | (eptians...| (W)
time Variable:[_U1 ions...
daytime X variable:| | (options ]@
[ Journal: [ Task80 | (gntians...] @
Ostring: [_retvalue | [sptivas...] @
|| | OMsrker: | 2 time
2 ) @
((poit ) ((clear | (cancel | [ ok ||

Move Marker: E]
Move to [_first downstroke | of wave [ Fo |
3»--0ptions
. Hysteresis: dB
Threshold: dB

Help

Cancel

il

Select instruction: Add Subroutine
Add Subroutine
Jump to Subroutine
Add Label
Jump
Add Comment
Do Every H Traces
Do Every ¥ Points
Loop
If-Then
While Loop

[(cancel ] [ ok

Enter Subroutine Name:
mySubrouting|
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PULSE ANALYSIS s used to analyze pulses and
send up to 24 characteristics (e.g. min, max, risetime,
fall time, etc.) of each pulse to journals, waves,
controls, strings, variables, and markers.

READ WAVE | NTERNALS is used to extract wave
characteristics, such as sample rate and # of points,
and transfer them to journals, waves, controls, strings,
variables, and markers.

RS-232 is used to communicate with RS-232
hardware devices via the computer's MODEM and
PRINTER ports. These ports support seria
communication at rates up to 57.6K BAUD viathe
Macintosh Serial Port Driver. Thisinstruction can be
used to send text, receive text, copy areceived string
into ajournal, and interpret areceived string.

SET WAVE INTERNALS is used to set wave
characteristics, such as sample rate and # of points.
Thisis done with values from journals, waves,
controls, strings, variables, and markers.

Pulse Analysis on: El

Send to journal: X Log pulse number
t3 tmax min2 t4
Atmax |
max +
- auvg2
v2
-t/ tel -t/ te2
e e
slope2
areal max2
vl |
. ] — avagl v\/_/
min >t 12 \
i3
t1 t2
(
Detection... Help Cancel

Transfer...

+ start time

Read Wave Internals:@

start time to...

sample time Owave: [_W1 | (gtians...] (w)
#valid pre pts Variable:[ error options...
#palid data pts = tabe I - I[ prof ]@
pre size [ Journal: [_view | (ptians.]
data size [ String: retlalue Bpdinns..
post size g I I [ i ] @
min I1U code O Control:
max 1U code Marker: M1 |time M
min EU value O
((poit ) [ clear | [cancel | [ ok )
RS-232 Command Sequence
D I
5]
- Results
& [_Copyinto ] journal [_Ji |
O [ Copyinto | string [ retbalue |
[JRead 1 scalar value and
O [ Append ][ AsCII | data into wave[_ W1 |

e ) (

Do It

] [ Options... ] [ Cancel ] [[ 0K ]]

Set sample time ...

Set Wave Internals:@

With...

start time

+ sample time
#palid pre pts
#palid data pts
pre size
data size
post size
min IU code
max IU code
min EU value

X Read:|_Dariable][ #

Current value: 0.00000 gstinag..

FAEEEEE

[(peit ] [ clear ] [ cancel || oK

-
e
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SOUND STATISTICSisused to calculate the
following statistics on a speech wave: % voiced, %
unvoiced, % silent, shimmer, jitter, HNR,
breathiness, Fo average, Fo kurtosis, Fo skewness,
Fo range and Fo std dev.

STATISTICSIisused to calculate the following
statistics on awave: avg, min, max, time of min,
time of max, std dev, rms and area. Results are
easily sent to Journals, Waves, Variables, Strings,
Controls and Markers.

SYNTHESIZE isused to load awave with a
constant value, ramp, Sine wave, triangle wave,
square wave, gaussian noise (gaussian distribution),
or uniform noise (flat histogram).

TRANSCENDENTAL isused to caculate a
transcendental function on one object, and transfers
the result into another object. A marker'svaueis
derived from it's position; a control's valueis
derived from it's setting; a string or journal's value
is derived from it's text; and awave's scalar valueis
derived from one point.

Sound Statistics on:

Transfer...

silence to...

iced
z::,c;ced Owave: [ Wi | (aptians... ] (w)
- Variable:| e_rror | [l]pt'fons...] @
HNR O Journal: [_view | (entions...] @
:ﬁ::h(:]::]s O string: [ retvalue |[§3{>iizmxm]@
iter O contrt
§0 kurtosis O ™Marker: | time M)
f0 skewness ’
[Help... ] [l]ptions...] [ Do it ] [ Clear ] [Cancel ] [[ 0K ]]
Statistics on:[_Rin0_|
Transfer... std dev to...
2 i
;.nl:g | | Owave: [_deriv | (gptians...] (w)
L“:;‘ nin [ variable:[ error | [§3z>2z:s>zzsm] @
H at max O Journal: [_Notes | (eptions..]
area string: thal Opti
@string: [_reWolve ] (Gations... 5]
] O contror ©
duration || | Omsexer: | time @
sum of points i :
((poit | [ clear | [cancel | [ ok |

Synthesize: El

Length:

points

® Periodic: |52 points/cycle
10.000 code amplitude

@ Sine

(O Square (O Triangle

) Ramp:

[0.000

| to [5.000  |code

) Constant: |0 code
() Guassian: code rms noise
> Uniform: |10.000 code random noise ()

[ Help ] [ Do It ] [ Cancel ]

[ Help... ][

Scalar Transcendental

0.00000 Volts

—

D BTN
Gutians...
0.01000

Do it

J[ cancel J[[ ok ]
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USER INTERFACE isused to monitor the X-Y
position of the mouse, the status of the mouse
button (up or down) and the status of the keyboard

(i.e. the last keypress). Results are sent to journals,

waves, variables, strings, markers, and controls.

USER PROMPT is used to show a custom alert,
with an optional response field and an optional
Cancel button. For example, the instruction to the
right results in the alert pictured below.

Do you cook with gas?

INo, | cook electric. |

((Nope ][ _ver J

User Interface

Transfer... mouse H to...
v Owave: [_W1 | (8ptians...| (W)
mouse status vari [ 2
Kou pross & Variable:| | (options...] @
O Journal: [ Data | (gntians...]
Ostring: [_retvalue | [sptivas...] @
|| | Odsrker: | 3 time
[ poit ] [ clear ] [cancel || ok |
User Prompt
Message

Do you cook with gas?

(< Response:
No, | cook electric.

Right Button:
& Left Button:[Nope |

Dariable "error" is loaded with 1 if Right button is pressed; 2
otherwise. String "retlalue"” is loaded with response text.

(

Help ] [ Dot |

[ Cancel ][[ 0K }]
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FUNCTIONS

The Calculate Wave instruction allows one to define waves in terms of other waves (e.g. "W1 =
deriv(W2)"). From within the Calculate Wave dialog, one can use any of 12 operators and any of over 65
functions (e.g. FFT, cos, signal average), as summarized in the table below.

Waves of type 16-bit integer and 32-bit floating point can be intermixed within afunction (e.g.
"intl6Wave = Abs(flt32Wave)"). Integer waves are aways analyzed with respect to their engineering
units. For example; if wave Result and Source are both 16-bit integer waves with +10 Volts mapped to
+32,768 (e.g. 5V corresponds to 16384 internally, etc.), Sourceis loaded with 1.0V (3,277 internally) and
one does "Result = cos(Source)", then Result would be loaded with 0.54 (1770 internally). The neat thing
about integer wavesis that the user, the displays and the tasks only see Engineering Units (e.g. Volts);
subsequently, one does not need to keep track of the internal values. Digitized data (e.g. from an analog-
to-digital or digital-to-analog converter) is always contained in 16-bit integer waves, since thisisthe
native format for 1/0 hardware. To seeinternal data, choose Edit VValues under Wave and then select
Internal.
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Function Description Example
+ add W1=W2+W3
- subtract W1=W2-W3
* multiply W1=W2* W3
/ divide W1=W2/W3
AND bitwise AND W1=W2& W3
OR bitwise OR W1=W2|W3
< 11t lessthen; O otherwise W1=W2<W3
> 11t greater then; O otherwise W1=W2>W3
< 11f <or equal; O otherwise W1=W2<W3
> 11t > or equa; O otherwise W1=W2>W3
== 11t equal; O otherwise W1=W2==W3
I= 11t not equal; O otherwise W1=W2==W3
Abs absolute value W1 = Abs(W2),
Alarm beep It value is out of bounds W1=Alam(W2, 5, 0)
Append append one wave to another W1 = Append(W2, W3)
Arccos Inverse cosine W1 = Arccos(W2)
Arcsin Inverse sine W1 = Arcsin(W2)
Arctan Inverse tangent W1 = Arctan(W2)
AutoCorrelation autocorrelation W1 = AutoC(W2)
AvgToDate average value to date W1 =AvgToD(W2)
Blackman generate a Blackman window W1 = Blackman(256)
Compress decrease sample rate W1 = Compress(W2, 2)
Convolve convolution W1 = Convolve(W2, W3)
CopyTiming copy sample period & start time W1 = Copy Timing(W2)
Cos cosine W1 = Cos(W2)
CrossCorrelation Ccross correlation W1 = CrossC(W2, W3)
CrossPower Cross power W1 = CrossP(W2, W3)
DeConvolution de-convolution W1 =DeConv(W2, W3)
Delete delete awaveform segment W1 = Deete(W2, 50, 100)
Deriv derivative W1 = Deriv(W2)
DerivFivePt 5 pt. Lagrange derivative W1 = DerivFivePt(W2)
Exp exponential W1 =Exp(W2)
Expand Increase sample rate W1 = Expand(W2, 2)
FFT fast Fourier transtorm, reals W1 =FFT(W2, 256)
Hamm generate a Hamming window W1 = Hamm(256)
Hann generate a Hanning window W1 = Hann(256)
Histo histogram W1 = Histo(W2, 0, 50,10)
Imag convert complex iImaginary W1 =1mag(W2)
IndexSort sort given indices W1 = IndexSort(W2, W3)
Insert Insert a segment Into awave W1 = Insert(W2, W3, 50)
Int convert to closest integer W1 =Int(W2)
Integ Integrate W1 = Integ(W2)
IntegAV Integrate, reset when area= A W1 =IntegAV (W2, 10)
IntegPT Integrate, reset whentime=T W1 =IntegPT (W2, 0.1)
IntegTL Integrate, reset at list of times W1 =IntegTL(W2, W3)
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Function Description Example
IntegTV integrate, reset when wave >V W1 = IntegTV (W2, 5)
InvFFT inverse fast Fourier transform W1 =TnvFFT(W2, 256)
Kaser generate a Kaiser window W1 =Kaser(W2, 256)
Last return datafrom last trace W1 = Last(W2)

Limit apply high & low bounds W1="Limit(W2, 5, 0)

Ln natural logarithm W1=1n(W2)

Logl10 logarithm with base 10 W1 =10gl0(W2)

Mag convert complex to magnitudes W1=Mag(W2)
MakeComplex return complex given real W1 = MakeC(W2)

Makel ndex return indices for a sort W1 = Makel (W2)
MaxToDate maximum value to date W1 = MaxToDate(W2)
Minimum minimum value W1 =Minimum (W2)
MinToDate minimum value to date W1 =MinToDate(W2)
Mod modulo W1=Mod(W2)

MVFFT return magnitude FFT W1 =MvFFT(W2, 256)
OnOft on/oft feedback control loop W1 =0n0ft(W2, 5, 0)
Peak find peaks W1 = Peak(W2, 2.5)

PID PID feedback loop W1=PID (W2, W3, 1...
PulseEndTimes return list of pulse end times W1 = PulseEndTimes(\W..
PulseMaxTimes return list of pulse max times W1 = PulseMaxTimes(\W..
PulseStart Times return list of pulse start times W1 = PulseStart Times(W..
Phase return phase given complex W1 = Phase(W2)

Real return real given complex W1 = Real(W2)

Reverse reverse the order of elements W1 = Reverse(W2)
Reciprocal return reciprocal of source W1 = Reciprocal (W2)
Shift shift wave horizontally W1 = Shitt(W2, 50)
SignalAvg determine waveform average W1 = Signa Avg(W?2)
Silent determine silent region W1 = Silent(W2)

Sin sine W1 =SIn(W2)

Smooth smooth wavetorm by n points W1 = Smooth(W?2, 12)
Sort sort wave elements W1 = Sort(W2)

Spectrum calculate frequency spectrum W1 = Spectrum(W2, 256)
Sort square root W1 =Sgrt(W2)

Tan tangent W1=Tan(W2)

TC find °C given thermocouple V W1=TC(W2, 1)
TimeHisto time histogram W1 =TimeH(W?2, 2, 100)
TimeVaues returns values given times W1=TimeV(W2, W3)
UnVoiced determine unvoiced region W1 =UnVoiced(W2)
Voiced determine voiced region W1 =Voiced(W2, W3)
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Chapter 6
Example Instruments

This chapter describes two software instruments that are included with SuperScope 1. A SuperScope ||
instrument consists of waves, markers, displays, journals, controls, indicators, datapipes and tasks that
have been assembled like building blocks to create a software environment that is appropriate for specific
work. You can use these instruments as is, customize them to your specific needs, or build new
instruments from scratch. More instruments may have been added to the disk since this chapter was
printed. Most object nhames are consistent across instruments, so the extra ones should be easy to
understand.

USING AN INSTRUMENT

To begin using an instrument, it is recommended that you first duplicate the instrument file and work with
acopy. Please these new files outside the SuperScope |1 application folder (e.g. the "SS2 Instruments &
Data' folder is ok) to reduce the chance of loosing it during a software update. To open thefile, either
double-click onitsicon from the Finder, or launch SuperScope |1 and then choose Open in the File menu.
After opening, you should verify the hardware setup, and save the instrument to disk.

The best instruNet instrument are in the " SuperScope |:instruNet Instruments:BEST INSTRUMENTS'
folder.

OBJECT NAMING CONVENTIONS

Nearly all SuperScope Il instruments from GW Instruments follow a single naming convention. This
consistency makes it easy to use the instrument most appropriate to a specific task, without having to
relearn the basics for each. It also allows tasks to be created on one instrument and used in any
instrument that contains similar objects. These names strike a balance between simplicity and flexibility.
Y ou may alter any object name, or use any hames when creating your own instrument. However, doing
so will make it more difficult to exchange tasks and instruments with colleagues.

Waves are prefixed with the letter "W". The first wave you create will be named W1 and the second W2.
The user is free to change the name of any wave at any time - even after an instrument is saved and tasks
are set up that access the waves data. SuperScope |1 will take care of all internal dependencies on the
waves name. Segment names are all automatically prefixed with "Seg". The first ssgment you create will
be called Segl and the second Seg2. Aswith all other SuperScope |1 objects segment names can be
change at any time. Displaysare prefixed with "D". The first display created will be D1, the next D2.
Markers are prefixed with "M". The first marker will be M1 and the next M2. Journals are prefixed with
"J'.

Thefirst journal will be J1 and the next J2. Specific names are reserved for journals for debugging
purposes. If ajournal isnamed Bench it will bench mark each instruction in atask whileit isrunning. If
atask isnamed Task80 it will list each instruction in atask asitisrun. A journa named Task10 will
produce an abbreviated form of each instruction run. Tasks are prefixed with "T". The first task will be
T1 and the next T2. One feature SuperScope |1 offersis the ability to run tasks directly as menu
selections. The instrument Menu Editor is an example that runs tasks as menu selections. Controls are
prefixed with "C". Thefirst task will be C1 and the next C2. Aswith all other SuperScope Il objects
users are free to give controls the name of their choosing. Variables are prefixed with "V".
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Thefirst variable will be V1 and the next V2. All SuperScope Il instruments include a variable called
"error” that is used to show the return value of certain functions. Strings are prefixed with"S'. Thefirst
string will be S1 and the next S2. Two strings, retVaue and message, are built into every SuperScope |
instrument. Message and retValue are global and are used a variety of message passing schemes.
retValue will contain the input string return from the dialog task. Datapipes are prefixed with"DP". The
first datapipe will be DP1 and the next DP2. Aswith all other SuperScope |1 objects users are free to give
datapi pes the name of their choosing.

TWO EXAMPLE SUPERSCOPE |l INSTRUMENTS

Two instrument are documented in the following pages. The instruments described here are included in
the SuperScope 11 folder. Some will include aread me file that can be opened with any text editor, or
TeachText.

THE " OSCILLOSCOPE WITH DATABASE.INET" INSTRUMENT

This instrument uses instruNet to implement an  [E=oscitescope with database.inet =] [52 owi |
Oscil |O$Ope, where the maximum wave |ength New DB ||:l]per? DB || I:Iea:r I I]i:giliz:e Il l]tz|tput:|| Fld:d Rec: | Hec:: $| Tim:ebas:e Il Tr:iggery Hel
islimited by available RAM memory (4 bytes i S S 1
for each point). The digitized wave and notes
journal is easily saved in one record of a
SuperScope Il disk-based database. The
database contains two files for each record:
wave W1 and journal Notes. These waves and
journals are kept in their own files, in the
RECORDNUMBER OBJECTNAME format
(e.g. file"000005 Notes" contains the Notes
text for record #5). In SuperScope I, databases
are simply acollection of filesin thisformat,
stored in one folder which is referenced by a
datapipe. The NEW DB button prompts the
user for a new database (i.e. folder) name, L
OPEN DB prompts the user to specify a
database (i.e. folder) on disk, ADD RECord adds arecord to the database, DIGITIZE digitizes atrace,
OUTPUT outputs the current trace via D/A #0, and CLEAR zeros out the current trace. The sample rate
and the number of points per trace are viewed and modified by pressing the TIMEBASE button; and the
Trigger is viewed and modified by pressing the TRIGGER button. The database records can be scanned
manually by pressing the increment/decrement arrows in the Record # field, or automatically in atask.
Subsequently, one could place all data acquired during ayear, for example, on disk in aformat that is
easily accessed by SuperScope |1, automatically or manually. Thisinstrument could easily be adapted to
work with virtually any instruNet digitizer.

This instrument contains several buttons, each of which cause atask to run when pressed. These tasks are
typically several instructions long, and can be viewed by choosing Edit under Task. The front panel
buttons are used as follows:

NEW DB - The NEW DATABASE button causes an alert to appear prompting the user for a new
database name. A folder isthen created with this name, the DB datapipe is attached to the new folder (so
that all file I/O will be directed to that folder), and the Record edit field (which displays the current
database record number) isreset to 0.

OPEN DB - Thisis used to present the standard File Open dialog. The user then navigates viathis
dialog to the inside of a database folder (i.e. this redirects the DB datapipe). The last record in this
database is then |oaded.
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CLEAR - Thisclears (i.e. sets all pointsto 0) the W1 wave.

DIGITIZE - This button starts the digitization of 1 signal. The 2 waveforms are acquired at 1K pts/sec,
1000 ptg/trace, for 1 second (only 1 scan isdigitized). To adjust the number of points per scan (i.e. the
total # of points digitized for each channel), or the number of points digitized per second, press the
Timebase button. To adjust the # of channels, choose New or Delete under Hardware.

OUTPUT - This causes the W1 wave to be output viathe D/A converter #0.

RECORD EDIT FIELD - Thisedit field shows the record number that you are currently viewing { 1...
total # of Records}. Y ou can press the adjacent UP or DOWN arrows to increment or decrement to the
next record number. This causes new W1 and Notes data to be loaded in from disk.

ADD RECORD - Thisadds 1 record to the database. Each record contains W1 wave data and Notes
journal text. Thewaves and journals are stored in separate files with their names prefixed by record #'s
(e.0. file 0000003 W1" contains the data for wave W1 in the 3rd record).

TIMEBASE - This opens the Timebase dialog, which is used to set the sample period (i.e. # of
microseconds between each digitized point) and the # of points that are stored in memory (and in each
disk file) each scan.

TRIGGER - This opens the Trigger dialog, which is used to set the trigger to one of the following: Auto
(analog positive or negative with fall-through), Norm (same as Auto, yet without fall-through), or None.

HEL P - This causes the Help journal to appear (which isthe one you are now viewing). To closethis
window, click the box at the upper left.
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THE "XY RECORDER.INET" INSTRUMENT

This instrument uses instruNet to XY Recorder.iNet
|mp| ement an OSCI”OSCOpe/XY Recorder, I]igitize”. stop || Open 0B |‘| New I]B” ﬂdd.Rec|'Hec:‘|l '
where the maximum wave length islimited  |oim [ ; o

by available RAM memory (4 bytesfor
each point). The digitized wave and notes
journal is easily saved in onerecord of a ] 5 50 aEnal
SuperScope || disk-based database. el B0 senguois

i owi
4 | Timebase || Trigger || Help
|5 99
H H H s

The database contains three files for each
record: wave VinA, VinB and journal
Notes. These waves and journals are kept
in their own files, in the
RECORDNUMBER OBJECTNAME
format (e.g. file "000005 Notes' contains [piacs retes rere.
the Notes text for record #5). In
SuperScope |1, databases are simply a
collection of filesin thisformat, stored in
one folder which is referenced by a
datapipe. The NEW DB button prompts the user for a new database (i.e. folder) name, OPEN DB
prompts the user to specify a database (i.e. folder) on disk, ADD RECord adds a record to the database,
DIGITIZE digitizes scans continuously until STOP is pressed. The sample rate and the number of points
per scan are viewed and modified by pressing the TIMEBA SE button; and the Trigger is viewed and
modified by pressing the TRIGGER button. The database records can be scanned manually by pressing
the increment/decrement arrows in the Record # field, or automatically in atask. Subsequently, one could
place all data acquired during ayear, for example, on disk in aformat that is easily accessed by
SuperScope I, automatically or manually. Thisinstrument could easily be adapted to work with virtually
any instruNet digitizer.

(=1

=l

10 Volt
3] 1 Vol t/Div

This instrument contains several buttons, each of which cause atask to run when pressed. These tasks are
typically several instructions long, and can be viewed by choosing Edit under Task. The front panel
buttons are used as follows:

NEW DB - The NEW DATABASE button causes an aert to appear prompting the user for a new
database name. A folder isthen created with this name, the DB datapipe is attached to the new folder (so
that all file I/O will be directed to that folder), and the Record edit field (which displays the current
database record number) isreset to O.

OPEN DB - Thisis used to present the standard File Open dialog. The user then navigates via this
dialog to the inside of a database folder (i.e. thisredirects the DB datapipe). The last record in this
database is then |oaded.

DIGITIZE - Thisbutton starts the digitization of 1 signal and displays both it's time wave and VinA vs.
VinB in XY from. The waveforms are acquired at 1Kpts/sec, 1000 pts/scan, for 1 second. To adjust the
number of points per scan (i.e. the total # of points digitized for each channel), or the number of points
digitized per second, press the Timebase button. To adjust the # of channels, create new waves and then
attach them to instruNet channels in the Wave Options dial og.

STOP - This causes the digitizing to stop.
RECORD EDIT FIELD Thisedit field shows the record number that you are currently viewing { 1...

total # of Records}. You can press the adjacent UP or DOWN arrows to increment or decrement to the
next record number. This causes new wave, fft and Notes data to be loaded in from disk.
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ADD RECORD - Thisadds 1 record to the database. Each record contains time wave data and Notes
journal text. Thewaves and journals are stored in separate files with their names prefixed by record #'s
(e.g. file 0000003 VinA" contains the data for wave "VinA" in the 3rd record).

TIMEBASE - This opens the Timebase dialog, which is used to set the sample rate and the # of points
that are stored in memory (and in each disk file) each scan.

TRIGGER - This opens the Trigger dialog, which is used to set the trigger to one of the following: Auto
(analog positive or negative with fall-through), Norm (same as Auto, yet without fall-through), or None.
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